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Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

A\DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

AAWARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

A\CAUTION
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

CAUTION
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

NOTICE

indicates that an unintended result or situation can occur if the corresponding information is not taken into
account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to
property damage.

Qualified Personnel

The device/system may only be set up and used in conjunction with this documentation. Commissioning and
operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes
in this documentation qualified persons are defined as persons who are authorized to commission, ground and
label devices, systems and circuits in accordance with established safety practices and standards.

Proper use of Siemens products

Trademarks

Note the following:

AAWARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical
documentation. If products and components from other manufacturers are used, these must be recommended
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and
maintenance are required to ensure that the products operate safely and without any problems. The permissible
ambient conditions must be adhered to. The information in the relevant documentation must be observed.

All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the
owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the
information in this publication is reviewed regularly and any necessary corrections are included in subsequent
editions.

Siemens AG Ordernumber: 6AV6691-1DR01-0AB0O Copyright © Siemens AG 2008.
Industry Sector ® 11/2008 Technical data subject to change
Postfach 48 48

90026 NURNBERG

GERMANY
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Purpose of the operating instructions

These operating instructions provide information based on the requirements defined by
DIN EN 62079 for mechanical engineering documentation. This information relates to the
place of use, transport, storage, mounting, use and maintenance.

These operating instructions are intended for:

® Users

o Commissioning engineers

® Maintenance personnel

Read especially the information in the section "Safety instructions" (Page 37),

The help integrated in WinCC flexible, the WinCC flexible Information System, contains
detailed information. The information system contains instructions, examples and reference
information in electronic form.

Basic knowledge required

General knowledge of automation technology and process communication is needed to
understand the operating instructions.

It is also assumed that those using the manual have experience in using personal computers
and knowledge of Microsoft operating systems.

Scope of the operating instructions

Trademarks

The operating instructions apply to the following HMI devices in conjunction with the
WinCC flexible software package:

e MP 377 12" Touch

e MP 377 12" Key

e MP 377 15" Touch

e MP 377 19" Touch

e MP 377 PRO 15" Touch

The following designations marked with the symbol ® are registered trademarks of
Siemens AG:

e HMI®

e SIMATIC®

e WinCC®

e SIMATIC MP 3770

MP 377, MP 377 PRO (WinCC flexible)
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Position in the information landscape

Conventions

These operating instructions form part of the SIMATIC HMI documentation. You can obtain
an overview of SIMATIC hardware and SIMATIC software products and SIMATIC systems
and information that can be called up in PDF format in various languages at the

following address:

"http://www.automation.siemens.com/simatic/portal/html_76/techdoku.htm"

The following designations are used in these operating instructions to represent
multiple HMI devices:

"MP 377" designates all MP 377 HMI devices.

"MP 377 mounting device" designates the following HMI devices:
e MP 377 12" Touch

e MP 377 12" Key

e MP 377 15" Touch

e MP 377 19" Touch

"MP 377 PRQO" designates the following HMI devices:

e MP 377 PRO 15" Touch

The following text notation will facilitate reading the Operating Instructions:

Notation Scope

"Add screen" e Terms that appear in the user interface, for example, dialog
names, tabs, buttons, menu commands

¢ Inputs required, for example limit values, tag values.
e Path information

"File > Edit" Operational sequences, for example, menu commands, shortcut
menu commands
<F1>, <Alt+P> Keyboard operation

Please observe notes labeled as follows:

Note

Notes contain important information concerning the product, its use or a specific section of
the documentation to which you should pay particular attention.

Figures in this documentation

This documentation contains figures pertaining to the hardware described herein. Newer
versions of the HMI device may differ from these figures.

MP 377, MP 377 PRO (WinCC flexible)
Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO
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Representatives and office locations

If you have any further questions relating to the products described in this manual, please
contact your local representative at the Siemens branch nearest you.

Locate your contact person at "http://www.automation.siemens.com/partner".

Training center

Siemens AG offers a variety of training courses in order to familiarize you with automation
systems. Contact your regional Training Center or the central Training Center in D-90327
Nuremberg, Germany.

Internet: "http://www.sitrain.com"

Technical support
Technical support for all industry sector products is available as follows:

Using the web form to request support
"http://www.siemens.com/automation/support-request”

Additional information about our technical support is available on the Internet under
"http://support.automation.siemens.com".

Service & Support on the Internet

Service & Support provides additional comprehensive information on SIMATIC products
through online services at "http://support.automation.siemens.com":

® The newsletter offers you the latest information about your products

® A large document base is available using our Service & Support search engine
e A forum for global exchange of information by users and experts

® Current product information, FAQs and downloads

® You local representative

® |nformation about on-site services, repairs, spare parts, and more

Recycling and disposal

The HMI devices described in these operating instructions can be recycled due to the low
levels of pollutants. Contact a certified disposal service company for environmentally sound
recycling and disposal of your old devices.

MP 377, MP 377 PRO (WinCC flexible)
Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO 5
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Overview 1

1.1 Product overview

The Multi Panel MP 377 HMI devices are an innovative advanced development of
the 370 series.

In addition to the established display sizes of 12", 15", and 19", the product series was
expanded to include the Multi Panel MP 377 PRO 15" Touch offering all around IP65 degree
of protection. The distinguishing feature of the HMI devices is that they fulfill the increasing
demands for technical innovation — especially in regard to display, performance and
extended applications.

Hardware equipment

The Multi Panel MP 377 has a TFT display with 64 K colors and improved performance
compared to predecessor devices. The Multi Panel MP 377 is based on Microsoft Windows
CE 5.0. Compared with previous devices, its multimedia functionality has been greatly
extended. Integration of the Microsoft Media Player allows the MP 377 to play videos.
Internet Explorer 6.0 for pocket PCs is pre-installed on the HMI devices and extends the
ways in which web pages can be displayed. Word documents, Excel spreadsheets and PDF
documents can be displayed with Microsoft Viewer.

The user memory has been expanded, and a retentive maintenance-free alarm buffer
integrated. A retentive memory for PLC data is provided to support WinAC MP.

Thanks to the wide range of devices, you can use the device best suited to your needs. The
MP 377 can be used for a wide range of applications, and offers high performance and a
favorable cost/performance ratio.

The HMI device has:

® 1 PROFIBUS interface

2 Ethernet ports for connection to PROFINET

2 USB 2.0 ports

1 slot for an SD memory card or multimedia card
1 CF card slot

1 TFT display with up to 64 K colors

The following extra software options have been added to the functions of the MP 377
as a "multifunctional platform™:

® WinCC flexible /Sm@rtService
® WinCC flexible /Sm@rtAccess
e WinCC flexible /OPC Server

e WinCC flexible /ProAgent

® WinCC flexible /Audit

e WinAC MP 2007

MP 377, MP 377 PRO (WinCC flexible)
Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO 13



Overview

1.7 Product overview

IP65 all-round

The Multi Panel MP 377 PRO, which features a housing with IP65 degree of protection, all
around protection against dust and water jets. The ready-to-use HMI device can be fixed
either from the top or the bottom to a support arm system or to a stand.

A basic adapter and adapter sets that can be ordered separately support fixing systems from
various manufacturers (including VESA standard for flat screens). The rear wall can be
removed quite easily. The interfaces of the HMI device can therefore be reached without any
problems. You do not require any special cables or connectors.

The Multi Panel MP 377 PRO is impressive not only due to ease of servicing but also
because of its sophisticated design and slimline device depth.

MP 377, MP 377 PRO (WinCC flexible)
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1.2 MP 377 mounting devices

1.2 MP 377 mounting devices

1.2.1 Design of the MP 377 12" Touch

Front view and side view

SIEMENS

Slot for an SD memory card or multimedia card
Slot for a CF memory card

Display/touch screen

Oblong holes for mounting clamps

Mounting seal

CECNCONCNC

Bottom view

©) Ports
@ Oblong holes for mounting clamps

MP 377, MP 377 PRO (WinCC flexible)
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Overview

1.2 MP 377 mounting devices

Rear view
©O) Slot for an SD memory card or multimedia card
® Rating label
® Slot for a CF memory card
@ DIP switch
® Interface name
See also

Ports

MP 377, MP 377 PRO (WinCC flexible)
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Overview

1.2 MP 377 mounting devices

1.2.2 Design of the MP 377 12" Key

Front view and side view

Slot for an SD memory card or multimedia card
Slot for a CF memory card

Display

Oblong holes for a mounting clamp

®@® 00

Mounting seal

Bottom view

©) Ports
® Oblong holes for a mounting clamp

MP 377, MP 377 PRO (WinCC flexible)
Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO 17
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1.2 MP 377 mounting devices

Rear view

Slot for an SD memory card or multimedia card
Rating label

Slot for a CF memory card
DIP switch
Interface name

®@®e 00

See also
Ports (Page 62)

MP 377, MP 377 PRO (WinCC flexible)
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1.2 MP 377 mounting devices

1.2.3 Design of the MP 377 15" Touch

Front view and side view

Slot for an SD memory card or multimedia card
Slot for a CF memory card

Display/touch screen

Oblong holes for mounting clamps

®@® 00

Mounting seal

Bottom view

® Ports
® Oblong holes for mounting clamps

MP 377, MP 377 PRO (WinCC flexible)
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Overview

1.2 MP 377 mounting devices

Rear view

See also

20

Slot for an SD memory card or multimedia card
Rating label

Slot for a CF memory card
DIP switch
Interface name

®@®e 00

Ports (Page 62)

MP 377, MP 377 PRO (WinCC flexible)
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1.2 MP 377 mounting devices

1.24 Design of the MP 377 19" Touch

Front view and side view

Slot for an SD memory card or multimedia card
Slot for a CF memory card

Display/touch screen

Oblong holes for mounting clamps

Mounting seal

®@®e 00

Bottom view

©) Ports
® Oblong holes for mounting clamps

MP 377, MP 377 PRO (WinCC flexible)
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1.2 MP 377 mounting devices

Rear view
| HIEHI
& ML i
e IIHI, [IIIIHIIIHHIIIHH'III\ \H,lllw (AT
0] Slot for an SD memory card or multimedia card
® Rating label
® Slot for a CF memory card
@ DIP switch
® Interface name

See also

Ports

MP 377, MP 377 PRO (WinCC flexible)
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1.3 MP 377 PRO

1.3 MP 377 PRO

1.3.1 Design of the MP 377 PRO 15" Touch

Front view and side view

O] Display with touch screen
® Housing
® Housing rear panel

Bottom view

@ Lower cover

MP 377, MP 377 PRO (WinCC flexible)
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1.3 MP 377 PRO

Rear view

) Housing rear panel
® Lower cover

1.3.2 Structure of the basic adapter

Seal

Cable channel

Mechanical interface to the MP 377 PRO

Mechanical interface to the adapter from the adapter set

The basic adapter is included in the product package of the MP 377 PRO. An adapter set

forms part of the basic adapter and can be ordered as an accessory. The basic adapter and
adapter set are required in order to fit the MP 377 PRO to a support arm or on a stand.

® e 00

See also

Accessories (Page 26)

MP 377, MP 377 PRO (WinCC flexible)
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1.4 Accessory kit

1.4 Accessory kit

Accessory kit for MP 377 mounting device
The accessory kit contains the following:
® Mains terminal for the power supply
® Mounting clamps for mounting the HMI device

Additional documents may be enclosed with the accessory Kkit.

Accessory kit for MP 377 PRO
The accessory kit contains the following:
® Mains terminal for the power supply
® Basic adapter as a basic element for fixing to a support arm
® Four screws for fixing the basic adapter to an adapter from an adapter set

Additional documents may be enclosed with the accessory kit.

MP 377, MP 377 PRO (WinCC flexible)
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1.5 Accessories

1.5 Accessories

Accessories are not included in the product package of the HMI device, but can ordered in
the Internet at "http://mall.automation.siemens.com".

RS 422 to RS 232 converter

The converter is required for the connection of controllers of other manufacturers. Connect
the RS 422 to RS 232 converter to the RS 422 / RS 485 interface. The converter converts
the input signals to RS-232 signals.

Order number for RS 422 to RS 232 converter: 6AV6 671-8XE00-0AXO0.

90° elbow adapter
If space is limited, you can use an elbow adapter at the RS 422/RS 485 interface.
Order number for 90° elbow adapter: 6AV6 671-8XD00-0AXO0.

Protective foil for HMI devices with touch screen
The protective foil prevents the touch screen from being scratched.

The protective foil can be ordered using the following order numbers:

HMI device Order no.

MP 377 12" Touch 6AV6 574-1AD00-4CX0
MP 377 15" Touch 6AV6 574-1AD00-4EX0
MP 377 PRO 15" Touch

MP 377 19" Touch 6AV7 672-1CE00-0AA0

Clamping frame

A clamping frame is available for the MP 377 12" Touch. If the material thickness around the
mounting cutout is < 2 mm, the clamping frame allows IP65 degree of protection or
enclosure type 4X/Type 12 to be achieved.

Order number for clamping frame for MP 377 12" Touch: 6AV6 671-8XS00-0AX0.

Key labeling strips
For the MP 377 12" Key, a kit containing two sets of blank key labeling strips can be ordered.
Order number for key labeling strips: 6AV6 574-1AB00-2BAO0.

MP 377, MP 377 PRO (WinCC flexible)
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1.5 Accessories

Service packages
The service packages include:
® Mounting seals
® Mounting clamps
® Power supply terminal, 2-pin

Service packages can be ordered for the following HMI devices using the following
order numbers:

HMI device Order no.
MP 377 12" Key 6AV6 574-1AA00-2BX0
MP 377 12" Touch 6AV6 671-4XA00-0AX0

MP 377 15" Touch
MP 377 19" Touch

Basic adapter
One basic adapter is included in the delivery scope of the MP 377 PRO 15" Touch.
Order number for the basic adapter as accessory: 6AV7674-0KA00-0AAO.

Adapter sets for support arm systems
The following adapter sets can be ordered for the MP 377 PRO:

Adapter set Suitable for support arm systems Order no.
Adapter set VESA75 and VESA100 compatible systems, 6AV7674-0KF00-0AAQ
VESA75/VESA100 Rose GTN Il support arm systems
Adapter set CP-L Rittal CP-L support arm systems 6AV7674-0KC00-0AA0D
Adapter set PLUS Bernstein CS-3000 Coupler 48, Rolec tara Plus, | 6AV7674-0KB00-0AAQ
Rolec Quadro, Rittal CP-S, Rose GT48/2,
Rose GTK electronic

Memory card

Only use SD memory cards, CF memory cards or MultiMediaCards tested and approved by
Siemens AG.

SIMATIC PC USB flash drive

The SIMATIC PC USB flash drive is a mobile form of data storage with a high data
throughput, designed for industrial use.

MP 377, MP 377 PRO (WinCC flexible)
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1.6 The HMI device in the operating process

1.6 The HMI device in the operating process

Project design

The HMI device is part of the operating process. The following two phases are key to the
way the HMI device is integrated in the operating process:

® Project design

® Process management

Visualization of the operating process is known as project design. Project design comprises:
® writing project data

® saving project data

e testing project data

e simulating project data

Project design is undertaken independently of the HMI device and results in a project. Once
this has been generated, the project can be transferred to the HMI device to control the
operating process.

=

Configuring PC HMI device

Process management

28

Process management is marked by two-way communication between HMI device and
controller. This lays the foundations for operator control and monitoring.

%ﬂm Control 1
Control 2
HMI device

The operator can intervene in the operating process on the HMI device for control purposes.
The controller in turn supplies the results of the operating process which are displayed on
the HMI device.

MP 377, MP 377 PRO (WinCC flexible)
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1.7

Alarms

1.7 Functional scope with WinCC flexible

Functional scope with WinCC flexible

The following tables show the objects that can be integrated in a project for an MP 377.

Note

The specified values are maximum values of the individual objects. Simultaneous use of
multiple objects with their maximum value can lead to problems in the active project.

Tags, values and lists

Object Specification MP 377
Alarms Number of discrete alarms 4000
Number of analog alarms 200
Length of the alarm text 80 characters
Number of tags in an alarm Max. 8
Display Alarm line, Alarm
window, Alarm view
Acknowledge error alarm individually Yes
Acknowledge multiple error alarms 16 alarm groups
simultaneously (group acknowledgement)
Edit alarm Yes
Alarm indicator Yes
ALARM_S Display S7 alarms Yes
Alarm buffer, retentive Alarm buffer capacity 1024 alarms
Simultaneously queued alarm events Max. 500
View alarm Yes
Delete alarm buffer Yes
Print alarms line by line Yes
Object Specification MP 377
Tags Quantity 2048
Limit value monitoring Input/output Yes
Linear scaling Input/output Yes
Text lists Quantity 500 M
Graphics lists Quantity 500
N The maximum total of text and graphics lists is 500.

MP 377, MP 377 PRO (WinCC flexible)
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1.7 Functional scope with WinCC flexible

Screens
Object Specification MP 377
Screens Quantity 500
Fields per screen 200
Tags per screen 400
Complex objects per screen 20
(for example, bars)
Template Yes
Recipes
Object Specification MP 377
Recipes Quantity 500
Data records per recipe 1000
Entries per recipe 1000
Recipe memory 128 Kb
Location e Memory card
e USB memory stick
e Network drive
N The number of recipe data records might be restricted by the capacity of the
storage medium.
Logs
Note
The HMI devices are suitable for the logging of relatively small volumes of data.
Manage the data in several adjacent archives in a segmented circular log. The use of a large
circular log has a negative effect on performance.
Object Specification MP 377
Logs Number of logs 50
Number of partial logs in a segmented 400
circular log
Entries per log 10 000
Filing format CSV with ANSI
character set
Location e Memory card
e USB memory stick
e Network drive
N The number of entries in the log may be restricted by the capacity of the
storage medium.
MP 377, MP 377 PRO (WinCC flexible)
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1.7 Functional scope with WinCC flexible

Safety
Object Specification MP 377
User view Number of user groups 50
Number of users 50
Number of authorizations 32
Info texts
Object Specification MP 377
Info texts Length (no. of characters) 320

(depending on font)

For alarms Yes
For screens Yes
For screen objects (for example, for 1/O field, Yes
switch, button, invisible button)
Additional functions
Object Specification MP 377
Screen settings Calibrating the touch screen " Yes
Brightness setting Yes
Language change Number of languages 16
VBScript User-specific extension of the functionality Yes
Number of scripts 100
Graphic objects Vector and pixel graphics Yes
Trends Quantity 400
Task planner Number of tasks 48
Text objects Quantity 30 000
Direct keys PROFIBUS DP direct keys Yes
PROFINET IO direct keys Yes

N MP 377 with touch screen only

MP 377, MP 377 PRO (WinCC flexible)
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1.8 Software options

1.8 Software options

The following software options are available for the MP 377:

32

WinCC flexible /Sm@rtService

The WiInCC flexible /Sm@rtService option enables you to access a remote HMI device or
PC via Ethernet.

WinCC flexible /Sm@rtAccess

The WinCC flexible /Sm@rtAccess option enables you to set up communication between
different HMI systems.

WinCC flexible /Audit

The WinCC flexible /Audit option extends the HMI device to include functions for
recording operations in an audit trail and electronic signature.

WinCC flexible /OPC-Server (OPC XML)

The WinCC flexible /OPC-Server option enables you to create communications to
OPC-capable applications from an HMI device or PC via Ethernet.

WinAC MP 2007
WInAC MP 2007 is PLC software capable of running on the MP 377.
WinCC flexible /ProAgent

The WinCC flexible /ProAgent option enables you to extend the HMI device to include
specific and high-speed process fault diagnostics.

Uninterruptible Power Supply (UPS) with USB support

When interfacing an uninterruptible power supply, the HMI device is shut down in a
controlled manner after a buffer time in the event of a power failure. The MP 377 supports
SITOP DC UPS modules connected via the USB port.

Microsoft Excel Viewer

Microsoft Excel Viewer enables you to view Excel documents.
Microsoft PDF Viewer

Microsoft PDF Viewer enables you to view PDF documents.
Microsoft Word Viewer

Microsoft Word Viewer enables you to view Word documents.

MP 377, MP 377 PRO (WinCC flexible)
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1.9 Communication

1.9 Communication

Number of connections
Connection MP 377
Number using a bus connection 6
Number of connections based on "SIMATIC HMI HTTP Protocol" 8
NOTICE

Communication faults with PROFINET 10

When you release PROFINET 10 in the HMI device's control panel, communication faults
may arise in the following cases:
e Use of PLCs from other manufacturers

e Use of SIMATIC 500/505 via NITP
Do not release PROFINET IO in the HMI device's control panel in the cases given.

MP 377, MP 377 PRO (WinCC flexible)
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1.9 Communication

PLCs

34

The following table shows the PLCs which can be used with the HMI devices and the
protocols or profiles which can be used.

PLC

Protocol

MP 377

SIMATIC S7

« PPI

o MPI Y

« PROFIBUS DP
+ PROFINET

Yes

SIMATIC S5

¢ PROFIBUS DP

Yes

SIMATIC 500/505

e NITP
e PROFIBUS DP

Yes

SIMATIC HMI HTTP Protocol

e HTTP/HTTPS (Ethernet)

Yes

Allen-Bradley

PLC series SLC500, SLC501, SLC502, SLC503,
SLC504, SLC505, MicroLogix and PLC5/11,
PLC5/20, PLC5/30, PLC5/40, PLC5/60, PLC5/80

e DF12956

e DH+ via KF2 module 3 % 6)

e DH485 via KF3 module 4 5 6
e DH48549)

Yes

ControlLogix and CompactLogix PLC series
o Ethernet/IP

Yes

GE Fanuc Automation

PLC series 90-30, 90-70, VersaMax Micro
e SNP®)

Yes

LG Industrial Systems
(Lucky Goldstar)/IMO

PLC series GLOFA GM (GM4, GM6 and GM7),
Series G4, G6 and G7

e Dedicated communication ©)

Yes

Mitsubishi Electric

PLC series MELSEC FX and MELSEC FX0
o FX8

Yes

PLC series MELSEC FX0, FX1n, FX2n, AnA,
AnN, AnS, AnU, QnA and QnAS

e Protocol 49

Yes

Modicon
(Schneider Automation)

PLC series Modicon 984, TSX Quantum and
TSX Compact

e Modbus RTU9®)

Yes

PLC series Quantum, Momentum, Premium and
Micro
PLC series Compact and 984 via Ethernet bridge

e Modbus TCP/IP (Ethernet)

Yes

MP 377, MP 377 PRO (WinCC flexible)
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1.9 Communication

P47/67/87/107 420, TSX 7 with P47/67/87/107
425, module TSX SCM 21.6 with the specified
TSX 7 CPUs, TSX 17 with module SCG 1161,
TSX 37 (Micro) and TSX 57 (Premium)

¢ Hostlink/Multilink (SYSMAC Way)9)

PLC Protocol MP 377
OMRON PLC series SYSMAC C, SYSMAC CV, SYSMAC Yes
CS1, SYSMAC alpha and CP
e Hostlink/Multilink (SYSMAC Way)®)
Telemecanique PLC series TSX 7 with P47 411, TSX 7 with Yes

" Not possible when connected to S7-212.

2 Applies to controllers SLC503, SLC504, SLC505, PLC5, MicroLogix.
3  Applies to controllers SLC504, PLC5 over DF1.

4 Applies to controllers SLC500 to SLC 505 and MicroLogix.

5  Only with converter RS 422-RS 232 6AV6 671-8XE00-0AXO0 (option).
6  PROFINET IO must be locked.

MP 377, MP 377 PRO (WinCC flexible)
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1.9 Communication
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Safety instructions and approvals 2

2.1 Safety instructions

High frequency radiation

NOTICE

Unwanted operating states

High-frequency radiation, for example, from cellular phones, can trigger unwanted
operating states.

Proper use

AWARNING

Commissioning the HMI device is prohibited until it has been absolutely ensured that the
machine in which the HMI device is to be installed complies with Directive 98/37/EC or
Directive 2006/42/EC as of December 29, 2009.

Hazardous areas

When operating the HMI device in hazardous areas the following warning applies.

A WARNING

Explosion Hazard

Do not disconnect while circuit is live unless area is known to be non-hazardous.
Substitution of components may impair suitability for Class |, Division 2 or Zone 2.

MP 377, MP 377 PRO (WinCC flexible)
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Safety instructions and approvals
2.1 Safely instructions

Working on the control cabinet
The following information applies to MP 377 mounting devices.

AWARNING
Open equipment

The HMI device is open equipment. This means that the HMI device may only be mounted
in housings or cabinets, whereby the device can be operated from the front panel.

The cubicle or cabinet in which the HMI device is installed may only be accessed with a key
or tool and only by trained, authorized personnel.

Dangerous voltage
Opening the cabinet will expose high voltage parts. Contact with these parts could be fatal.

Always disconnect the cabinet from the mains before opening it.

MP 377, MP 377 PRO (WinCC flexible)
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Safety instructions and approvals
2.2 Standards, certificates and approvals

2.2 Standards, certificates and approvals

Approvals

A\ crution

The following overview shows possible approvals.

The HMI device itself is certified as shown on the rear panel labels.

CE approval

C€

The HMI device meets the general and safety-related requirements of the following EC
directives and conforms to the harmonized European standards (EN) for programmable logic
controllers published in the official gazettes of the European Union:

e 2004/108/EC "Electromagnetic Compatibility" (EMC Directive)

e 2006/95/EC "Electrical equipment for use within specific voltage limits" (Low-Voltage
Directive)

EC Declaration of Conformity

The EC Declarations of Conformity are available to the relevant authorities at the following
address:

Siemens Aktiengesellschaft
Industry Sector

1A AS RD ST PLC

P.O. Box 1963

D-92209 Amberg

MP 377, MP 377 PRO (WinCC flexible)
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2.2 Standards, certificates and approvals

UL approval

@

Underwriters Laboratories Inc., to

e UL 508 (Industrial Control Equipment)

® (CSA C22.2 No. 142 (Process Control Equipment)
or

@

HAZ. LOC.
Underwriters Laboratories Inc., to

e UL 508 (Industrial Control Equipment)

® (CSA C22.2 No. 142 (Process Control Equipment)
e UL 1604 (Hazardous Location)

® (CSA-213 (Hazardous Location)

Approved for use in

® C(Class I, Division 2, Group A, B, C, D or

® C(Class I, Zone 2, Group IIC or

® non-hazardous locations

FM approval (MP 377 mounting device only)

APPROVED
Factory Mutual Research (FM) conforming to
e Approval Standard Class Number 3611, 3600, 3810
Approved for use in
e (Class I, Division 2, Group A, B, C, D T4
® C(Class |, Zone 2, Group IIC T4

Marking for Australia

IEC 61131

40

0 N117

The HMI device fulfills the requirements of standard AS/NZS 2064 (Class A).
The HMI device fulfills requirements and criteria to IEC 61131-2, Programmable Logic
Controllers, Part 2: Operating resource requirements and tests.

MP 377, MP 377 PRO (WinCC flexible)
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2.3 Notes about usage

2.3 Notes about usage

Industrial applications
The HMI device is designed for industrial applications. It conforms to the following standards:
® Requirements for emissions EN 61000-6-4: 2007
® Requirements for interference immunity EN 61000-6-2: 2005

Use in residential areas

Note

The HMI device is not intended for use in residential areas. Operation of an HMI device in
residential areas can have a negative influence on radio/TV reception.

If the HMI device is used in a residential area, you must take measures to achieve Limit
Class B conforming to EN 55011 for RF interference.

Suitable measures for achieving the degree of noise suppression for Limit Class B include,
for example:

e |nstallation of the HMI device in grounded control cabinets
® Use of filters in electrical supply lines

Individual acceptance is required.

MP 377, MP 377 PRO (WinCC flexible)
Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO 41



Safety instructions and approvals

2.4 Electromagnetic compatibility

24 Electromagnetic compatibility

Introduction

The HMI device fulfills, among other things, the requirements of the EMC law pertaining to
the domestic European market.

EMC-compatible installation of the HMI device

The EMC-compliant installation of the HMI device and the application of interference-proof
cable is the basis for interference-free operation. The "Directives for interference-free
installation of PLCs" and the "PROFIBUS Networks" manual also apply for the installation of
the HMI device.

Pulse-shaped disturbance

The following table shows the electromagnetic compatibility of modules with regard to pulse-
shaped interference. The precondition for electromagnetic compatibility is that the HMI
device meets the specifications and guidelines for electrical installation.

(high-speed transient
interference)

in accordance with
IEC 61000-4-4

2 kV signal cable, > 30 m
1 kV signal cable, <30 m

Pulse-shaped disturbance Tested with Degree of
severity

Electrostatic discharge Air discharge: 8 kV 3

in accordance with Contact discharge: 6 kV

IEC 61000-4-2

Burst pulses 2 kV power supply cable 3

High-power surge pulses in accordance with IEC 61000-4-5, external protective circuit required
(refer to the manual Automation System S7-300, Installation, "Lightning and
overvoltage protection" section)

DC voltage with protective elements

1 KV signal cable, > 30 m,
with protective elements as required

Asymmetrical coupling 2 kV power cable 3
DC voltage with protective elements
2 kV signal/data cable, > 30 m,
with protective elements as required

Symmetrical coupling 1 kV power cable 3

MP 377, MP 377 PRO (WinCC flexible)
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2.4 Electromagnetic compatibility

Sinusoidal interference

The following table shows the EMC behavior of the modules with respect to sinusoidal
interference. This requires the HMI device to meet the specifications and directives for
electrical installation.

Sinusoidal interference Test values Degree of
severity

HF radiation (in e 80% amplitude modulation at 1 kHz 3

electromagnetic fields) in with 10 V/m in the range of 80 MHz to 1 GHz

accordance with with 3 V/m in the range 1.4 GHz to 2 GHz

IEC 61000-4-3 with 1 V/m the range 2 GHz to 2.7 GHz

e 10 V/m with 50% pulse modulation at 900 MHz
10 V/m with 50% pulse modulation at 1.89 GHz

RF interference current on Test voltage 10 V, with 80% amplitude modulation 3
cables and cable shielding of 1 kHz in the 9 MHz to 80 MHz range
conforming to IEC 61000-4-6

Emission of radio interference

The following table shows the unwanted emissions from electromagnetic fields in
accordance with EN 55011, Limit Value Class A, Group 1, measured at a distance of 10 m.

From 30 to 230 MHz <40 dB (uV/m) quasi-peak
From 230 to 1000 MHz < 47 dB (uV/m) quasi-peak

Additional measures

If you want to connect an HMI device to the public power supply system, you must ensure
Limit Value Class B in accordance with EN 55022.
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2.5 Transport and storage conditions

Mechanical and climatic conditions for transportation and storage

This HMI device meets the requirements for IEC 61131-2 relating to transport and storage
conditions. The following specifications apply to the transport and storage of an HMI device
in its original packaging.

The climatic conditions conform to the following standards:

e |EC 60721-3-3, Class 3K7 for storage

e |EC 60721-3-2, Class 2K4 for transport

Mechanical requirements conform to EC 60721-3-2, Class 2M2.

Type of condition Permitted range
Drop test (in transport package) <1m
Temperature From -20 to +60 °C
Atmospheric pressure From 1 080 hPa to 660 hPa,
corresponds to an elevation of —1000 to 3500 m
Relative humidity From 10 to 90%, without condensation
Sinusoidal vibration in accordance with 5t0 9 Hz: 3.5 mm
IEC 60068-2-6 9 Hz to 500 Hz: 9.8 m/s?2

Shock in accordance with IEC 60068-2-29 | 250 m/s2, 6 ms, 1000 shocks

NOTICE
Avoid dewing

If the HMI device is subjected to low temperatures or extreme fluctuations in temperature
during transportation, moisture could occur on or inside the HMI device. Dewing can occur.
This can cause malfunctions.

The HMI device must have acquired room temperature before it is put into operation. Do
not expose the HMI device to direct radiation from a heater in order to warm it up. If there is
condensation, wait approximately 4 hours until the HMI device has dried completely before
switching it on.

Proper transport and storage, installation and assembly as well as careful operation and
maintenance are required to ensure trouble-free and safe operation of the HMI device.

The warranty for the HMI device will be deemed void if these stipulations are not heeded.

MP 377, MP 377 PRO (WinCC flexible)
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Planning application

3.1 Notes about usage

Mechanical and climatic conditions of use

The HMI device is designed for use in a location protected from the effects of the weather.
The conditions of use meet the requirements for DIN IEC 60721-3-3:

e (Class 3M3 (mechanical requirements)

® (Class 3K3 (climatic requirements)

Use with additional measures

The HMI device should not be used at the following locations unless additional measures
are taken:

® |n locations with a high degree of ionizing radiation
® |n locations with severe operating conditions, for example, due to:
— Corrosive vapors, gases, oils or chemicals
— Electrical or magnetic fields of high intensity
® |n plants that require special monitoring - for example:
— Elevators
— Systems in especially hazardous rooms

Mechanical ambient conditions

The mechanical ambient conditions for the HMI device are specified in the following table in
terms of sinusoidal vibration.

Frequency range in Hz | Constant Occasional
10<f<58 Amplitude 0,0375 mm Amplitude 0.075 mm
58 <f<150 Constant acceleration 0,5 g Constant acceleration 1 g

Reducing vibrations

If the HMI device is subjected to greater shocks or vibrations, you must take appropriate
measures to reduce acceleration or amplitudes.

We recommend mounting the HMI device on damping materials (on rubber-metal vibration
dampers, for example).

MP 377, MP 377 PRO (WinCC flexible)
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3.1 Notes about usage

Testing mechanical ambient conditions

The following table provides information on the type and scope of tests for mechanical

ambient conditions.

Tested for

Test standard

Comments

Vibrations

Vibration test in accordance
with IEC 60068, part 2-6
(sinusoidal)

10 = f < 58,

58 <f< 150,

Type of vibration:
Transitional rate of the frequency:
1 octave/minute.

Constant amplitude 0.075 mm

constant acceleration 1 g,
with support arm 0.5 g on the basic adapter

Vibration duration:

10 frequency cycles per axis at each of the three
associated vertical axes

Shock

Shock test in accordance
with IEC 60068, Part 2 -27

Type of shock: Half-sine

Shock intensity:
Peak value 15 g, duration 11 ms

Direction of impact:
3 shocks in * direction at each one of the three
associated vertical axes

Climatic ambient conditions

The following table shows the climatic ambient conditions for operation of the HMI device.

Ambient conditions

Permitted range

Comments

Temperature

e Vertical installation
MP 377 12" Touch
MP 377 12" Key
MP 377 15" Touch
MP 377 19" Touch
MP 377 PRO 15" Touch

e Inclined installation
MP 377 12" Touch
MP 377 12" Key
MP 377 15" Touch
MP 377 19" Touch
MP 377 PRO 15" Touch

From 0 to 50° C
From 0 to 50° C
From 0 to 50° C
From 0 to 50° C
From 0 to 45° C

From 0 to 40° C
From 0 to 40° C
From 0 to 35° C
From 0to 35° C
From 0 to 45° C

MP 377 12" Touch,

MP 377 12" Key,

MP 377 15" Touch,

MP 377 19" Touch:

See section Mounting positions
and type of fixation (Page 47)

MP 377 PRO 15" Touch:
See section Mounting positions
(Page 51)

Relative humidity

10 to 90%, without condensation

Atmospheric pressure

1080 to 795 hPa

Corresponds to an elevation
of =1 000 m to 2 000 m

Pollutant concentration

S0O2: < 0.5 vpm;
Relative humidity < 60%,
no condensation

Test: 10 cm3/m3; 10 days

H2S: < 0.1 vpm;
Relative humidity < 60%,
no condensation

Test: 1 cm3/m3; 10 days
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3.2 MP 377 mounting devices

3.2 MP 377 mounting devices

3.21 Mounting positions and type of fixation

Mounting position
The HMI device is suitable for installation in:
® Mounting cabinets
e Control cabinets
e Switchboards
® Consoles

In the following, all of these mounting options are referred to by the general term "cabinet".

The HMI device is self-ventilated and approved for vertical and inclined mounting in
stationary cabinets.

Mounting position Deviation from the vertical
® Inclined < 35°
® Vertical 0°
CAUTION

Damage due to overheating

An inclined installation reduces the convection by the HMI device and therefore the
maximum permissible ambient temperature for operation.

If there is sufficient forced ventilation, the HMI device can also be operating in the
inclined mounting position up to the maximum permissible ambient temperature

for vertical installation.

Otherwise, the HMI device may be damaged and the approvals and warranty for the
HMI device may become void.

For information regarding the permissible ambient temperatures, refer to Notes about usage
(Page 45).
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3.2 MP 377 mounting devices

Mounting

Metal mounting clamps are provided for mounting. The mounting clamps hook into the
oblong holes on the HMI device.

"

F
I

@ Threaded pin
® Hook

3.2.2 Preparing for installation

Select the mounting location of the HMI device
Points to observe when selecting the mounting location:
® Position the HMI device so that it is not subjected to direct sunlight.
e Position the HMI device such that it is ergonomically accessible for the user.
Choose a suitable mounting height.
® Ensure that the air vents of the HMI device are not covered as a result of the mounting.
® Note the permissible mounting positions.

NOTICE

Stability of the mounting cutout

The material in the area of the mounting cutout must provide sufficient strength to
guarantee the enduring and safe mounting of the HMI device.

The force of the clamps or operation of the device may not lead to deformation of the
material in order to achieve the degrees of protection described below.

Degrees of protection
The protection ratings are only ensured if the mounting cutout conforms to the following:

e Material thickness at the mounting cutout for IP65 degree of protection or for
enclosure type 4X/type 12 (indoor use only): 2 mm to 6 mm

® Permitted deviation from plane at the mounting cutout: < 0.5 mm
This condition must be fulfilled for the mounted HMI device.
® Permissible surface roughness in the area of the seal: < 120 ym (Rz 120)

A clamping frame is additionally available for mounting the MP 377 12" Touch to panels with
a material thickness < 2 mm at the mounting cutout. The frame enables IP65 degree of
protection or enclosure type 4X/type 12 to be achieved.

MP 377, MP 377 PRO (WinCC flexible)
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Planning application

Dimensions of the mounting cutout

3.2 MP 377 mounting devices

The following table shows the dimensions of the required mounting cutout:

Mounting cutout

MP 377 12" Touch

MP 377 12" Key

MP 377 15" Touch

MP 377 19" Touch

Width 310*" mm 450" mm 367" mm 4491 mm
Height 248*' mm 290*" mm 289*" mm 379" mm
HMI device depth, 72 mm 59 mm 72 mm 75 mm

not including front
panel

Note

You can insert an MP 377 12" Key into the mounting cutout of the following HMI devices:
e MP 370 12" Key

o MP 277 10" Key

e MP 270 10" Key

e OP27010"

You can insert an MP 377 12" Touch into the mounting cutout of the following HMI devices:
e MP 370 12" Touch

e MP 277 10" Touch

e MP 270 10" Touch

e OP27010"

You can insert an MP 377 15" Touch into the mounting cutout of the following HMI device:
e MP 370 15" Touch

Maintaining clearances
The HMI device must be installed with the following clearances:
® 50 mm above and below the mounting cutout respectively for ventilation

e 15 mm to the right and left of the mounting cutout respectively for suspending the
mounting clamps for mounting

® Atleast 10 mm behind the rear panel of the HMI device

NOTICE

Ensure that the maximum ambient temperature is not exceeded when mounting the
device in a cabinet and especially in a closed enclosure.

MP 377, MP 377 PRO (WinCC flexible)

Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO 49



Planning application
3.2 MP 377 mounting devices

3.23 Information on insulation tests, protection class and degree of protection

Test voltages

Insulation strength is demonstrated in the type test with the following test voltages in
accordance with IEC 61131-2:

Circuits with a nominal voltage of Ue to Test voltage
other circuits or ground
<50V 500 V DC

Protection class

Protection Class | in accordance with IEC 60536, i.e. PE/ground terminal to profile rail
required!

Protection against foreign objects and water

Degree of protection in accordance with Explanation

IEC 60529

Front When mounted:
e |P65

e Enclosure Type 4X/Type 12 (indoor use only)

Rear panel IP20

Touch protection test with standard test probes. There is
no protection against ingress by water.

The degree of protection at the front can only be guaranteed if the mounting seal is installed
flush to the mounting cutout.

3.24 Rated voltages

The table below shows the rated voltage and the corresponding tolerance range.

Rated voltage Tolerance range
+24 VDC 19.210 28.8 V (+/-20%)

MP 377, MP 377 PRO (WinCC flexible)
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3.3 MP 377 PRO

3.3 MP 377 PRO

3.3.1 Mounting positions

Mounting position
The HMI device is self-ventilated and approved for vertical and inclined mounting.

Mounting position Deviation from the vertical
©) Inclined < 35°
® Vertical 0°
3.3.2 Preparing for installation

Select the mounting location of the HMI device
Points to observe when selecting the mounting location:
e Position the HMI device so that it is not subjected to direct sunlight.

e Position the HMI device such that it is ergonomically accessible for the user. Choose a
suitable mounting height.

® Observe the permissible mounting positions for the HMI device.
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3.3MP 377 PRO

3.3.3 Information on insulation tests, protection class and degree of protection

Test voltages

Insulation strength is demonstrated in the type test with the following test voltages in

accordance with IEC 61131-2:

Circuits with a nominal voltage of Ue to other | Test voltage
circuits or ground
<50V 500 VDC

Protection class

Protection Class | in accordance with IEC 60536, i.e. PE/ground terminal to

profile rail required!

Protection against foreign objects and water

The following degree of protection applies to the HMI device:

Device side

Degree of protection in accordance with IEC 60529

all sides

e |P65
e Enclosure Type 12 (indoor use only)
e Enclosure Type 4X/Type 12 (indoor use only)

3.34 Rated voltages

The table below shows the rated voltage and the corresponding tolerance range.

Rated voltage

Tolerance range

+24 VDC

19.21028.8 V (+/-20%)
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Mounting and connecting 4

4.1 Checking the package contents

Check the package content for visible signs of transport damage and for completeness.

NOTICE

Damaged parts
A damaged part will cause the HMI device to malfunction.

Do not install parts damaged during shipment. In the case of damaged parts, contact your
Siemens representative.

The following is included in the product package of the MP 377 mounting device:
e HMI device

® Accessory kit with mounting clamps and mains terminal

The following is included in the product package of the MP 377 PRO:

o HMI device

® Basic adapter for fixing to a support arm

® Four screws for fitting the basic adapter

® Mains terminal

Additional documents may be included in the product package of all HMI devices.

The documentation belongs to the HMI device and is required for subsequent
commissioning. Retain all enclosed documentation for the entire service life of the HMI
device. You must pass on the enclosed documentation to any subsequent owner or user of
the HMI device. Make sure that every supplement to the documentation that you receive is
stored together with the operating instructions.

MP 377, MP 377 PRO (WinCC flexible)
Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO 53



Mounting and connecting
4.2 Installing the HM/ device

4.2 Installing the HMI device

421 Installing the MP 377 mounting device

Requirement
All packaging components and protective foils should be removed from the HMI device.

To install the HMI device, you need the mounting clamps from the accessory kit. The
mounting seal must be fitted on the HMI device. If the mounting seal is damaged, order a
replacement seal. The mounting seal is part of the associated service pack.

To ensure the necessary degree of protection on the HMI device, the mounting clamps must
observe the positions listed below.

The following photo shows how positions 1 to 10 are counted.

MP 377, MP 377 PRO (WinCC flexible)
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4.2 Installing the HMI device

Positions of mounting clamps on the MP 377 12" Touch
The following figure shows the counting direction for the insertion of the mounting clamps.

)

1! \

A [\

| D
The following table shows the positions of the mounting clamps on the MP 377 12" Touch.
Observe the counting direction.

Page Number of mounting Position 1 Position 2 Position 3
clamps

Top 3 2 11 20

Right 3 2 9 16

Bottom 3 2 11 20

Left 3 2 9 16

Positioning the mounting clamps on the MP 377 12" Key

A total of 10 mounting clamps are needed for mounting. Fit mounting clamps
in all the cutouts.
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4.2 Installing the HM/ device

Positioning the mounting clamps on the MP 377 15" Touch

Positions of the mounting clamps on the MP 377 19" Touch

56

The following figure shows the counting direction for the insertion of the mounting clamps.

)

o)

)

The following table shows the positioning of the mounting clamps on the MP 377 15" Touch.
Observe the counting direction.

Page Number of Position 1 Position 2 Position 3 Position 4
mounting clamps

Top 4 2 9 17 24

Right 3 3 10 17 -

Bottom 4 2 9 17 24

Left 3 3 10 17 -

The positions of the mounting clamps are marked by stamps on the cutouts.

The following diagram shows examples of these stamps.

@ Stamps identifying the position of a mounting clamp

A total of 18 mounting clamps are needed for mounting. Fit mounting clamps in all the
stamped cutouts.

MP 377, MP 377 PRO (WinCC flexible)
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Procedure

4.2 Installing the HMI device

NOTICE

Installation of the HMI device
Always mount the HMI device according to the instructions in this manual.
Risk of guaranteed level of protection not being met

If the mounting seal is damaged or protrudes beyond the HMI device, the level of protection
is not ensured.

Check the fit of the mounting seal.

Note

Tighten the threaded pins of the mounting clamps until the HMI device is flush with the
surface of the control cabinet. Alternatively, tighten the mounting clamps using a maximum
torque of 0.2 Nm.

Proceed as follows:
1. Check that the mounting seal is fitted on the HMI device.

Do not install the mounting seal turned inside out. This may cause leaks in
the mounting cutout.

2. Insert the HMI device into the mounting cutout from the front.

3. Insert a mounting clamp into the cutout provided on the HMI device.
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4. Fasten the mounting clamp @ by tightening the threaded pin @.
5. Repeat steps 3 and 4 for all mounting clamps.
6. Check the fit of the mounting seal.

If necessary, repeat steps 1 to 6.
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4.2 Installing the HM/ device

Result

The HMI device is mounted and the relevant level of protection is ensured at the front.

See also
Accessory kit (Page 25)
Accessories (Page 26)

Information on insulation tests, protection class and degree of protection (Page 50)

4.2.2 Installing MP 377 PRO

Requirement
All packaging components and protective foils should be removed from the HMI device.

To install the HMI device, you need the basic adapter and an adapter set from the
accessories.

The following cables are fed through the stand or the support arm to which the HMI device
will be fixed:

e Equipotential bonding cable
® Power supply cable
e Data cables, such as PROFINET, USB

NOTICE

Warranty endangered

If you install the HMI device not in accordance with the specifications given in these
operating instructions, the warranty for the HMI device will become void.

Always install the HMI device according to these operating instructions.
IP65 degree of protection at risk

If there are no seals on the adapters or these are damaged, then IP65 degree of
protection is at risk. Check the condition and seating of the seals.

If the seal on the rear panel of the housing is damaged, it can be repaired. For a repair
scenario, follow the procedure described in the section "Spare parts and repairs
(Page 274).

Note

The warranty for the IP65 degree of protection assumes that the support arm or the stand
also complies with IP65.
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4.2 Installing the HMI device

Procedure
This section describes how to install the device on a support arm system. Installation on a

stand is carried out analogously.

Proceed as follows:
1. Remove the 10 screws ® of the housings rear panel using a size 2 Allen wrench.

2. Remove the rear panel of the housing @ and store it in a secure location.

. Fasten the support arm head @ to the adaptor plate ® using the four M6 x 12 screws
from the accessory kit of the adapter set. Ensure that the seal is properly seated.

4. Fasten the base adapter ® to the adaptor plate ® using the four M6 x 12 screws from
the accessory kit of the adapter set. Ensure that the seal is properly seated.

NOTICE

Do not exceed the permissible torque

If you fasten the screw @ with a torque > 1.2 Nm, the threads in the housing may be
damaged.

Alternatively, tighten the screws using a maximum torque of 1.2 Nm.

5. Fasten the base adapter ® to the mechanical interface using the four screws @ of the
cover. Ensure that the seal is properly seated.

MP 377, MP 377 PRO (WinCC flexible)
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4.2 Installing the HM/ device

6. Fasten the HMI device to the support arm @.

In doing so, ensure that all connections are fed (without damage) through the adapter into
the inside of the HMI device.

7. If you want to connect the cables at a later point in time, fasten the housing rear panel @
to the HMI device.

Result
The HMI device is fitted and can be connected electrically.

See also
Accessory kit (Page 25)
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4.3 Connecting the HMI device

431 Overview

Requirement

® The HMI device must be mounted according to the specifications of
these operating instructions.

e Always use shielded standard cables for the data cable.

Additional information is available in the catalog and online order system at
"http://mall.automation.siemens.com".

Connection sequence
Connect the HMI device in the following sequence:
1. Equipotential bonding
2. Power supply

Perform a power-up test to ensure the power supply is connected with
the correct polarity.

3. PLC
4. Configuring PC as necessary

5. 1/Os as necessary

NOTICE
Damage to the HMI device

If you do not keep to the connection sequence you could damage the HMI device.

Ensure you connect the HMI device in the sequence stipulated above.

Disconnect the HMI device by completing the above steps in reverse order.

Connecting the cables

When connecting the cables, ensure that the contact pins are not bent. Secure the cable
connectors by screwing the connector onto the socket.

Provide adequate strain relief for the cables. For this purpose, the MP 377 PRO contains a
strain relief bar below the ports on the rear of the HMI device.
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4.3 Connecting the HM/ device

43.2 Ports
The following figure shows the ports of the HMI device MP 377.

Power supply connector
RS-422/RS-485 port X10/ IF1b
PROFINET, 2 ports X1 P1 and X1 P2
USB, ports X20 and X21

Line in and micro

®Oe 6000

Line out
Connect PROFIBUS DP or MPI to the X10/ IF1b port.

You can affix the USB and PROFINET connecting cables to the rear panel of the HMI device
with cable ties.

See also
Design of the MP 377 12" Touch (Page 15)
Design of the MP 377 12" Key (Page 17)
Design of the MP 377 15" Touch (Page 19)
Design of the MP 377 19" Touch (Page 21)
Design of the MP 377 PRO 15" Touch (Page 23)
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4.3 Connecting the HMI device

4.3.3 Connecting the equipotential bonding circuit

Differences in electrical potential

Differences in electrical potential can develop between spatially separated plant
components. Such electrical potential differences can lead to high equalizing currents over
the data cables and therefore to the destruction of their interfaces. Equalizing currents

can develop if the cable shielding is terminated at both ends and grounded to different
plant parts.

Differences in potential may develop when a system is connected to different
mains supplies.

General requirements for equipotential bonding

Differences in potential must be reduced by means of equipotential bonding in order to
ensure trouble-free operation of the relevant components of the electronic system. The
following must therefore be observed when installing the equipotential bonding circuit:

The effectiveness of equipotential bonding increases as the impedance of the
equipotential bonding conductor decreases or as its cross-section increases.

If two plant parts are interconnected by means of shielded data cables and their shielding
is bonded at both ends to the grounding/protective conductor, the impedance of the
additionally installed equipotential bonding cable must not exceed 10% of the

shielding impedance.

The cross-section of an equipotential bonding conductor must be capable of handling the
maximum equalizing current. Experience has shown that equipotential bonding
conductors with a minimum cross-section of 16 mm? should be fitted between the control
cabinets or the ground point of the supporting arm or the stand for PRO HMI devices.

Use equipotential bonding conductors made of copper or galvanized steel. Establish a
large surface contact between the equipotential bonding conductors and the
grounding/protective conductor and protect these from corrosion.

Use a suitable cable clip to clamp the shield of the data cable flush to the equipotential
bonding rail. Keep the length of cable between the HMI device and the equipotential
bonding rail as short as possible.

Route the equipotential bonding conductor and data cables in parallel and with minimum
clearance between these.
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Mounting and connecting

4.3 Connecting the HMI device

Wiring diagram

Chassis terminal on the HMI device, example

Equipotential bonding conductor cross-section: 4 mm?2

Control cabinet

Equipotential bonding conductor cross-section: min. 16 mm?2

Ground connection

Cable clip

Equipotential bonding rail

Parallel routing of the equipotential bonding conductor and data cable

CECNCNGCNCNCHECNC)

CAUTION

Damage to the interface modules possible

Cable shielding is not suitable for equipotential bonding.

Use only the prescribed equipotential bonding conductors. The equipotential bonding
conductor ® must not be less than 16 mm?2. The interface modules may otherwise be
damaged or destroyed.

MP 377, MP 377 PRO (WinCC flexible)
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Mounting and connecting
4.3 Connecting the HMI device

Connecting the power supply

434

Wiring diagram

The following figure shows the connection between the power supply and HMI device.

MP 377 12" Touch

0

0

—

(S

MP 377 12* Key

MP 377 15“ Touch

MP 377 19" Touch

MP 377 PRO 15" Touch

Note when connecting

The mains terminal for connecting the power supply is contained in the accessory kit. The

mains terminal is designed for cables with a maximum cross-section of 1.5 mm2.

MP 377, MP 377 PRO (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

Connecting the mains terminal

NOTICE
Damage

Do not tighten the screws of the power supply terminal if it is plugged into the HMI device.
The pressure from the screwdriver may otherwise damage the HMI device socket.

Only connect the wires when the mains terminal is withdrawn.

p GND
+24 VDC

Connect the power supply terminal to the cables of the power supply as shown in the figure
above. Ensure that the lines are connected properly to the correct terminals. Refer to the
label for the contact pins on the rear of the HMI device.

Reverse polarity protection
The HMI device is equipped with a reverse polarity protection circuit.

Connecting the power supply

CAUTION
Safe electrical isolation

Use only 24 VDC power supply units with safe electrical isolation in accordance with
IEC 60364-4-41 or HD 384.04.41 (VDE 0100, Part 410), e.g. to PELV standard.

The supply voltage must be within the specified voltage range. Otherwise, malfunction at
the HMI device cannot be ruled out.

Applies to non-isolated plant configurations:

Connect the GND 24 V connection from the 24 V power supply output to equipotential
bonding for uniform reference potential. You should always select a central point
of termination.

See also
Connecting an uninterruptible power supply (Page 67)
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Mounting and connecting
4.3 Connecting the HMI device

4.3.5 Connecting an uninterruptible power supply

Connection graphic

The following figure shows the connection between the uninterruptible power supply and
HMI device. The uninterruptible power supply is connected to the 24-V input and one of the
HMI device's USB ports.

When connected to the HMI device's USB port, the following uninterruptible power supplies
are supported:

SITOP DC UPS modules as of a rated power value of 6 A, e.g. 6EP1931-2DC42

Uninterruptible power supply

m

MP 377 12" Touch

MP 377 12* Key

[
MP 377 15 Touch T Vi
ke e s e S e

Note

Observe all the notes relating to connecting a power supply.

See also
Connecting the power supply (Page 65)
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Mounting and connecting

4.3 Connecting the HMI device

Connecting the PLC

4.3.6

Wiring diagram

The following figure shows the connection between the PLC and HMI device.

PROFINET

L

SIMATIC S7

}_( PROFINET (Ethernet/LAN)

-
-

| SIMATIC 500/505 }—(

PLC’

RS 485

SIMATIC S7

RS 485

SIMATIC S5

RS 485

RS 422

| SIMATIC 500/505 }—(

RS 422/RS 485

L
L
L

PLC’

RS 485

RS 232

RS 422

RS 232

PLC’

PLC’

MP 377 12“ Touch

" PLC of other manufacturer

—

L -

MP 377 12“ Key

MP 377 15* Touch

g

5

-

(NI
il

e}
HEHE

I

MP 377 19“ Touch

MP 377 PRO 15* Touch
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Mounting and connecting

4.3 Connecting the HMI device

NOTICE
Approved cable

If you do not use approved cables to connect a SIMATIC S7 controller,
you may experience malfunctions.

Only use approved cables to connect a SIMATIC S7 controller.

Standard cables are available for the connection. You can find additional information on this
in the Internet at "http://mall.automation.siemens.com".

Connecting PROFINET

NOTICE
Damage to the HMI device

Only connect the HMI device to public Ethernet networks using a switch
or comparable device.

PROFINET 10 communication

For instructions regarding the installation of PROFINET networks, refer to the
"PROFINET System Description" manual.

Note the following for the MP 377 PRO 15" Touch:

Use an angled tool, such as an Allen wrench, to loosen the latch of the RJ45 connector
for PROFINET.

MP 377, MP 377 PRO (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

Configuring an RS-422/RS-485 port
A DIP switch S1 for the configuration of the RS-422/RS-485 port is located on the rear of

70

the HMI device.

In the factory state, the DIP switch is set for communication with the SIMATIC S7 PLC

via RS 485.

Note

Note the diagrams of DIP switch settings on the rear panel of the HMI device.

The following table shows the DIP switch settings. The send and receive direction is toggled
internally using the RTS signal.

Communication

Switch setting

Meaning

RS 485

4321

No RTS on connector,
e During data transfer between the PLC and HMI device

e During data transfer between the HMI device and PC
(delivery condition)

RTS on pin 4, same as PLC,
for example for commissioning

RTS on pin 9, same as programming device,
for example for commissioning

RS 422

N
w
[N
N

I
[
o
Z

RS-422 port is active.
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Mounting and connecting
4.3 Connecting the HMI device
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Connecting the configuration PC

4.3.7

Wiring diagram

The following figure shows the connection between the configuring PC and HMI device.

The ports are described in the specifications.

For the RS-485 to RS-232 conversion, you can order the PC/PPI cable from Siemens AG

using order number 6ES7 901-3CB30-0XA0.

MP 377, MP 377 PRO (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

Configuring the PC/PPI cable
Use the DIP switches to configure the transfer rate of the PC/PPI cable.

Note

Set a lower bit rate if the connection is lost during the operating system update. If you use
a higher bit rate, you must use the PC/PPI cable version 3 or higher. The version code is
printed on the cable ("E stand 3," for example, corresponds to version 3).

® DIP switch
@) LEDs

Set DIP switches 1 to 3 to the same bit rate as in WinCC flexible. DIP switches 4 to 8
must be set to "0".

LT ey

123456

® DIP switch

The following bit rates can be set:

Bit rate in Kbps DIP switch 1 DIP switch 2 DIP switch 3
115.2 1 1 0
57.6 1 1 1
38.4 0 0 0
19.2 0 0 1
9.6 0 1 0
4.8 0 1 1
2.4 1 0 0
1.2 1 0 1

In the figure, the bit rate is set to 115.2 Kbps.
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Mounting and connecting

4.3 Connecting the HMI device

Note when connecting

NOTICE
USB connection sequence

Observe the following sequence when connecting by USB:
1. HMI device

2. PC

USB host-to-host cable

Use only the driver for the USB host-to-host cable that is included in the WinCC flexible
package. Never use the driver supplied with the USB host-to-host cable.

Note
Updating the operating system

If there is no serviceable HMI device image on the HMI device, you can only update the
operating system by restoring the factory setting. When restoring the factory settings,
connect the PC to the HMI device by PROFINET.

HMI device changeover

If you connect more than one HMI device with the same IP address in succession to a single
configuring PC, you need to ping the configuring PC once from the HMI device on each
changeover of the HMI device.

Note for MP 377 PRO 15" Touch

Use an angled tool, such as an Allen wrench, to loosen the latch of the RJ45 connector
for PROFINET.
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Mounting and connecting

4.3 Connecting the HMI device

43.8 Connecting a USB device

Below are examples of devices you can connect to the USB port of the HMI device:
® External mouse
e External keyboard
® Printer
o USB memory stick
® [ndustrial USB Hub 4
Industrial USB hub 4 can be obtained using order number 6AV667 1-3AH00-0AXO0.

Note when connecting

NOTICE
Functional problem with USB port

If you connect an external device with a 230-V power supply to the USB port without using
an non-insulated installation, you may experience functional problems.

Ensure a non-insulated installation.
Excessive rated load on port
A USB device with too high a power load may possibly cause functional problems.

Observe the values for the maximum load of the USB interface. You will find the values in
the section "Technical specifications" (Page 284).

MP 377, MP 377 PRO (WinCC flexible)
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Mounting and connecting
4.3 Connecting the HMI device

Connecting a printer

4.3.9

Wiring diagram

The following figure shows the connection between the printer and HMI device.

uUSB

MP 377 12* Touch

MP 377 12" Key

i

MP 377 15" Touch

MP 377 19" Touch

H HuuuuuuﬂuuuuHEHEDuuuuuuuuuHHEDHHHHuuuuuuuuuanguuuuunuuuuaug
sftonononogonooflaflanonooonoooofioflononooooooaafioflanocooanaaag
mlooooooooo0oololU000000000000U0UO00000000000UOUO00000000000

MP 377 PRO 15" Touch

MP 377, MP 377 PRO (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

Note when connecting

4.3.10

76

NOTICE

Data exchange cables
If you use cables without a metallic netting shield between the HMI device and printer,
you may experience functional problems.

Only use cables with metal-braided shielding grounded at both ends for connecting the
HMI device and printer.

Note
Some printers may require the ASCII character set used in the project to also be defined on
the printer.

You can find the list of current printers and required settings for HMI devices in the Internet
at "http://support.automation.siemens.com/WW/view/en/11376409".

Observe the supplied printer documentation when you connect the printer.

Connecting an audio device

You can connect an active speaker or another audio amplifier to the HMI device's
"Line Out" port.

Note
The "Micro" and "Line In" ports are provided for future applications.

The microphone and audio source share one port.

MP 377, MP 377 PRO (WinCC flexible)
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Mounting and connecting
4.4 Swifching on and testing the HM/ device

44 Switching on and testing the HMI device

Procedure
Proceed as follows:
1. Switching on the power supply.

The screen lights up after power is switched on. A progress bar is displayed
during startup.

If the HMI device fails to start, you have probably crossed the wires on the mains
terminal. Check the connected wires and change their connection. The Loader opens
after the operating system has started.

Transfer

Skark

Conkrol
Panel

Taskbar

The HMI device automatically switches to "Transfer" mode during initial startup under the
following conditions:

— No project is loaded on the device.
— At least one data channel has been configured.

During this process the following dialog appears:

Zonnecting ko host L.,

Canecel

2. Press "Cancel" to stop the transfer.

MP 377, MP 377 PRO (WinCC flexible)
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Mounting and connecting

4.4 Swifching on and testing the HMI device

Result

Function test

The Loader appears again.

Note

When restarting the system, a project may already be loaded on the HMI device. The project
will then start after an adjustable delay or when you press the "Start" button.

Use the relevant operating element to close the project.

Refer to your plant documentation to find any additional information on this topic.

Perform a function test following commissioning. The HMI device is fully functional when one
of the following states is indicated:

® The "Transfer" dialog is displayed.
® The Loader is displayed.

® A project is started.

Shutting down the HMI Device

See also
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Terminate the project at the HMI device before switching it off.
You have the following options for switching off the HMI device:
e Switch off the power supply.

® Remove the mains terminal from the HMI device.

Configuring the data channel (Page 136)
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Mounting and connecting

4.5 Securing the cables

4.5 Securing the cables

45.1 Securing cables on the MP 377 mounting device

After the power-on test, to ensure strain relief, use cable ties to secure the connected cables
to the marked fixing elements.

Fastening element

452 Securing cables on the MP 377 PRO

After the power-on test, use cable ties to secure the connected cables to the marked clasps
to ensure strain relief.

Clasps

MP 377, MP 377 PRO (WinCC flexible)
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Mounting and connecting
4.6 Closing the housing rear wall of MP 377 PRO

4.6 Closing the housing rear wall of MP 377 PRO

Requirement
® All cables are connected.

Procedure
Proceed as follows:
1. Check that the seal is properly seated on the housing.

NOTICE

IP65 degree of protection at risk

If the seal on the rear wall of the housing is damaged, the IP65 degree of protection is at
risk. This is a repair case. Proceed as described in the section Spare parts and repairs
(Page 274).

2. Position the housing rear wall on the housing.

Ensure the housing rear wall cannot fall down.

NOTICE

Do not exceed the permissible torque

If you tighten up the screws with a torque of > 1.2 Nm, you could damage the thread in
the housing.

Alternatively, tighten the screws using a maximum torque of 1.2 Nm.

3. Use an Allen key, size 2, to remove the 10 screws @ of the housing rear wall.

»
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Operator controls and displays 5

5.1 Front operator controls

MP 377 Touch

SIEMENS

O] Display with touch screen

The MP 377 Touch is operated via the touch screen. All operating elements required for
operator input are displayed on the touch screen once the HMI device has started.

NOTICE

Unintentional action possible

Do not carry out several operations simultaneously. You may otherwise trigger an
unintentional action.

Always touch only one operating element on the screen
Damage to the touch screen possible

Never touch the touch screen with pointed or sharp objects. Avoid applying excessive
pressure to the touch screen with hard objects. Both these will substantially reduce the
useful life of the touch screen and even lead to total failure.

Always operate the HMI touch screen with your fingers or with a touch pen.
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5.1 Front operator confrols

MP 377 12" Key

82

Function keys with LED

System keys - alphanumeric keys
Display

System keys — control keys
System keys - cursor keys

®@®e 00

The MP 377 12" Key is operated using the system keys and the function keys.

The function assigned to a specific function key is defined during configuration. The function
keys have no function prior to the project being opened.

NOTICE
Unintentional action possible

Do not carry out several operations simultaneously. You may otherwise trigger an
unintentional action.

Do not press more than two keys simultaneously
Damage to the keyboard possible

Using hard instruments to press the keys considerably reduces the service life of the
key mechanism.

Only use your fingers to operate the HMI device keys.
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5.2

Introduction

Procedure

See also

5.2 Inserting a memory card

Inserting a memory card

The following can be saved to the memory card of the HMI device:

Backup of the HMI device

Logs

Recipes

Operating system

Applications

Other data such as video files, Word, Excel or PDF files

The memory card can be inserted during operation.

Note
The multimedia card of the SIMATIC S7 PLC cannot be used.

Proceed as follows:

1.

Insert the memory card into the relevant slot.

When inserting the memory card, please note that it can only be inserted in the slot when
the front side of the memory card is visible.

e
L
_._.....Jnmuululllllilllﬂl
AT i
s TN i i
mmnmlnmlmlm A
-..,,,,,_:m:uun::n».m.
T
""'-mmm:ﬂmuunm::"
"Huilrlmln::

t

2. Check that the memory card is properly seated.

Securing memory card (Page 84)

MP 377, MP 377 PRO (WinCC flexible)
Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO 83



Operafor controls and displays
5.3 Securing memory card

5.3 Securing memory card

Introduction

The HMI device is designed for the tough conditions experienced in industry. Therefore use
the locking bracket to secure the memory card in its slot.

Requirements
A memory card has been inserted.

Procedure
Proceed as follows:
1. Loosely screw in the Torx screw @.
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2. Place the locking bracket @ against the memory card.

3. Tighten the Torx screw @.

Result
The memory card is secure.
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5.4 Unplugging the memory card

54 Unplugging the memory card

Introduction
The memory card can be unplugged during operation. Do not remove the memory card while
data is being accessed by an application, e.g. during backup or recipe transfer.

Procedure

NOTICE

Loss of data possible

The data on the memory card is lost if you attempt to remove it while the HMI device is
accessing its data.

Do not remove the memory card while data is being accessed. Observe the corresponding
alarms on the screen.

Proceed as follows:
1. Unplug the memory card from the memory card slot.

2. Store the memory card in a safe place.

MP 377, MP 377 PRO (WinCC flexible)
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5.5 Labeling the function keys on the MP 377 12" Key

5.5 Labeling the function keys on the MP 377 12" Key

Introduction

You can label the function keys as required for your project. Use the labeling strips for
this purpose.

Preprinted key labeling strips may be ordered as accessories,

see section Accessories (Page 26).

Note
Do not write on the keyboard to label the function keys.

Printing labeling strips

WinCC flexible comes with a range of labeling strip templates. You can find additional
information on the location of the templates in the WinCC flexible online help.

Any printable and writable foil can be used as labeling strips. You can use transparency film,
the keyboard membrane of the HMI device is printed on the reverse side. Use transparent
foil so that the LEDs of the function keys can be seen.

The permitted thickness of the labeling strip is 0.13 mm. Paper labeling strips
are inappropriate.

Dimensions of the labeling strip for the MP 377 12" Key

2x45°

/ 17
rr 17,
9.4/ 206 | 206 | 206 | 206 | 20.6 | 20.6 | 20.6
245

2x45°

/7 Area which can be written and printed on
17
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94| 21

1
-
-
-
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Operafor controls and displays

Procedure

5.5 Labeling the function keys on the MP 377 12" Key

Proceed as follows:

1.

Edit and then print the template.
You can also print blank templates and label them manually.
Apply a fixing spray film to the labeling strips.

The fixing spray ensures that the text is water resistant and does not smear, and that the
printer ink on the keyboard membrane does not run.

Cut out the labeling strip.

Ensure that the corners are cut according to the diagram shown above as this makes it
easier to slide them into the slot.

. Remove any existing labeling strips.

Note
Wait for the printed labeling strips to dry before you insert them.

Slide the labeling strips @ into the slot @®.

Slide the labeling strips into the slot up to the stop.

The labeling strip will protrude approximately 3 cm from the slot. The template
dimensions for the labeling strips are designed so that the labeling is correctly placed for
the function keys. It is not necessary to secure the labeling strip.

When mounting the HMI device, ensure that the labeling strips do not become jammed
between the mounting cut-out and the HMI device.
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5.5 Labeling the function keys on the MP 377 12" Key
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Configuring the operating system

6.1 Loader

Overview

The following figure shows the Loader. The header line contains details of the loader
version. These details are not shown in the following figure.

Transfer
Stark
Control
Panel
Taskbar

The Loader buttons have the following functions:
® Press the "Transfer" button to set the HMI device to "Transfer" mode.

The transfer mode can only be activated when at least one data channel has been
enabled for the transfer.

® Press the "Start" button to start the project on the HMI device.

If you do not perform an operation, the project on the HMI device will automatically start
after a delay.

® Press the "Control Panel" button to open the control panel of the HMI device.
You can change various settings in the Control Panel, for example, the transfer settings.

® Press the "Taskbar" button to activate the taskbar with the Windows CE start menu open.

MP 377, MP 377 PRO (WinCC flexible)
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Configuring the operating system

6.1 Loader

The following figure shows the open start menu.

L B Command Prampt
¥ a Internet Explorer
") Documents | &Y Media Player
[ Settings » | i Softkeyboard
& Run... ﬁ' Windows Explorer

[#75tart | |Loader

Transfer

Start

Contral
Panel

Taskbar

» 09:19

Depending on the software installed, other symbols may be displayed in the

desktop's status bar.

Open Loader

The following options are available to open the Loader:
® The Loader appears briefly after starting the HMI device.
® The Loader appears when the project is closed.

If configured, use the relevant operating element to close the project.

For further information on this, refer to your plant documentation.

Key operation in the Loader

The following table shows the key combinations for navigating in the Loader.

Key combination

Function

[v][a][]

The next or previous entry is selected.

{ 1
ENTER
or

The selected button is operated.
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Configuring the operating system

6.1 Loader

Key operation in the Windows CE interface
The following table shows the key combinations for navigating in the user interface.

Key combination Function

The taskbar is activated with the open Windows CE start menu.
+
The next active program is displayed.
+
The Task Manager is opened.
+

Key operation in the Explorer
The following table shows the key combinations for navigating in the Explorer.

Key combination Function

e Toggles the active window.
e Toggles between the Windows CE Desktop and the window.

2 Selects the first entry.
,
Selects the last entry.
.
+ Selects everything, if the left LED of the key lights up

Activates the menu bar.

Changes to the higher level.
Opens the shortcut menu.
1.

. Displays the properties.

TAB
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Configuring the operating system

6.1 Loader

Protection against unauthorized use

You can protect the control panel against unauthorized access by using a password.

You can also protect the taskbar and the Desktop with the help of SecureMode. If the
HMI device is protected, "secure mode" is displayed on the Windows CE desktop.
You can find additional information on this in the section "Setting up and disabling

SecureMode (Page 94)''.

The "Transfer" and "Start" buttons can always be used without having to enter a password.

Password protection prevents maloperation. This increases the security of the system
or equipment because settings for the current project can only be changed after entering

the password.

NOTICE

Loss of data possible

operating system.

Back up the HMI device's data.

If the password is no longer available, you can only cancel password protection by updating
the operating system. All data on the HMI device will be deleted when you update the

Internet Explorer

Internet Explorer for Windows CE is installed on the HMI device.

[File Edit view Favorites | [| @]+ |@]&] a|&] x]
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Service & Support

= Driverdownload SIMATIC Flak Panel

—* Measuring cvcles

= Special funchions: Axis pair collusion prokection (TES)

—* Spedial functions: Cycle-Independent Path-3vnchronous Signal Qukput (TES)

Self-help

8 subscribe

Search Product Support Documents

Enter waur specific product information below ko quickly
extrack the latest related entries from our global database,

Produck Mame or Park Mumber

Browse Support Docume

Go ko our global database and exp
FaZs, manuals, downloads and ap

- Product Support

Far automation syskem interackion
questions, click below For applicatic

Search Text (key words)

demonstration systems and more:

" Go | - Application & Tools ¥

4

|http:waw.autc:math:un.siemens.cnmfmetafihdex_?_ﬁ.htm
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6.1 Loader

Note

Internet Explorer for Windows CE and the Internet Explorer version which can run on a PC
differ in terms of functionality.

Internet Explorer for Windows CE has separate proxy settings that are independent of the
settings in the control panel of the HMI device.

You can find additional information at the Microsoft Website.

Media Player

Media Player for Windows CE is installed on the HMI device. Media Player is used, for
example, to play video sequences for maintenance and servicing.

Media Player

Media Player supports the following formats:
e WMA
e MPEG

Note

Media Player for Windows CE and the Media Player version that can run on a PC differ in
terms of functionality.

You can find additional information at the Microsoft Website.
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6.2 Setting up and disabling SecureMode

Overview

You can protect the control panel against unauthorized access with a password. You can
also protect the taskbar and the Desktop with the help of the SecureMode.

Function of SecureMode

You set up SecureMode by setting up a password in the control panel. SecureMode is then
automatically activated. The label "secure mode" is displayed in the Windows CE Desktop.

If you now want to use a function on the taskbar or Desktop, you have to enter the password.
When you have entered the password, the label "secure mode" is no longer displayed. All

the functions of the taskbar and Desktop can now be used freely. To reactivate SecureMode,

double-click the g icon on the Desktop. The "secure mode" label is displayed again. The

HMI device is protected again.

Canceling SecureMode
To completely cancel SecureMode, delete the password.
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6.3 Viewer

Introduction

6.3 Viewer

You can use ProSave to install viewers for various data formats. You can tell which viewers
are installed by a symbol on the desktop and from the Start menu under "Programs".

The following viewers can be installed:

Viewer

PDF Viewer

Word Viewer

Excel Viewer

] e (8
[ T 3
E S EE

Functional scope

The viewers can read and print the following file formats:

Viewer Readable file formats
PDF Viewer PDF

Word Viewer DOC, RTF

Excel Viewer XL*

All viewers share a Zoom function. The Excel Viewer also offers the following functions:

e Switch between spreadsheet tabs

e Split the spreadsheet

® (Change line height and column width

MP 377, MP 377 PRO (WinCC flexible)
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6.4 Control Panel

6.4.1 Overview
The HMI device's Control Panel is similar to the control panel on a PC.

The Control Panel looks like this:

File View . | |_T_|I|E|
@ ) R D om D @

Backup/R... Certificates InputPanel  Internet Keyboard Mouse  Metwork and
Options Dialup Co...

Metwark 1D Pazswiord Printer PROFINET Regional  S7-Transfer ScreenSaver

- = e Settings Settings
H L, I 49 %

System Trarsfer LIPS yolume & WiniCC
Sounds Intern...

The control panel can be used to modify the following settings:
® Date and time

® Screen saver

® Regional settings

® Transfer settings

® Network settings

e Delay time

e Password
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6.4.2 Opening the Control Panel

Introduction
The HMI device Control Panel can be opened as follows:

® Independently of a running project
— Press the "Control panel" button in the loader.
— By calling up from the Windows CE start menu.
e \With active project
An operating element must be configured to open the control panel for this purpose.

Procedure - open the Control Panel via the Start menu
Proceed as follows:
1. Open the Windows CE start menu.

— Procedure using the keys:

Select the + key combination.

— Procedure using the touch screen:

Press the key twice on the alpha-numeric VDU keyboard.

2. Select "Settings > Control panel".

Result
The control panel is opened.
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6.4 Control Panel

6.4.3

Overview of functions

98

Reference for functions

The following table shows the settings in the Control Panel.

Functions Tab / entry
Saving and restoring with external storage device -
Importing, displaying and deleting certificates "Stores"
Setting the date and time "Date/Time"
Configuring the screen keyboard -
Changing the browser startup page and general "General"
browser settings
Changing connection and proxy server settings "Connection"
Changing cookie settings "Privacy"
Changing privacy settings "Advanced"
@ Setting the character repeat for the keyboard "Repeat"
i/:‘i‘) Setting the double-click "Double-Click"
% Parameterizing the LAN connection "ERTEC400"
= Setting the IP address "ERTEC400 Ethernet Driver' "IP Address"
Settings"
Set name server "ERTEC400 Ethernet Driver' "Name Servers"
Settings"

IO
[EAE

Changing the logon data

"Ildentification"

%

Backup registry information

"Persistent Storage"

Changing monitor settings "Display"

Displaying information about the HMI device "Device"

Restarting the HMI device "Device"

Touch screen calibration " "Touch"

Activate memory management "Memory Monitoring"

Changing password protection

"Password Settings"

Changing the printer properties

Changing the PROFINET 10O setting

O & ||

Changing regional settings

"Regional Settings"

Changing the number format "Number"
Changing the currency format "Currency"
Changing the time format "Time"
Changing the date format "Date"
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6.4 Control Panel

Icon Functions Tab / entry
ﬂﬂ Changing transfer settings "MPI"

Changing the PROFIBUS DP transfer settings "PROFIBUS"

Setting the screen saver -
@ Reducing the backlighting

T‘i Displaying the system information "General"

=7 Displaying memory information "Memory"

Setting the device name of the HMI device

"Device Name"

= Configuring the data channel "Channel"
L8 Setting the delay time "Directories"
= Setting the uninterruptible power supply "Configuration”
= State of uninterruptible power supply "Current Status"

'ﬁ-‘r Setting operation fegdback with key and "Volume"

touch screen operation

Setting operation feedback with key operation

Setting acoustic signal for inadvertent operations

Assigning sounds to events. "Sounds"
!-'". Changing e-mail settings? "Email"

" Only with MP 377 Touch

2) Additional tabs may appear in the "WinCC flexible Internet Settings" dialog. This depends on
the options that have been enabled for network operation in the project.

6.4.4 Operating the Control Panel

6.4.4.1 Overview

Operator input options

The hardware of the HMI device determines, which of the following operator control options

are available:

® Touch screen

The operating elements shown in the dialogs are touch-sensitive. Touch objects are
basically operated in the same way as mechanical keys. You activate operating elements
by touching them with your finger. To double-click them, touch an operating element

twice in succession.

o HMI device keyboard

The operating elements shown in the dialogs are selected and operated using the keys of

the HMI device.
e External USB keyboard

o External USB mouse
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6.4 Control Panel

Entries using an external keyboard

An external keyboard can be used to operate the Control Panel in exactly the same way as
the HMI device keyboard. Use the keys of the external keyboard which correspond to the
HMI device keys in the description.

Operator entries using an external mouse

An external mouse can be used to operate the Control Panel in exactly the same way as the
HMI device touch screen. Click the described operating elements with the mouse.

6.4.4.2 Operation using the touch screen

Introduction

The control panel is operated with the HMI device touch screen or a connected mouse.

Requirements

An active project has been terminated. The Loader appears.

Procedure

Proceed as follows to change settings in the Control Panel:

1. Open the Control Panel with the "Control Panel" button.

. To open the required dialog, double-click its symbol.

2
3. Change the tab as required.
4

. Make the necessary changes.

Touch the corresponding input object.

Use the screen keyboard of the HMI device to enter the new values in the text boxes.
Touch a button to operate it.

Touch the selection box to open a drop down list box. Touch the required entry from
the drop down list box.

Touch the check box to activate or deactivate a check box.

Touch a radio button to select it.

5. Confirm the selection with the 0K| button or abort the entry with the | X | button.

The dialog closes.
6. Close the Control Panel with the "[X|" button.

The Loader appears.
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Input with the screen keyboard

A screen keyboard is available for data input. The screen keyboard is displayed as
soon as you touch a text box. You can also call up the screen keyboard directly from
the Control Panel.

Display methods for the screen keyboard

You can change the display method for the screen keyboard and fix the position on the
screen. Confirm the entry with the button or abort the entry with the key. Either
action closes the screen keyboard.

® Numerical screen keyboard

7[ 8 g« [Flx]

4 56 Cel | Ins
123‘J

0- . |ESC| |

INum

® Alphanumerical screen keyboard

“[1lz2[3]as]e[7]e]o]o]-[=]«— [& _Ix]

—quertyuiop[]JInsHomEI;'

o |a|s|d|f|lg|lh|i|k|I|:]" |\ pel | End |
tly|[z|x|ec|¥|b|n|m| ,|.|/f]| & [Ec| rm|$
I E: | acer | B ow | ¥ |

The alphanumerical keyboard is organized in the following two layers:

— Normal level

— Shift level

® Reduced screen keyboard
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Changing the display of the screen keyboard

Key Functions

i

Switching between the numerical and alphanumerical keyboard

Switching between the normal level and Shift level of the alphanumerical
screen keyboard

Switchover to special characters

Switching from full display to reduced display

Switching from reduced display to full display

E@DEEE

Close the screen keyboard

6.4.4.3 Operation with the keyboard

Introduction

The Control Panel is operated with the system keys of the HMI device.

Requirements

An active project has been terminated. The Loader appears.

Procedure

Proceed as follows to change settings in the Control Panel:

1.
2.

3.

102

Open the Control Panel.

Select the "Control Panel" button in the loader using the cursor keys.

Press

The Control Panel is opened.

Select the symbol of the required dialog with the cursor keys.

Press to open the dialog.

Change the tab as required.

Press until the name of the tab is selected. Now switch between the tabs using

the cursor keys.

Use the key to return to the input area.
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8. Make the necessary changes.

To do this, highlight the corresponding input object using the key.

— Use the system keys of the HMI device to enter the new values in the text boxes.

To operate a button, select the button with the cursor keys and then press .

Open the drop down list boxes with the key combination + Izl

Select the required entry from the drop down list box using the cursor keys.

Confirm the selected entry by pressing .

[
Press to activate or deactivate a check box.

Select a radio button from a group using the cursor keys.

9. Confirm your entries with or discard your entries with .

If you have selected an input object, you first have to complete entry.
The dialog closes.

10. Close the Control Panel.

Press the key to do this.

The control panel menu is opened.

11. Select the "Close" entry using the cursor keys.

12. Press .

The Loader appears.
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Control keys

The following tables show the control keys used to select and operate the control panel.

® Select operating elements

Key

Functions

Description

TAB

SHIFT
+

Tabulator

Selects the next/previous operating element in the
tab sequence.

[«]»]
[v]a]

Cursor keys

Selects the next operating element to the left, right,
above or below the current screen object.

Navigates in the operating element.

® Using operating elements

Key

Functions

Description

A
A
oM

HOME

Scroll back

Scrolls back a page in a list.

F Y
N + |HOME]

Scroll to the beginning

Scrolls to the beginning of a list.

END

Scroll forward

Scrolls one page forward in a list.

v
[~]. [E]

Scroll to the end

Scrolls to the end of a list.

ENTER key e Operates a button.
e Accepts and ends an entry.
Cancel e Deletes the characters of a value entry and

restores the original value.
¢ Closes the active dialog.

INS
DEL

Delete characters

Deletes the character to the right of the current
cursor position.

Delete characters

Deletes the character to the left of the current
cursor position.

E
+

Open drop down list box

Opens a drop down list box.

+

Accept value

Accepts the selected value in the drop down list
box without closing the list.
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Enter key combinations

6.4 Control Panel

Key Functions Purpose
Toggle key assignment Toggles the assignment for a key with
multiple assignment.

e NolLEDis lit
The number assignment is enabled. Pressing
the button once toggles to letter assignment.
e AnLEDislit

The left or right letter assignment is enabled.

Each time the key is pressed, the system toggles
between the left letter assignment, the right letter
assignment and the number assignment.

Toggle between upper-case
and lower-case

Used in key combinations, for example for entering
upper-case letters.

[%)
l I
=z l
i

Switch to additional
key assignment

Some of the keys contain a blue imprinted key
assignment, for example the "%" character.

Used in key combinations for the blue
key assignment.

=
T
2

General control function

Used in key combinations

ALT

General control function

Used in key combinations

MP 377, MP 377 PRO (WinCC flexible)
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6.5 Changing settings for operation

6.5.1 Configuring the screen keyboard

Introduction

Requirements

Procedure

106

The details provided below will explain how the screen keyboard can be
displayed and positioned.

You have opened the "Siemens HMI Input Panel - Options" dialog with

icon.

Position and Size
[ Show Resize buttan

Currently closed...
| Open Input Panel ! @

Save current size and position...

‘ Save I @

@ Check box for displaying the El button in the screen keyboard
® Button for displaying the screen keyboard
® Button for saving the screen keyboard settings

Proceed as follows:

1. If you want to change the size of the screen keyboard, activate the "Show Resize Button"
check box.

The | button is displayed in the screen keyboard awaiting opening.

2. If you want to prevent the size of the screen keyboard from being changed,
deactivate the "Show Resize Button" check box.

The | button is removed from the screen keyboard awaiting opening.

3. Use the "Open Input Panel" button to open the screen keyboard.

4. If you want to switch between the numerical and alphanumerical screen keyboard,

press the key.
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5. If you want to change the position of the screen keyboard, use the mouse pointer to
select a free space between the keys.

Release the mouse pointer when the required position has been reached.
6. If you want to increase or decrease the size of the keyboard screen, place your mouse
pointer over the button [|.
Adapt the screen keyboard size by dragging it to size with the mouse pointer.
Release the mouse pointer when the required size has been reached.
If you want to save the settings, press the "Save" button.
10. Confirm your entries.

The dialog closes.

Result
The screen keyboard settings have been modified.

6.5.2 Setting the character repeat

Introduction
The details provided below will explain how to set the character repetition and the associated

delay for the keyboard and/or screen keyboard.
Requirements

You have opened the "Keyboard Properties" dialog with the "Keyboard" @ icon.

Keyboard Properties m
RED_
[w

cnable character repeat

Repeat delav: Long Shart )

COE)

Repeat rake:  Slow Fast )

[ G e )

Tap here and hold down a ke ko

566 &

Check box for activating the character repeat

Slider control and buttons for the delay time before character repeat
Slider control and buttons for the rate of the character repeat

Test field

® 0 0
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Procedure

Result

6.5.3

Introduction

108

Proceed as follows:

1.

If you want to enable character repetition, activate the "Enable character repeat"
check box.

If you want to change the delay, press a button or the slider in the "Repeat delay" group.

Moving the slider to the right will shorten the delay. Moving to the left will extend
the delay.

If you want to change the repeat rate, press a button or the slider in the
"Repeat rate" group.

Moving the slider to the right will shorten the repeat rate. Moving to the left will extend the
repeat rate.

Check the settings.
Procedure using the touch screen:
— Touch the test field.
The screen keyboard opens.
— Move the screen keyboard as needed.
Procedure using the keys:
— Select the test field.
Press an alphanumeric key and keep the key pressed down.

Check the implementation of the character repetition and the rate of the character
repetition in the test field.

6. If the settings are not perfect, correct them.

7. Confirm your entries.

The dialog closes.

The character repetition and delay are set.

Setting the double-click

You can start applications in the Control Panel and in Windows CE with a double-click.
A double-click corresponds to two brief touches in sequence.

In the "Mouse Properties" dialog, make the following adjustments for touch screen operation
and operation with external mouse:

Interval between touch contacts on the touch screen

Interval between mouse clicks
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Requirements

You have opened the "Mouse Properties" dialog with the "Mouse" i/:‘:_.) icon.

Double-Click |

Double-click this grid to set the double-click,
sensitivity For both the speed and physical SR

distance between clicks,

Double-click this icon to test vour double-click
settings. IF this icon doesn't change, adjust
wour settings using the grid above,

—®
—®

® Pattern
® Icon

Procedure
Proceed as follows:
1. Click the pattern twice.
After the second click, the colors of the pattern will be reversed and the white fields will
change to gray. The time before the second click is saved.
2. Check the double-click.
Click on the icon twice in succession to do this. If the double-click is recognized,
the icon is displayed as follows:
3. If the settings are not perfect, correct them.
To do this, repeat steps 1 to 2.
4. Confirm your entries.
The dialog closes.
Result

The double-click adjustment is completed.
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6.54 Calibrating the touch screen

Introduction

Requirements

Procedure

110

Depending on the mounting position and viewing angle, it is possible that parallax may occur
when operating the touch screen. In order to prevent any operating errors as a result,
calibrate the touch screen again in the startup phase or during runtime.

You have opened the "OP Properties" dialog "Touch" tab with the "OP" é@ icon.

OP Properties

I Persistent Starage I Display I Device

If wour Windows CE device is not responding

f properly to wour kaps, wou may need ko
recalibrate your screen,

To skart, tap Recalibrate.

Recalibrate

Proceed as follows:
1. Click on the "Recalibrate" button.

The following dialog opens:

Carefully press and briefly hold stylus on the center of
the target. Repeat as the target moves around the screen.

+ @

2. Briefly touch the middle of the calibration crosshairs @.
The calibration crosshairs is then displayed at four more positions.
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3. Briefly touch the middle of the calibration crosshairs for each position.

Once you have touched all the positions of the calibration crosshairs,
the following dialog appears:

New calibration settings have been measured.
Tape the screen to register saved data.
Wait for 30 seconds to cancel saved data and
keep the current setting.

Time limit: 30 sec

4. Touch the touch screen.

The calibration is saved. The "OP Properties" dialog, "Touch" tab is displayed again.
If you do not touch the touch screen within the time shown, your original setting will
be retained.

5. Close the dialog.

Result

The HMI device touch screen is calibrated.
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6.6 Setting up password protection

Introduction
You can protect access to the Control Panel and the Windows CE taskbar with a password.

Requirements

You have opened the "Password Properties" dialog with the "Password" @ icon.

Password Properties m
Password Settings |

Password
% Password: I
Zonfirm password: I

NOTICE

Password not available

If the password is no longer available, you will have to wait for the operating system to be
updated again.

¢ Change settings in the Control Panel

e Use the Windows CE taskbar

All data on the HMI device will be deleted when you update the operating system!

Therefore use the password to protect against loss.

Note
The following characters cannot be used in passwords:

e Blank
e Special characters *? . % /\'"

Procedure
Proceed as follows:
1. Enter a password in the "Password" text box.
2. Repeat the password entry in the "Confirm password" text box.
3. Confirm your entries.
The dialog closes.
Result

You cannot open the Control Panel or Windows CE taskbar without entering a password.

MP 377, MP 377 PRO (WinCC flexible)
112 Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO



Configuring the operating system
6.7 Canceling password protection

6.7 Canceling password protection

Requirements

You have opened the "Password Properties" dialog with the "Password" @ icon.

Password Properties m
Pazsword Settings |

Password
@ Password: I
Zonfirm password: I

Procedure
Proceed as follows:
1. Delete the entries in the "Password" and "Confirm password" text boxes.
2. Confirm your entries.
The dialog closes.
Result

Password protection for the Control Panel and Windows CE taskbar is canceled and they
can be freely accessed.
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6.8 Changing HMI device settings

6.8.1 Setting the date and time

Introduction

Requirements

Procedure

114

You can set the date and time on the HMI device. The HMI must be restarted in
the following cases:

® You have changed the time zone setting

® You have changed the "Daylight savings time currently in effect" check box setting.

You have opened the "Date/Time Properties" dialog with

142

the "Date/Time Properties" -aJ icon.

DatejTime Properties m
DatefTime I

Time Zone I(GMT) Greenwich Mean Time : Dublin, Edinbllzi—

Current Time

Bl Februar 2007 |[J

&

MDMDFGS S m——@
O

—®

2930 31 1z 3 4
S 6 7 8 9 10 11
12 13 14 15 17 18
19 20 21 22 23 24 25
2728 1 2 3 4

5 6 7 & 9 1011 P\JDW—:

E Davlight savings kime
currently in etbect

Time zone selection box
Input field for the time

Date selection box

"Daylight savings" check box

®@ 6000

Button for applying changes

Proceed as follows:
1. Select the appropriate time zone for the HMI device from the "Time Zone" selection field.
2. Touch the "Apply" button to confirm your entry.

The time of day shown in the "Current Time" field is adjusted correspondingly to the
selected time zone.

3. Set the date in the selection box.

4. Set the current time of day in the "Current Time" text box.
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Result

Internal clock

6.8 Changing HMI device settings

. Confirm your input by clicking on the "Apply" button.

The values you have set are now in effect.

Note
The system does not automatically switch between winter and summer time.

. If you want to switch from winter to summer time, activate the

"Daylight savings time currently in effect" check box.
When you press the "Apply" button, the time is brought forward by one hour.

. If you want to switch from summer to winter time, deactivate the

"Daylight savings time currently in effect" check box.

When you press the "Apply" button, the time is taken backward by one hour.

. Confirm your entries.

The dialog closes.

The settings for the data and time of day have now been changed.

The HMI device has an internal buffered clock.

Synchronizing the date and time with the PLC

The date and time of the HMI device can be synchronized with the PLC if this has been
configured in the project and the PLC program.

Further information on this subject is available in the "WinCC flexible" system manual.

NOTICE

Time-dependent reactions

You have to synchronize the date and time when time-controlled responses are triggered in
the PLC by the HMI device.

6.8.2 Changing regional settings

Introduction

In different countries, for example, the date, time and decimal points are displayed
differently. You can adjust this display to meet the requirements of different regions.

The country-specific settings apply to the current project. If the project language is changed,
the country-specific settings are also changed.

MP 377, MP 377 PRO (WinCC flexible)
Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO 115



Configuring the operating system

6.8 Changing HMI device settings

Requirements
You have opened the "Regional and Language Settings" dialog with

the "Regional Settings" 5 icon.

Regional and Language Settings

Regional Settings | Murnber I Currency I Time I Date |

Many programs have different
-|international settings, Regional
adjustrnents in date-, time-,
currency- and numbers-
conventions for displaying and
sorting data can be achieved in
K changing those international

-
=t

©) Region selection box

Procedure
Proceed as follows:
1. Select the region from the selection box.

2. Change to the "Number", "Currency", "Time" and "Date" tabs and set the selection boxes
to the desired settings.

3. Confirm your entries.

The dialog closes.

Result

The HMI device's regional settings have been changed.

6.8.3 Backup registry information

Registry information and temporary data

You can install and uninstall your own programs on the HMI devices under Windows CE.
You must save the registry settings after installation or uninstallation.

You can save the following data to the flash memory:
® Registry Information

® Temporary files

Restoring the file system of a memory card

If memory cards are used, the file system on the memory card may become damaged,
perhaps due to a power failure. The HMI device detects the defective file system on start-up
or when the memory card is inserted. The HMI device can restore the file system
automatically or on request.
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Requirements

You have opened the "OP Properties” dialog, "Persistant Storage" tab with

the "OP" é@ icon.

OP Properties m

_ Persitent Storage || Display | Deviee | Touch | 1 (] 'll

Save ackual registry settings to flash,
System will skart with saved reqistry Save Reqgistry —

setkings next time. || :

Sawve all files From kemporary memary
{e.g. the "Program files' direckory) ko Save Files  —
flash., The files will be restored during ||
system starbup, The " Temp' directary @
will not be saved. ||

D Autarnatically repair file system errors on storage
cards at syskem startup and card insertion time ||

©) Significance of the text:

Saves the current registry information to the flash memory. The HMI device loads the saved
registry information the next time it boots.

Button for saving registry information
Button for saving temporary files

® e 0

Significance of the text:

Saves all the files in temporary storage to the flash memory (for example, from the "Program
Files" directory). These files are written back when the HMI device is started. The "\Temp"
directory is not saved.

® Automatically restores the file system on the memory card when the HMI device starts up and
when a memory card is inserted.

Procedure
Proceed as follows:
1. If you want the system to be restored automatically, activate the "Automatically repair file
system errors ..." check box.
If the check box is unchecked, the system is only restored once prompted to do so.
2. Click on the necessary buttons.
3. Confirm your entries.
The dialog closes.
Result

The HMI device uses the saved registry information the next time it starts. The temporary
files are copied back.
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6.84 Changing monitor settings

Requirements

Procedure

Result

118

You have opened the "OP Properties", dialog "Display" tab with the "OP" 6@ icon.

OP Properties

Persiskent Storage

i| Device

EBrightness

Lp

DN

Proceed as follows:

1. If you want to increase the brightness, press the "UP" button.

2. If you want to decrease the brightness, press the "DOWN" button.

3. Confirm your entries.

The dialog closes.

The screen settings have been changed.
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6.8.5 Setting the screen saver

Introduction
You can set the following time intervals on the HMI device:
® For the automatic activation of the screen saver
® For the automatic reduction in the screen's backlighting

When you do not undertake an operation within the configured interval, the configured
function will be activated automatically.

The screen saver and the reduced screen backlighting functions are switched back off by
means of the following actions:

® By pressing any key
e By touching the touch screen

The function associated to the key or button will not be executed by this.

NOTICE
Reduce backlighting

The brightness of the backlighting decreases incrementally during its operational life.

In order to not shorten the operational lifetime of the backlighting unnecessarily,
activate the backlighting reduction.

Activating the screen saver

Screen contents may occasionally leave a burn-in effect in the background if they appear
too long.

This burn-in effect will automatically disappear after a certain amount of time if the
screensaver is activated, for example. The longer the same content is displayed on the
screen, the longer it will take for the burn-in effect to disappear.

Generally, you should always activate the screen saver.

When the screen saver is active, the backlighting is reduced at the same time.
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Requirement

Procedure

Result

You have opened the "Screensaver" dialog with the "ScreenSaver" @ icon.

Enter a '0' to disable the Function.
The minirmurn Eire is 5 and the maximumn is 71582 minutes,

Screensaver m
i Backlight becomes ackive after Ia [ mirtes @
Screensaver becomes active after ||:| vl minukes @

[ @ Standard O Blank Screen ] @

O]
®
®

Time interval in minutes until backlighting is reduced
Period of time in minutes before the screen saver is activated
Radio buttons for the screensaver

Proceed as follows:

1.

Enter the interval in minutes after which the backlighting is to be reduced.
Entering "0" will deactivate the backlighting reduction.
Enter the number of minutes before the screen saver is to be activated.

The minimum time is 5 minutes and the maximum time is 71582 minutes. Entering "0"
disables the screen saver.

Select either the screen saver or an empty screen.
— If you want the screen saver to function, activate the "Standard" radio button.

— If you do not want the screen saver to function, activate the "Blank Screen”
radio button.

. Confirm your entries.

The dialog closes.

The screen saver and the reduced backlighting for the HMI device is set.

6.8.6 Changing the printer properties

Introduction

120

The HMI device can print on local printers or network printers. You can print hardcopies and
reports on a network printer. Line printing of alarms is not possible on a network printer.

You can find the list of current printers and required settings for HMI devices in the Internet
at "http://support.automation.siemens.com/\WW/view/en/11376409".
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Requirement

6.8 Changing HMI device settings

L
You have opened the "Printer Properties" dialog with the "Printer" icon.

Port:
Metwork:
Paper Size:

Orienkation 1
(W) Portrait () Landscape |

Printer Language: | g

r_] Draft Mode D Calar

.

@

CSECNCNCNCNCONC)

Procedure

Selection box for the printer

Interface selection box

Network address of the printer

Paper format selection box

Group orientation with radio buttons for print orientation
Print quality check box

Color printing check box

Proceed as follows:

1.
2.
3.

Select a printer from the "Printer Language" selection box.
Select the port for the printer from the "Port" selection box.

If you wish to print via the network, enter the printer's network address in
the "Network" text box.

Select the paper format from the"Paper Size" selection box.

5. Activate a radio button in the "Orientation" group.

Result

"Portrait" for portrait
"Landscape" for landscape
Select the print quality.
— Select the "Draft Mode" check box if you wish to print in draft mode.
— Clear the "Draft Mode" check box if you wish to print with higher quality.

If the printer selected can print in color and you wish it to do so,
activate the "Color" check box.

Confirm your entries.

The dialog closes.

The settings for the printer have now been changed.
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6.8.7 Enabling sound and setting sound volume

Introduction

You can activate an acoustic feedback for keyboard and touch screen operations. With each
touch or activation of a key, a sound is emitted.

Requirements

You have opened the "Volume & Sounds Properties" dialog, "Volume" tab with

G
the "Volume & Sounds" icon.

Volume 8 Sounds Properties m

Wolume | Sounds |

El Loud | Emable sounds for:
— . Events (warnings, beeps and system events)

ﬁ':): Applications {program specific and all other sounds)

Matifications (alarms, appointments and reminders)
Enable clicks and taps

@
| ®
ElSDFt Hardware buttons @) Loud () Soft @

®

[ screen taps: @ Loud () Soft

Acoustic warnings and system events

Program-specific sounds

Notification sounds

Acoustic feedback when using keys

Acoustic feedback when using touch screen

Keys and controller for setting volume for the "Enable sounds for" group

®@ 6 00

Note

If you deactivate the settings under "Enable sounds for", no more acoustic signals will be
emitted during inadvertent operations.
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Procedure
Proceed as follows:
1. Activate the check boxes needed in the "Enable sounds for" group.
If no check boxes are activated, no acoustic feedback will be output.
2. If you want signaling for entries to be audible, activate the following check box:
— With key control: "Hardware buttons".
— With touch control: "Screen taps".
3. Use the "Loud" and "Soft" radio buttons to select between loud and quiet signaling.
4. If you want to change the volume for acoustic messages, use the controller or "Loud" and
"Soft" keys to do this.
5. Confirm your entries.
The dialog closes.
Result

The properties of the acoustic operation feedback are now set up.
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6.8.8

Introduction

Requirements

Procedure

Result

124

Assigning sound to an event

When acoustic feedback is activated, a sound is used to report an event. You can select the
sound to reflect the event.

® A loudspeaker is connected to the HMI device.

® You have opened the "Volume & Sounds Properties”, dialog "Sound" tab with

Y
the "Volume & Sounds" icon.

Volume & Sounds Properties m
Sounds
Event Sound
:%.finduws CE ﬁ |Asterisk =] E”Il
B A sterish
Close Program Scheme
= Critical Stop
%% Default Sound |defau|t EI

Empty Recycle Bin

. - ‘ﬁave As... | | Delete |
'(ﬂ: Exclamation

Proceed as follows:

1.

Select a suitable sound from the "Event" group.

The sound selected is displayed in the "Sound" group in the associated list box.

If you want to listen to the sound, press the " ™ |" button.

The sound is output by a loudspeaker connected to the HMI device. Use the L‘ button
to stop the output.

If you haven't managed to find a suitable sound, you can use the "Browse" button to
switch to a folder of your choice.

The sound selected is displayed in the "Sound" group in the associated list box.
Confirm your entries.

The dialog closes.

The sound is set for acoustic feedback on operations.
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6.8.9 Restarting the HMI device

Introduction

You can restart the HMI device or reset the factory settings before rebooting. Further
information on this can be found in the section "Resetting factory settings (Page 174)".

Required restart
The HMI device must be restarted in the following cases:
® You have activated or deactivated the PROFINET IO direct keys.
® You have changed the time zone setting.

® You have changed the automatic daylight savings and standard setting

NOTICE

Data loss when the HMI device is restarted

All volatile data is lost when the HMI device is restarted.

Check the following:
e The project on the HMI device is complete.
¢ No data is being written to the flash memory.

The HMI device must be restarted in the following cases:

Requirement

® You have opened the "OP Properties" dialog box, "Device" tab, by touching

the "OP" %" icon.

OP Properties

[ Persiskent Storage I Display |

Device: TP 1776 4" color PHIDP
Irnage Yersion: ¥01.00.00.00_01.47
Bootloader Yersion: 0.90
Bootloader Rel,Date: 29,2.2008
Flashsize: 32 MB
MaC-Address: 08-00-06-29-da-00
Reboot : @

@ Button for restarting the HMI device

® |f you want to reset the HMI device to the factory settings: the HMI deice is connected to
a configuration PC via PROFINET.
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Procedure
1. If you want to restart the HMI device, press the "Reboot" button.
The following message is displayed:

Attention

If wou execute this function, vou lose all unsaved Files,

Please close all applications before rebooting.

Press "Prepare For Reset” to download the OS5 and reset to
factory settings,

Rebook now?

| Rebook | |Prepare for Resetl

® @
@ If you run this function, all data which has not been backed up will be lost. Please close all
applications before restarting.

® Button for reset to factory settings and subsequent restart
® Button for restart

2. Press one of the buttons.
® |f you want to restart the HMI device, press the "Reboot" button.
The HMI device restarts without delay.

e [f you want to reset the HMI device to the factory settings and then restart, press the
"Prepare for Reset" button.

You are given the option of resetting the HMI device to the factory settings through
ProSave. The HMI device then restarts.

® |f you do not want to restart the HMI device, press the "No" button.

The message closes. There will be no restart.

Result
The HMI device starts.
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6.8.10 Displaying information about the HMI device

Introduction

Requirement

See also

You will need the device-specific information if you contact Technical Support.

the "OP" /

The following figure applies to the MP 377 15" Touch. The data displayed are device-specific
and may therefore deviate from that of your HMI device.

You have anened the "OP Properties" dialog box, "Device" tab, by touching
,é icon.

OP Properties

I Persistent Starage I Display |

Device: MP 377 15" Touch —@

Irnage Version: \i01.00,00,00_01.36 @

Bootloader Yersion: 0.2z @

Bootloader Rel,Date: 22,2.2006 @

Flashsize: 64 MB @

MaZ-Address: 03-00-06-29-d45-b5 @
Reboot : @

HMI device name

Version of the HMI device image

Version of the boot loader

Boot loader release date

Size of the internal flash memory in which the HMI device image and project are stored
MAC address of the HMI device

See section "Restarting HMI device"

QP®O®®e OO

The HMI device-specific information is displayed in the "Device" tab.

Note

The size of internal flash memory is not equivalent to application memory available for a
project.

Restarting the HMI device|(Page 125)
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6.8.11 Displaying system properties

Introduction

Requirements

The general system-specific information provides you with information about the processor,
operating system and memory.

You have opened the "System Properties”, dialog "General" tab with the "System" icon.

The data displayed are device-specific and may therefore deviate from that of
your HMI device.

System Properties m
General | Memary | Device Mame |
System: Computer:
Microsoft® WindowsE CE Processor Type: IInteI, ¥S5cale-21341
RIS Expansion Slats: | El
{® 2004 Microsoft Corp. Al rights Memary: 228035 KB RAM
reserved, This cormputer programm is ; .
protected by LS, and international Registered to:
copyright lawes.

@ @
® Copyright to Microsoft Windows CE
® Details on processor and size of internal Flash memory

Displaying system properties

128

The system properties are displayed. This dialog is read-only. Close the dialog.
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6.8.12 Displaying memory distribution

Introduction

Requirements

Procedure

The "Memory" system-specific information provides you with information about the
distribution and size of the memory in the HMI device.

NOTICE

"Memory" tab
Do not change the memory distribution in the "Memory" tab.

Applies for the usage of options:
An alteration to the memory distribution may be necessary. Please refer to the

accompanying documentation for further information.

You have opened the "System Properties", dialog "Memory" tab with the "System" 277 icon.

General | Memory | Device Marne

Move slider to the left for more remory to run prograrms. Move slider to
the right for more storage room. Only unused RAM can be adjusted.

Storage ;| Avcyrerseesmmm e DEQOram
Memory ﬁﬁ Memory
Allocated 15384KE Allocated 211740:B
In Use 100KE In Use 12344kB

1. Determine the HMI device's current memory structure

2. Close the dialog.
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6.9 Setting storage location

Introduction

Requirements

Procedure

Result

130

There are various storage locations available for storing the compressed source file of your
project. The following describes how you can set the storage location.

You have opened the "Transfer Settings", dialog "Directories" tab with

g
the "Transfer" g icon.

Transfer Settings

Project File
I'l,FIash'l,Simatic'l,

Project Backup q%/
I'I,Storage Card MM\ Simakich, B RS | _@
®

Aukostart application:

Path: WWaik [zec]:
I'l,FIash'l,Simatic'l,HmiRTm.exe |3 EI
@ Directory where the project file is saved
® Directory where the compressed source file of your project is saved
® Storage location and initialization file of the HMI device for process operation
NOTICE

Settings under "Project File" and "Path”

The project may not open the next time the HMI device is started if changes are made in
the "Project File" and "Path" text boxes.

Do not change the entries in the "Project File" and "Path" text boxes.

1. Select a memory location from the "Project Backup™ text box.

The external memory card or the location in the data network can be defined as the
storage location. During the next backup process, the project's source file is stored in the
specified location.

2. Confirm your entries.

The dialog closes.

The storage location for the HMI device is now set.
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6.10 Setting the delay time

Introduction

Once the HMI device has been switched on, a project can be started after a delay. The
Loader is displayed during the delay time.

Requirements

You have opened the "Transfer Settings", dialog "Directories" tab with
=

the "Transfer" T, icon.

Transfer Settings

Project File
I'l,FIash'l,Simatic\,

Praject Backup
I'l,Stnrage Zard MM 3imatic!,

Aukostart application:

Path: Wait [sec]:
I'l,FIash'l,Simatic'l,HmiRTm.exe |3 EI
NOTICE

Settings under "Project File" and "Path”

The project may not open the next time the HMI device is started if changes are made in
the "Project File" and "Path" text boxes.

Do not change the entries in the "Project File" and "Path" text boxes.

Procedure
1. Select the desired delay time in seconds from the "Wait [sec]" selection box.
With the value "0", the project starts immediately. It is then no longer possible to call the
Loader after switching on the HMI device. If you still wish to access the Loader, an
operating element must be configured to close the project.
2. Confirm your entries.
The dialog closes.
Result
The delay time for the HMI device is now set.
See also

Overview [(Page 163)
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6.11 Setting the uninterruptible power supply

Introduction

Requirements

Procedure

132

UPS monitoring is an option you load as an add-on with ProSave.

A UPS ensures that the HMI device is shut down in a controlled manner after a buffer time in
the event of a power failure. This avoids the loss of data.

The following uninterruptible power supplies are supported:
SITOP DC UPS modules as of a rated power value of 6 A, e.g. 6EP1931-2DC42

Connect the UPS to the 24-V input and a USB port. Configure the USB port
for UPS monitoring.

Ik
You have opened the "UPS Properties", dialog "Configuration" tab with the "UPS" jij icon.

;E___Eg!jf!guration I Current status I

Interface: LISE
Battery mode

[ send “Shutdown' signals after

Part disturbed

Text box for the time after which the "Battery mode activated" message is displayed
Check box for enabling battery mode

Text box for the time after which the "Faulty port" message is displayed

Check box for the "Faulty port" message

®OOE

® 0 0

Proceed as follows:
1. If you want to enable battery mode, activate the "Battery mode" check box.
2. Enter the time for terminating applications in the "min" and "s" text boxes.

You will receive a message when UPS takes effect. Applications such as HMI Runtime
and WIinAC MP are then terminated depending on the time entered.

3. If the port to which the UPS is connected is faulty and you therefore want to receive a
message, activate the "Port disturbed" check box.

4. Select the message you want from the list box.

5. Enter the time after which the "Faulty port" message is displayed in the "min" and
"s" text boxes.
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Result
Port monitoring for the UPS is set.

See also
State of uninterruptible power supply (Page 133)

6.12 State of uninterruptible power supply

Introduction
If you have connected a UPS to a USB port, you can display the monitoring state of this port.

Requirements

Al
You have opened the "UPS Properties", dialog "Current status" tab with the "UPS" _jfﬂ icon.

UPS Properties m m
| Cofiguration | Currenk status ||

Current status:

UPS programm is nok running. @

Mo current status available!

@ The "UPS program is not running. No current status available." message appears when the
UPS is not connected.

Procedure
Proceed as follows:
1. Installing the UPS monitoring software.
2. Connect the UPS.
3. If you want to update the monitoring state, press the "Update" button.

The message is changed according to the current setting. The message will remain
unchanged if no check boxes in the "Configuration" tab have been activated.

Result
The current monitoring state for the UPS is displayed.

See also
Setting the uninterruptible power supply (Page 132)
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6.13 Enabling PROFINET IO

PROFINET 10

If the HMI device is connected to the PLC via PROFINET, function keys or buttons, for
example, can be configured as PROFINET IO direct keys. If PROFINET IO direct keys are
used in the project, they must be enabled.

Note

If you enable PROFINET 1O direct keys, you cannot use the RS 422/RS 485 port
for serial communication.

PROFINET IO direct keys and PROFIBUS DP direct keys are mutually exclusive.

Requirements

You have opened the "PROFINET" dialog with the "PROFINET" i icon.

®
[ PROFINET IO enabled e

Device nanie: (max, 127 charackers)

[1P-377-15-ZolHTouch — —@
MAC Adress:  08-00-ab-ac-00-10 —@

@ Activating or deactivating the PROFINET 10 direct keys
® Text box for the device name
® MAC address of the HMI device

NOTICE
Inconsistent device name

If the device name does not match the device name entered in the HW Config of STEP 7,
the direct keys do not work.

Use the device name from the HW Config of STEP 7. This device name does not
correspond to the device name used under Windows CE.
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Within the ETHERNET data network, the device name must be unique and satisfy the DNS
conventions. These include:

Procedure

Restriction to 127 characters in total (letters, digits, hyphen or point)

A name component within the device name, e.g. a string between two points, may not
exceed 63 characters.

Special characters such as umlauts, brackets, underscores, slashes, spaces etc. are not
permitted. The hyphen is the one exception.

The device name must not start or end with a the "-" character.
The device name must not take the form n.n.n.n (n = 0 to 999).

The device name must not start with the character sequence "port-xyz-" (x, y, z= 0 to 9).

Proceed as follows:

1.

If you want to enable the PROFINET IO direct keys, activate the "PROFINET 1O enabled"
check box.

2. Enter the device name of the HMI device.

3. Confirm your entries.

Result

The dialog closes.

The PROFINET IO direct keys are enabled.
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6.14 Changing transfer settings

6.14.1 Configuring the data channel

Introduction

Requirements

136

If you block all data channels, the HMI device is protected against unintentional overwriting
of the project data and HMI device image.

Note

A project can only be transferred from the configuring PC to the HMI device when at least
one of the data channels is enabled on the HMI device.

The "Transfer Settings" dialog, "Channel" tab has been opened with the

]
"Transfer Settings" ¢, g icon.

Transfer Settings

. Channel | Directories |

rchannel 1
®

Serial:via R5232/PPI Multi-Master Cable

[ Enable Channel ] Remake Control

rchannel 2:
@
IETHERNET :I

Enable Channel Remote Control advanced @

@ Group for the data channel 1 (Channel 1)
® Group for the data channel 2 (Channel 2)
® Button for the "MPI/DP-Transfer Settings" and/or "Network and Dial-Up Connections" dialog

AWARNING

Unintentional transfer mode
Unintentional transfer mode could cause unintentional actions to be triggered in the plant.

Ensure that the configuring PC does not inadvertently switch the HMI device to transfer
mode during the open project.
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NOTICE

"Remote control" for "Channel 1"

If the "Remote Control" check box is activated during "Online" operating mode, the X10 port
cannot be used for communication.

The "Remote Control" check box must be deactivated for "Online" operating mode. Once
the serial transfer is complete, in the "Channel 1" group you must therefore deactivate the
"Remote Control" check box.

Transfer mode using "Channel 2"

When the project on the HMI device starts, transfer parameters, e.g. HMI device address,
for MPI/PROFIBUS DP are overwritten with the values from the project.

You can change the settings for the transfer via "Channel 2".

The following steps are required:

e Close the project.

¢ Change the settings on the HMI device.
e Then return to "Transfer" mode.

The next time the project is started on the HMI device, the settings will be overwritten by
the values from the project.

Note

If the HMI device is in "Transfer" mode while changes are made to the transfer settings,
the settings only go into effect after the transfer function is restarted.

This may occur if the Control Panel is opened to change the transfer properties in
an active project.
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6. 14 Changing transfer settings

Procedure

Result

See also

138

Proceed as follows:

. If you want to enable a data channel, activate the "Enable Channel" check box in the

"Channel 1" or "Channel 2" group.

In the "Channel 1" group, the RS-422/RS-485 port is enabled for the serial data transfer.
The network port is enabled in the "Channel 2" group.

. If you want to enable the automatic transfer, activate the associated "Remote Control"

check box.

. If you have enabled the data channel for "Channel 2", select the log from

the selection box.

. Enter further parameters if required.

Applies to "MPI/PROFIBUS DP":

— Press the "Advanced" button to switch to the "S7-Transfer Settings" dialog box.
You can change the settings for MPI/PROFIBUS DP there.

— Confirm your entries.

— The "S7-Transfer Settings" dialog box closes.

Applies to "ETHERNET":

— Use the "Advanced" button to change to "Network&Dial-Up Connections".
— Open the "ERTEC400" entry. You can change the TCP/IP settings there.
— Confirm your entries.

— Close "Network&Dial-Up Connections".

Applies to "USB":

— No settings are needed for "USB".

. Confirm your entries.

The dialog closes.

The data channel is configured.

Overview (Page 163)

Backup and restore using WinCC flexible (Page 169)
Backup and restore using ProSave (Page 171)
Changing MPI/PROFIBUS DP settings (Page 139)
Changing the network configuration (Page 145)

MP 377, MP 377 PRO (WinCC flexible)
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6. 14 Changing transfer settings

6.14.2 Changing MPI/PROFIBUS DP settings

Introduction
The communication settings for MPI or PROFIBUS DP are defined in the HMI device project.
In the following cases, the transfer settings might have to be changed:
® The first time the project is transferred

e |f changes are made to the project but are only applied later

NOTICE
Transfer mode using MPI/PROFIBUS DP
The bus parameters are read from the project currently loaded on the HMI device.

The settings for MPI/PROFIBUS DP transfer can be modified. The following steps
are required:

e Close the project.

e Change the settings on the HMI device.

e Then return to "Transfer" mode.

The changed MP/PROFIBUS DP settings will be overwritten in the following cases:
e The project is started again

e A project is transferred and started

Transfer settings

If the HMI device is in "Transfer" mode while changes are made to the transfer settings,
the settings only go into effect after the transfer function is restarted.

Requirements
You have opened the "S7-Transfer Settings" dialog with

the "S7-Transfer Settings" jﬂ icon.

S7-Transfer Settings m

FROFIBLS ( : )

‘ Properties... +—@

® Network selection

® Button for opening the properties dialog

MP 377, MP 377 PRO (WinCC flexible)
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6. 14 Changing transfer settings

Procedure

140

Proceed as follows:

1.
2.

Select a network.
Use the "Properties" button to open the "MPI" or "PROFIBUS" dialog.

MPI

ok ] x |

Skation Parameters
[ Panel is the anly master on the bus

Address: 1

®

Tirme-outk: 1s [l
Mekwork. Pararmeters

Transmission Fate: 187,5 khitsls =

Highesk Station 126 =

@® © |

Skation Parameters

[ Panel is the anly master on the bus

®

Address: 45
Time-out: 1s [l
Metwork, Parameters

Transmission Fate: 12 Mhbits\s

Highest Station Address; 126

@

LlLadl

Prafile P

Bus Parameters, .,

|

CSNCNCNCNCNCONC)

CONORONS

The HMI device is the only master on the bus.

Bus address of the HMI device
Time-out

Data transmission rate in total network
Highest station address in the network

Profile

Button for displaying the bus parameters

If there are several masters connected on the bus, deactivate the "Panel is the only
master on the bus" check box.

Enter the bus address for the HMI device in the "Address" text box.

NOTICE

The bus address in the "Address" text box must be unique throughout the
MPI/PROFIBUS DP network.

Select the transmission rate from the "Transmission Rate" text box.

Enter the highest station address on the bus in the "Highest Station Address" or
"Highest Station" text box.

Select the desired profile from the "Profile" selection box.

MP 377, MP 377 PRO (WinCC flexible)
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Result

See also

6. 14 Changing transfer settings

8. If you want to view the profile data, press the "Busparameter" button of

the PROFIBUS dialog.

The profile data are displayed. The "Profile" dialog is read-only.

NOTICE

The bus parameters must be the same for all stations in
the MPI/PROFIBUS DP network.

Tslot:

Mir Talr:
Max Tadr:
Teet:
Toui:

Gap factor

Retry limit:

tBit
tBit
tBit
tBit
tBit

Trdy
Tid1:
Tid2:

11 it
37 tBit
150 tBit

9. Close the "Profile" dialog.

10. Confirm your entries.

The dialog closes.

The MPI/PROFIBUS DP settings of the HMI device have been changed.

Configuring the data channel (Page 136)
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6.15 Configuring network operation

6.15 Configuring network operation

6.15.1 Overview of network operation

Introduction

Addressing

142

You can connect the HMI device to a PROFINET network via the Ethernet port.

NOTICE

The HMI device only has client functionality in the PC network. This means that users can
access files of a node with TCP/IP server functionality from the HMI device via the network.
However, you cannot, for example, access files of the HMI device from a PC via

the network.

Note

Information on communication using SIMATIC S7 via PROFINET is provided in the
"WinCC flexible communication" user manual.

The connection to a network offers, for example, the following options:

® Printing via a network printer

® Saving, exporting and importing of recipe data records on or from a server
® Setting up of message and data archives

® Transferring a project

e Saving data

Within a PROFINET network, computers are usually addressed using computer names.
These device names are translated from a DNS or WINS server to TCP/IP addresses.
This is why a DNS or WINS server is needed for addressing via computer names when
the HMI device is in a PROFINET network.

The corresponding servers are generally available in PROFINET networks.

Note
The use of TCP/IP addresses to address PCs is not supported by the operating system.

Consult your network administrator if you have questions in this regard.

MP 377, MP 377 PRO (WinCC flexible)
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Printing via a network printer

The HMI device's operating system does not support line by line alarm logging via a network
printer. All other printing functions, for example, hardcopy or logs, are available without
restriction via the network.

Preparation

Before beginning the configuration, request the following network parameters from your
network administrator.

® Does the network use DHCP for dynamic assignment of network addresses?
If not, get a new TCP/IP network address for the HMI device.

® Which TCP/IP address does the default gateway have?

e |f a DNS network is used, what are the addresses of the name server?

e [f a WINS network is used, what are the addresses of the name server?

General procedure for configuring the network

The HMI device must be configured prior to network operation. The configuration is basically
divided into the following steps:

Proceed as follows:

1. Enter the device name of the HMI device.
2. Configure the network address.

3. Set the logon information.
4

. Save the settings.
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6.15 Configuring network operation

6.15.2 Setting the device name of the HMI device

Introduction

Requirements

Procedure

Result

144

The HMI device uses the device name to identify itself in the communication network.

You have opened the "System Properties", dialog "Device Name" tab with

the "System" &i57 icon.

System Properties m

General] Marnory | Device Marme l
These settings are wsed to identify your Windows CE device to

other cormputers,
Please type a name (without any spaces) and a short description,

Device name:; | skiEEEE)]

@
Device description; |HMI Device —_@

@ Device name of the HMI device
® Description for the HMI device (optional)

Note

To activate the network functions, enter a unique computer name in the "Device name"
text box.

Proceed as follows:

1. Enter the device name for the HMI device in the "Device name" text box.

2. If necessary, enter a description for the HMI device in the "Device description" text box.
3. Confirm your entries.

The dialog closes.

The device name for the HMI device is now set.
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6.15.3 Changing the network configuration

Introduction

You can change the network settings for the LAN connection under
"Network&Dial-Up Connections".

Requirements

You have opened the following display using the "Network&Dial-Up Connections™ er_, icon.

|File Edit View Advanced ||}Ri| Egiié_l EE
ERTEC400

MP 377, MP 377 PRO (WinCC flexible)
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6.15 Configuring network operation

MP 377, MP 377 PRO (WinCC flexible)

Procedure
Proceed as follows:
1. Open the "ERTEC400" entry.
The "ERTEC400 Ethernet Driver' Settings" dialog is opened.
IP Address i'Name Servers |
An 1P address can be (") Obtain an IP address via DHIP
autornatically assigned to this
cornputer. If your network @ Specify an IP address
does not automatically assign : _
IP addresses, ask wour netwaork e 15268 55 108
administrator for an address, Subnat Mask:
and then type it in the space
provided. Default Gateway: |:|
2. If you need automatic issuing of addresses, select the "Obtain an IP address via DHCP"
radio button.
3. If you need manual issuing of addresses, select the "Specify an IP address" radio button.
4. If you have selected manual issuing of addresses, enter the corresponding addresses in
the "IP Address", "Subnet Mask" text boxes and if necessary in "Default Gateway".
5. If a name server is used in the network, change to the "Name Servers" tab.
i IP Address | Mame Servers |
Marme setver addresses may be  Prirnary DRNS: |:|
autornatically assigned if DHCP
is enabled on this adapter, Secondary DMNS: I:I
fou can specify additional . : |:|
WINS or DMS resolvers in the Froi e
space provided. Secondary WINS: |:|
6. Enter the respective addresses in the text boxes.
7. Confirm your entries.
The dialog closes.
8. Close the "Network&Dial-Up Connections" display.
The Control Panel is displayed again.
Result
The LAN connection parameters for the HMI device have been changed.
See also
Configuring the data channel (Page 136)
146
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6.15.4 Changing the logon data

Introduction

6. 15 Configuring network operation

Windows CE uses this information to gain access to the network resources. Enter the user
name, password and domain you have received from your administrator.

Requirements

], 5

You have opened the "Network ID" dialog with the "Network ID" =g icon.

Identification |

Windows CE uses this LIzer narne: |
inforrmation to gain access to

rnetwork resources. Enter the  Password: |
Liser name, password, and

domain provided by your Domain: |
network adrinistrator.

Procedure
Proceed as follows:
1. Enter the user name in the "User name" text box.
2. Enter your password in the "Password" text box.
3. Enter the domain name in the "Domain" text box.
4. Confirm your entries.

The dialog closes.
Result

The logon information has now been set.
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6.15 Configuring network operation

6.15.5 Changing e-mail settings

Requirements
You have opened the "WIinCC flexible Internet Settings" dialog with the
"WinCC Internet Settings" icon.

WinCC flexible Internet Settings m

SMTP server a
@ Use the default of the praject file i

®] _4@)

Mame

Sender: |5irnatic HMI Dewvice —4@
Authentication: | —4@

@ Setting the SMTP server

® Name for the sender
® E-mail account
Note

Additional tabs may appear in the "WIinCC flexible Internet Settings" dialog. This depends on
the options that have been enabled for network operation in the project.

Procedure
Proceed as follows:
1. Specify the SMTP server.

— Activate the "Use the default of the project file" radio button if you want to use the
SMTP server configured in the project.

— Deactivate the "Use the default of the project file" radio button if you do not want to
use the SMTP server configured in the project. Specify the required SMTP server.

2. Enter the name for the sender in the "Sender" text box.
3. Enter the e-mail account for your e-mail in the "Authentication" text box.

Some e-mail providers only allow you to send mail if you specify the e-mail account. The
"Authentication” text box can remain empty if your e-mail provider allows you to send mail
without checking the account.

4. Confirm your entries.

The dialog closes.

Result
The e-mail settings have been changed.
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6.15.6 Changing Internet settings

6.156.6.1  Changing general Internet settings

Requirements
You have opened the "Internet Options", dialog "General" tab with

the "Internet Options" 9 icon.

Internet Options m

G3eneral |C0nnecti0n IF‘rivac\,r I Advanced I

Start Page: Ihttp:f,fwww.siemens.cc:mfautc:matinn

Search Page: Ihttp:waw.siemens.cumfautumatianfser\tice

User Agent (requires browser restart): |Defau|t (Windows CE) El
Cache Size {in KB): |512 ‘ Clear Cache | |Clear Histuryl
Note

Do not change the settings in the "User Agent" field.

Procedure

Proceed as follows:
Enter the homepage for the Internet browser in the "Start Page" text box.
Enter the address of the required search engine in the "Search Page" text box.
Enter the required cache memory size in the "Cache" text box.
If you want to delete the cache memory, press the "Clear Cache" button.

If you want to delete the history, press the "Clear History" button.

BN O

Confirm your entries.

The dialog closes.

Result
The general parameters for the Internet browser have been set.
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6.15 Configuring network operation

6.15.6.2 Setting the proxy server

Requirements

Procedure

You have opened the "Internet Options", dialog "Connection" tab with

the "Internet Options" 9 icon.

Internet Options m
Connection |Privacy | Advanced

[]Use L&N (no autodial)  Autodial name: | El

Network
|:| #ccess the Internet using a proxy server:

Address: I Paort: IEID

[[] Bypass prawy server for local addresses

Proceed as follows:
1. Select the "Use LAN (no autodial)" check box.

2. If you are using a proxy server, in the "Network" group, activate the
"Access the Internet using a proxy server" check box.

Specify the address of the proxy server and the port.

3. If you want to bypass the proxy server for local addresses, activate the
"Bypass proxy server for local addresses" check box.

4. Confirm your entries.

The dialog closes.

6.15.6.3 Changing privacy settings

Cookies and encryption

150

Cookies are pieces of information sent by a web server to a browser. In the event of
subsequent access to the web server, the cookies are sent back. This enables information to
be stored between the accesses.

In order to ensure a high level of privacy, data are sent via the Internet in encrypted form.
Common encryption protocols include SSL and TLS. You can activate or deactivate the
usage of encryption protocols.

The required settings can be obtained from your network administrator.
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Requirements

6. 15 Configuring network operation

You have opened the "Internet Options" dialog, "Privacy" tab with

the "Internet Options" ig’icon.

Internet Options

| General | Conmection | Privacy | Advanced |

okf %

Cookies

First-party Cockigs Third-party Cookigs

: () Accept
) Block ) Block
) Prompt {®) Prompt

Blways allow session caokies

Procedure
Proceed as follows:

1. Select the required cookie behavior by means of the radio buttons.

"Accept"

Cookies are stored without request.
— "Block"

Cookies will not be stored.
- "Prompt"

Cookies will be stored on request.

2. If you want allow cookies which are restricted to a single session, activate the

"Always allow session cookies" check box.

3. Change to the "Advanced" tab.

Internet Options

[General I Connection IF‘rivac\,r | Advanced |

CX E3

[Tse 551 2.0
Use S5L 3.0
Use TLS 1.0

warn if changing between secure and not secure mode

4. Activate the required encryption protocol.
5. Confirm your entries.

The dialog closes.

Result
The logon information has now been set.
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6.15.6.4 Importing and deleting certificates

Overview

You can import, view and delete certificates that have been imported for the HMI device.
The certificates differ in the following ways:

e Certificates that you trust

e Own certificates

® Other certificates

You can import additional certificates and delete certificates that are not required.

The required settings can be obtained from your network administrator.

Requirements

You have opened the "Certificates" dialog with the "Certificates" icon.

Stares |

Class 2 Public Primnary Certification Authority E
Class 3 Public Prirnary Certification Authority
Entrust.net Certification Authority (2048)
Entrust.net Secure Server Certification Authorit
Lists the certificates Equifax Secure Certificate Authority

trusted by you GlobalSign Root €& El

Import.. || Yiew.. || Remove |

Procedure
Proceed as follows:
1. Select the type of certificate from the selection box:
"Trusted Authorities"
"My Certificates"
"Other Certificates"
2. If required, start the importing process with the "Import" button.
A dialog with source details will open.
3. Ifrequired, delete certificates with the "Remove" button.
Mark the desired certificate.
4. If you want to list the properties of the certificate marked, press the "View" button.
5. Confirm your entries.

The dialog closes.

Result
The changes to the certificates have been undertaken.
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6.16 Saving to external storage device (backup)

Introduction

A backup involves copying the operating system, applications and data from the internal in
flash memory of the HMI device to an external storage device.

The following external storage devices are possible:
e External memory

e USB memory stick

Requirements

e The HMI device features an external storage device with sufficient free space.

® You have opened the "Backup/Restore" dialog with the "Backup/Restore" @ icon.

Backup f Restore

&l ather application must be ended before
starting <BACKUP> or <RESTORE:.

Backup (to storage card)

BACKUP

Restore (from storage card)

RESTORE

Procedure - using a memory card for the first time

NOTICE

Loss of data possible

The first time you use a memory card the HMI device will request that you format the card.

Save a backup copy of memory card data to a PC before formatting.

Proceed as follows:
1. Cancel the formatting procedure by pressing "ESC".

. Remove the memory card from the HMI device.

2

3. Save a backup copy of vital data to a PC.
4. Insert the memory card into the HMI device.
5

. Format the memory card on the HMI device.
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6.16 Saving to external storage device (backup)

Procedure

Result
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Proceed as follows:

1.

Press the "BACKUP" button to open the "Select Storage Card" dialog.

The "--- no storage card available ---" message appears if there is no external memory
in the HMI device or if this memory is defective. Insert an external memory or a
different one.

2. Select the external memory for backup from the "Please select a Storage Card" list box.
3. Click on the "Start Backup" button.

The HMI device checks the external memory.

If the "This storage card..." message appears, an external memory with a greater memory
capacity is needed. Acknowledge this message. Backup is aborted. Insert an external
memory with a greater memory capacity and restart the backup process.

If the "You may have an old backup on the storage card. Do you want to delete it?"
message appears, there is already a backup on the external memory. If you do not want
to overwrite the backup, press the "No" button. Otherwise click on the "Yes" button.

Several messages are displayed in sequence during the backup process:
— Saving registry data
— Copy files

A progress bar shows the status of the backup process. When the backup process is
completed, the following message is displayed:

"The operation completed successfully."

. Acknowledge this message.

The dialog closes.

The HMI device data is now saved on the external memory.
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6.17 Restoring from external storage device

Introduction

A restore operation deletes the old data from flash memory of the HMI device on
confirmation. The data stored on the external memory is then copied to the internal flash
Flash memory.

Requirements

e The external memory holding the backed up data is inserted in the HMI device.

® You have opened the "Backup/Restore" dialog with the "Backup/Restore" @ icon.

Backup [ Restore

all other application rust be ended before
starting <BACKUP= or <RESTORE:=.

Backup (to storage card)

BACKUP

Restore (from storage card)

RESTORE

NOTICE

Loss of data possible

All data on the HMI device will be deleted during a restore operation. License keys are
deleted after counter-inquiry.

Back up the HMI device's data before restoring if required.
External memory with data backup

If several external memories with data backups are plugged in, the data cannot
be restored.

Remove the external memory with the data backups not needed.
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6.17 Restoring from external storage device

Procedure
Proceed as follows:
1. Press the "RESTORE" button to open the "Storage Card" dialog.

Storage Card m

Storage Card with Backup detected:
--- o storage card available -- @

Only one Storage Card containing Backup is alloveed.
Mo Storage Card detected, please insert Storage @
Card and press <Refreshiz.

‘ Cancel | Start Restore

@ No storage card available

® Only one storage card containing backup is allowed. No storage card detected. Insert a
storage card and press the "Refresh" button.

2. Select the external memory with the backup from the "Storage Card with Backup
detected" selection box.

The "--- no storage card available ---" message appears if there is no external memory in
the HMI device or if this memory is defective.

3. If the "--- no storage card available ---" message appears, press the "Cancel" button.
Restoring is then aborted.
— Insert a memory card or a different one.
— Click on the "Refresh" button.
The content of the selection box will be changed.

— Select the external memory with the backup from the "Storage Card with Backup
detected" selection box.

4. Click on the "Start Restore" button.

Restoring is started.
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Result

6.17 Restoring from external sforage device

. The data to be restored is checked.

The following messages are displayed in sequence during the check.
"Starting Restore"
"Checking data"

When the data has been checked, the following message is displayed:

"You are starting RESTORE now. All files (except files on storage cards) and the registry
will be erased. Are you sure?"

The message means that the restore process can be started. All files files except
those located on the external memory will be deleted. Tab entries are also deleted.
Are you sure?

. If you do not want to allow the data to be deleted from the HMI device, abort the restore

process by pressing the "ESC" button.

. Start to restore the data by selecting "Yes".

The following messages are displayed in sequence during the restore:
"Deleting files on flash"
"Restore CE Image"

A progress bar shows the status of the restore process.

When restore is completed, the following message is displayed:

"Restore succesfully finished. Press ok, remove your storage card and
reboot your device."

8. Remove the external memory.

9. Acknowledge this message.

The HMI device starts.

The data from the external memory is now on the HMI device.

Note
Calibrating the touch screen

After the reset, you may have to recalibrate the touch screen.
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6.18

Activate memory management

Memory management

Requirements

Procedure

Result
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Provided the memory management is activated, the HMI device will automatically close the
project if the memory needs reorganizing during an active project.

The project is shut down and the HMI device will display a message. You have to restart
the project.

NOTICE

Memory management

If you do not activate memory management, undefined states can occur during the runtime
of the project.

Active memory management from the "OP Properties" dialog.

You have opened the "OP Properties" dialog, "Memory Monitoring" tab with
the "OP" 6@ icon.

OP Properties

| Display | Device | Touch || Memary Monitaring :

Maximum used memory; 5% |I

Zurrent used mermory: 5%

D Shut down HMI Funkime iF memory is running low, M

00

©) Maximum memory used since the HMI device was last switched on
® Percentage of memory currently used
® Activate memory management

Proceed as follows:
1. If you want to enable memory management, activate the check box.

If memory management is active and there is not enough working memory, the
SIMATIC HMI runtime and therefore the current project will be closed.

2. Confirm your entries.

The dialog closes.

Memory management is activated.
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7.1 Overview

Configuration phase

A project — the process image of the working process — is produced during configuration
to visualize automated working processes. The process displays for the project contain
displays for values and messages which provide information about process statuses.
The process control phase follows the configuration phase.

Process control phase

The project must be transferred to the HMI device if it is to be used in process control.
Another precondition for process control is that the HMI device is connected online to a
controller. Current working processes - operating and observing - can then be subject to
process control.

Transferring the project to the HMI device
You can transfer a project to an HMI device as follows:
® Transfer from the configuring PC
® Restore from a PC using ProSave

In this case, an archived project is transferred from a PC to the HMI device.
The configuration software need not be installed on this PC.

Commissioning and recommissioning
Initial and re-start-ups differ in the following respects:
® \When the HMI device is commissioned there is no project at first.
The HMI device is also in this state after the operating system has been updated.

® \When recommissioning, any project already on the HMI device is replaced.
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7.2 Operating modes

7.2 Operating modes

Operating modes
The HMI device may be in the following operating modes:
e Offline
® Online
® Transfer

"Offline mode" and "Online mode" can be set on both the configuring PC and the HMI
device. To set these modes on the HMI device, use a corresponding operating element
of the project.

Changing the operating mode

The configuration engineer must have configured an appropriate operating element to allow
a change of the operating mode on the HMI device during ongoing operation.

Further information on this may be available in your plant documentation

"Offline" operating mode

In this mode, there is no communication between the HMI device and PLC. Although the
HMI device can be operated, it cannot exchange data with the PLC.

"Online" operating mode

In this mode, the HMI device and PLC communicate. You can operate the plant on the HMI
device according to your system configuration.

"Transfer" mode

In this mode, you can transfer a project from the configuring PC to the HMI device or backup
and restore HMI device data, for example.

The following options are available for setting "Transfer" mode on the HMI device:
® \When the HMI device starts up

Start "Transfer" mode manually in the HMI device Loader.
e During ongoing operation

Start the "Transfer" mode manually within the project using an operating element. The
HMI device toggles to "Transfer" mode when automatic mode is set and a transfer is
initiated on the configuring PC.

See also
Backup and restore using WinCC flexible |(Page 169)

Backup and restore using ProSave (Page 171)
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7.3 Using existing projects

The following table shows how you can reuse existing projects, while observing
the screen size:

HMI device in the existing project New HMI device

MP 370 12" Touch MP 377 12" Touch

MP 370 12" Key MP 377 12" Key

MP 370 15" Touch MP 377 15" Touch, MP 377 PRO 15" Touch

The following cases are possible:
1. Project exists in ProTool

Migrate the project to WinCC flexible and then replace the HMI device.
2. Project exists in WinCC flexible

Carry out an HMI device switch in WinCC flexible.

If you migrate existing projects from HMI devices with a different screen size, images which
have already been configured are converted during the migration.

Further information on the subject can be found in the WinCC flexible Online Help or in the
"WinCC flexible Migration" manual.

MP 377, MP 377 PRO (WinCC flexible)
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7.4

Overview

See also

162

Data transmission options

The following table shows the options for data transfer between the MP 377 and

the configuring PC.

Type Data channel MP 377
Backup Serial " Yes
MPI/PROFIBUS DP Yes
USB Yes
PROFINET Yes
Restoring Serial » Yes
MPI/PROFIBUS DP Yes
USB Yes
PROFINET Yes
Updating the operating system Serial 1) Yes
MPI/PROFIBUS DP Yes
USB Yes
PROFINET Yes
PROFINET with restore to Yes
factory setting
Transferring a project Serial " Yes
MPI/PROFIBUS DP Yes
UsB 2 Yes
PROFINET Yes
Installing or removing an option Serial 1) Yes
MPI/PROFIBUS DP Yes
USB Yes
PROFINET Yes
License key transferring or Serial » Yes
transferring back MPI/PROFIBUS DP Yes
USB Yes
PROFINET Yes

R Applies when PC/PPI cable 6ES7 901-3CB30-0XA0 is used

2) You must not connect the HMI device to a USB 2.0 hub.

Overview|(Page 163)

Backup and restore using WinCC flexible |(Page 169)

Backup and restore using ProSave|(Page 171)
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7.5 Transfer

7.5 Transfer
7.51 Overview
Transfer

Backtransfer

See also

Transfer the executable project from the configuring PC to the HMI device.
You can start the "Transfer" mode manually or automatically on the HMI device.

Transferred data is written directly to the internal flash memory on the HMI device. For the
transfer, you use a data channel which you have to configure before starting a transfer.

You have the option to transfer the compressed project file together with the runtime project
to the HMI device. If necessary, the compressed project file can be transferred back to the
configuring PC and edited.

The HMI device must be equipped with an external memory card to which the compressed
project file can be saved.

NOTICE

Compressed project file

WinCC flexible does not check whether the compressed project file stored on the HMI
device corresponds to the existing runtime project.

Setting the delay time|(Page 131)
Configuring the data channel|(Page 136)

Data transmission options|(Page 162)

7.5.2 Starting manual transfer

Introduction

You can manually switch the HMI device to "Transfer" mode as follows:
® \With a configured operating element during ongoing operation.

® |n the Loader of the HMI device.

MP 377, MP 377 PRO (WinCC flexible)
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Requirements

The project "*.hmi" is opened in WinCC flexible.
The HMI device is connected to a configuring PC.
The data channel is configured on the HMI device.

The HMI device is in "Transfer" mode.

Procedure
Proceed as follows:
1. On the configuring PC, select the "Transfer settings" command in the menu "Project >
Transfer" in WinCC flexible.
The "Select devices for transfer" dialog opens.
2. Select the HMI device in the left area of the dialog.
3. Select the type of connection between the HMI device and the configuring PC.
Set the connection parameters.
4. Set the transfer parameters in the right area of the dialog.
5. If you wish to transfer the compressed project file together with the runtime project to the
HMI device:
Select the "Enable backtransfer" check box.
6. Start transfer in WinCC flexible with "Transfer".
The configuring PC checks the connection to the HMI device. The project is transferred to
the HMI device. If the connection is not available or is defective, an error message is
displayed on the configuring PC.
Result
When the transfer is completed successfully, the project can be found on the HMI device.
The transferred project is then started automatically.
753 Starting automatic transfer
Introduction
If automatic transfer is activated, the HMI device automatically changes into "Transfer" mode
during operations as soon as a transfer starts on the configuring PC connected.
Note
With automatic transfer, the HMI device only changes into "Transfer" mode when the project
is running on the HMI device.
Automatic transfer is particularly suited for the test phase of a new project since transfer is
completed without interfering with the HMI device.
MP 377, MP 377 PRO (WinCC flexible)
164 Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO



Commissioning a project

Requirements

Procedure

Result

7.5 Transfer

NOTICE

If the automatic transfer has been activated on the HMI device and a transfer is initiated on
the configuring PC, the project currently running is automatically stopped. The HMI device
then automatically switches to "Transfer" mode.

After the commissioning phase, deactivate the automatic transfer so that the HMI device
cannot be inadvertently switched to transfer mode. The transfer mode can trigger
unintentional actions in the device.

You can issue a password in the control panel to restrict access to the transfer settings and
thus avoid unauthorized modifications.

® The project *.hmi is opened in WinCC flexible.

® The HMI device is connected to a configuring PC.

® The data channel is configured on the HMI device.

® The automatic transfer is activated in the data channel for the transfer.

® The project is started on the HMI device.

Proceed as follows:

1. On the configuring PC, select the "Transfer settings" command in the menu "Project >
Transfer" in WinCC flexible.

The "Select devices for transfer" dialog opens.

2. Select the HMI device in the left area of the dialog.

3. Select the type of connection between the HMI device and the configuring PC.
Set the connection parameters.

4. Set the transfer parameters in the right area of the dialog.

5. If you wish to transfer the compressed project file together with the runtime project to the
HMI device:

Select the "Enable backtransfer" check box.
6. Start transfer in WinCC flexible with "Transfer".

The configuring PC checks the connection to the HMI device. The HMI device shuts
down the current project and automatically switches to "Transfer" mode. The project is
transferred to the HMI device. If the connection is not available or is defective, an error
message is displayed on the configuring PC.

When the transfer is completed successfully, the project can be found on the HMI device.
The transferred project is then started automatically.

MP 377, MP 377 PRO (WinCC flexible)
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754 Starting backtransfer

Requirements

Procedure

Result

166

No project is open in WinCC flexible.

The HMI device is connected to a configuring PC.
The data channel is configured on the HMI device.
The HMI device is in "Transfer" mode.

The memory card containing the compressed project file is inserted into the HMI device.

Proceed as follows:

1.

On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

2. Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuring PC.

Set the connection parameters.

4. Close the dialog with "OK".

5. Select the "Transfer" > "Backtransfer" command in the "Project” menu.

The "Backtransfer" dialog opens.
Click "OK" to start the backtransfer process.

The configuring PC checks the connection to the HMI device. The compressed project file
is transferred back from the HMI device to the configuring PC. If the connection is not
available or is defective, an error message is displayed on the configuring PC.

After successful backtransfer, the project is opened on the configuring PC in WinCC flexible.

MP 377, MP 377 PRO (WinCC flexible)
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755 Testing a project

Introduction

There are two options to test a project:

Test the project on the configuring PC

You can test a project at a configuring PC, using a simulator. For detailed information,
refer to the "WIinCC flexible" user manual and to the WinCC flexible Online Help.

Offline testing of the project on the HMI device

Offline testing means that communication between the HMI device and PLC is down
while the test is being carried out.

Online testing of the project on the HMI device

Online testing means that the HMI device and PLC communicate with each other
during testing.

Perform the tests, starting with the "Offline test", followed by the "Online test".

Note

You should always test the project on the HMI device on which the project will be used.

Check the following:

1.
2.
3.
4.

Check the correct layout of the screens
Check the screen navigation
Check the input objects

Enter the tag values

The test increases the certainty that the project will run error-free on the HMI device.

Requirements for offline testing

Procedure

The project has been transferred to the HMI device.

The HMI device is in "Offline" mode.

In "Offline" mode, you can test individual project functions on the HMI device without them
being affected by the PLC. PLC tags, therefore, are not updated.

Test the operating elements and visualization of the project as far as possible without
connecting to the PLC.

Requirements for online testing

The project has been transferred to the HMI device.

The HMI device is in "Online" mode.

MP 377, MP 377 PRO (WinCC flexible)
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7.6 Backup and restore

Procedure

7.6

7.6.1

In "Online" mode, you can test individual project functions on the HMI device without them
being affected by the PLC. PLC tags are updated in this case.

You have the option to test all communication-dependent functions, for example alarms, etc.

Test the operating elements and views of the project.

Backup and restore

Overview

Backup and restore

You can back up and restore the following data in the internal flash memory of the
HMI device with a PC:

® Project and HMI device image

® Password list

® Recipe data

® License keys

Use one of the following tools for backup and restore:
® WinCC flexible

® ProSave

Note
Alternatively, use the control panel to back up to an external memory device.

General information

See also

168

NOTICE

Power failure

If a complete restore operation is interrupted due to power failure on the HMI device, the
operating system of the HMI device may be deleted! In this case, you have to reset the HMI
device to its factory settings.

Compatibility conflict

If a message is output on the HMI device warning of a compatibility conflict during the
restore operation, the operating system must be updated.

Saving to external storage device (backup) |(Page 153)
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7.6.2 Backup and restore using WinCC flexible

Requirements
® No project is open on the configuring PC in WinCC flexible.
® The HMI device is connected to this configuring PC.

® The data channel is configured on the HMI device.

Procedure for backup
Proceed as follows:

1. On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

2. Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuring PC.
Set the connection parameters.

4. Close the dialog with "OK".

5. Select the "Backup" command in the menu "Project > Transfer" in WinCC flexible.
The "Backup Settings" dialog opens.

6. Select the data to be backed up.

7. Select a destination folder and a file name for the "*.psb" backup file.

8. Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the HMI device automatically
sets "Transfer" mode when a backup is initiated.

9. Start the backup operation in WinCC flexible with "OK" on the configuring PC.
Follow the instructions in WinCC flexible.

A status view opens to indicate the progress of the operation.

Result
The system outputs a message when the backup is completed.

The relevant data is now backed up on the configuring PC.

MP 377, MP 377 PRO (WinCC flexible)
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Procedure for restore

Proceed as follows:

1.

o a0k~ 0N

Result

On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

Select the type of HMI device.

Select the type of connection between the HMI device and the configuring PC.
Set the connection parameters.

Close the dialog with "OK".

Select the "Restore" command in the menu "Project > Transfer" in WinCC flexible.
The "Restore Settings" dialog opens.

Select the "*.psb" backup file to be restored from the "Open" field.

You can see the HMI device for which the backup file was created and the type of backup
data the file contains.

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when a restore operation is initiated.

Start the restore operation in WinCC flexible with "OK" on the configuring PC.

If there are license keys both on the HMI device and in the backup, a dialog will appear.
Use this dialog to establish whether you want to overwrite the license keys or abort the
restore process.

— If necessary, abort the backup and first back up the HMI device's license keys.
— Then restart the restore process.
Follow the instructions in WinCC flexible.

A status view opens to indicate the progress of the operation.

When the restore is successfully completed, the data backed up on the configuring PC is
now on the HMI device.

See also

Transferring and transferring back license keys (Page 186)

Configuring the data channel|(Page 136)

Operating modes (Page 160)

Data transmission options|(Page 162)
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7.6.3 Backup and restore using ProSave

Requirements

o The HMI device is connected to a PC on which ProSave is installed.

® The data channel is configured on the HMI device.

Procedure for backup
Proceed as follows:

1.
2.
3.

From the Windows Start menu, start ProSave on the PC.
Select the HMI device type in the "General" tab.
Select the type of connection between the HMI device and the PC.

Set the connection parameters.

4. Select the data to be backed up in the "Backup" tab.

5. Select a destination folder and a file name for the "*.psb" backup file.

6. Set "Transfer" mode on the HMI device.

Result

If automatic transfer mode is enabled on the HMI device, the HMI device automatically
sets "Transfer" mode when a backup is initiated.

Start the backup operation in ProSave with "Start Backup".
Follow the instructions in ProSave.

A status view opens to indicate the progress of the operation.

The system outputs a message when the backup is completed.

The relevant data is now backed up on the PC.

MP 377, MP 377 PRO (WinCC flexible)
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Procedure for restore
Proceed as follows:

1.

Result

From the Windows Start menu, start ProSave on the PC.

2. Select the HMI device type in the "General" tab.
3.
4
5

Select the type of connection between the HMI device and the PC.

. Set the connection parameters.

. Select the "*.psb" backup file to be restored from the "Restore" tab.

You can see the HMI device for which the backup file was created and the type of backup
data the file contains.

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when a restore operation is initiated.

. Start the restore operation in ProSave on the PC with "Start Restore".

If there are license keys both on the HMI device and in the backup, a dialog will appear.
Use this dialog to establish whether you want to overwrite the license keys or abort the
restore process.

— If necessary, abort the backup and first back up the HMI device's license keys.
— Then restart the restore process.
Follow the instructions in ProSave.

A status view opens to indicate the progress of the operation.

When the restore is successfully completed, the data backed up on the PC is now on
the HMI device.

See also

Configuring the data channel|(Page 136)

Operating modes (Page 160)

Data transmission options|(Page 162)

Transferring and transferring back license keys|(Page 186)
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7.7 Updating the operating system

7.71 Overview

Updating the operating system

A compatibility conflict may occur when transferring a project to the HMI device. This is
caused by different versions of the configuration software used and the HMI device image
available on the HMI device. If there are different versions, the transfer is aborted. A
message indicating a compatibility conflict is displayed on the configuration PC.

There are two ways to match the versions:

e Update the HMI device image if the project was created with the most recent version of
the configuration software.

e Transfer a matching version of the HMI device image if you do not want to adapt the
project for the HMI device to the most recent version of the configuration software
for the project.

NOTICE

Data loss

All data on the HMI device, such as the project and licenses, will be deleted when you
update the operating system.

Note
When WIinAC MP is used, all data channel parameters are reset.

Note
Calibrating the touch screen

After the update, you may have to recalibrate the touch screen.

MP 377, MP 377 PRO (WinCC flexible)
Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO 173



Commissioning a project

7.7 Updating the operating system

7.7.2

174

Resetting factory settings

In ProSave or WinCC flexible, you can update the operating system with or without resetting
to factory settings.

e Updating the operating system without resetting to factory settings

First, switch into "Transfer" mode on the HMI device or use the automatic transfer
function if the project is active. Then start the operating system update in ProSave
or WinCC flexible.

Updating the operating system with resetting to factory settings

NOTICE

Loss of license keys

The license keys on the HMI device will be deleted when resetting to factory settings.
The license keys on the HMI device will be retained when updating the operating system
without resetting to factory settings.

NOTICE
Data channels

When resetting to factory settings, all data channel parameters are reset. The transfer
can only be started following reconfiguration of the data channels.

Note

You have to perform an operating system update with reset to factory settings if the
HMI device does not yet have an operating system or if the HMI device's operating
system is corrupt.

First, start the operating system update in ProSave or WinCC flexible and switch the
power on the HMI device off and on again when prompted.

MP 377, MP 377 PRO (WinCC flexible)
Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO




Commissioning a project

7.7 Updating the operating system

7.7.3 Updating the operating system using WinCC flexible

Requirements

® No project is open on the configuring PC in WinCC flexible.

® The HMI device is connected to this configuring PC.

® The data channel is configured on the HMI device.

Proceed as follows:

Procedure
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Result

On the configuring PC, select the "Communication settings" command from the
"Projekt > Transfer" menu in WinCC flexible.

The "Communication Settings" dialog opens.

Select the type of HMI device.

Select the type of connection between the HMI device and the configuring PC.

Set the connection parameters.

Close the dialog with "OK".

In WinCC flexible, select the command "OS Update" from the "Projekt > Transfer" menu.

In "Image path", select the HMI device image file ".img".

The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation CD.

In the output area, you are provided information on the version of the HMI device image
file after it is opened.

Switch into "Transfer" mode on the HMI device.

If you have activated automatic transfer mode for the HMI device, the device
automatically switches to "Transfer" mode when an update is initiated.

In WinCC flexible, select "Update OS" on the configuring PC to run the operating
system update.

Follow the instructions in WinCC flexible.

During the operating system update a status view opens to indicate progress.

A message is displayed when the operating system update is successfully completed.

This operation has deleted the project data from the HMI device.
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7.74 Updating the operating system using ProSave

Requirements
® The HMI device is connected to a PC on which ProSave is installed.

® The data channel is configured on the HMI device.

Procedure
Proceed as follows:
1. From the Windows Start menu, start ProSave on the PC.
2. Select the HMI device type in the "General" tab.
3. Select the type of connection between the HMI device and the PC.
4. Set the connection parameters.
5. Select the "OS Update" tab.
6. In "Image path", select the HMI device image file "*.img".
The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation CD.
In the output area, you are provided information on the version of the HMI device image
file after it is opened.
7. Switch into "Transfer" mode on the HMI device.
If you have activated automatic transfer mode for the HMI device, the device
automatically switches to "Transfer" mode when an update is initiated.
8. Select "Update OS" n the PC to run the operating system update.
9. Follow the instructions in ProSave.
During the operating system update a status view opens to indicate progress.
Result

A message is displayed when the operating system update is successfully completed.

This operation has deleted the project data from the HMI device.

MP 377, MP 377 PRO (WinCC flexible)
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7.75 Resetting to factory settings with WinCC flexible

Requirements
® No project is open on the configuring PC in WinCC flexible.
® The HMI device is connected to this configuration PC over the standard Ethernet cable.
® Have the MAC address of the Ethernet interface on your HMI device to hand.
— The MAC address is displayed briefly when the HMI device is turned on.
— The MAC address is displayed in the "PROFINET" dialog in the Control Panel.

Procedure - Setting the PC interface
1. Select "Start > Control Panel > Set PG / PC interface" on the configuration PC.
2. Select "STONLINE (STEP7) -> TCP / IP" from the "Application access point" area.

3. Select the interface which is connected to the HMI device from the "Interface
parameterization used" area.

4. Confirm your entries.
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Procedure - Restoring factory settings

178

Proceed as follows:

1.

On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

Select the HMI device type from the "General" tab, and select "Ethernet" from the
"Connection" area.

3. Enter an IP address.

Note
Possible address conflicts with incorrect IP address

Do not use a dynamic IP configuration for "Reset to factory settings".

Specify a unique IP address in which the configuration PC is located. For the duration of
the update process, the HMI device is automatically assigned to the specified address.

If the HMI device has already been used with WinCC flexible or ProSave you can use the
existing IP address for "Reset to factory settings.”

{8 Select devices for transfer

| [ Device_ 1 [Operator Panel]|  Settings for Device 1

Transfer to
(3 Flash ) Rt
Mode " Delta transfer
®0n O oi

Computer nane

S 1 2168110 [[] Enable back transfer

Owernwrite pazsword list

Ovenarite recipe data records

Tranzfer | | Apply | | Cancel

Confirm your entries.
In WinCC flexible, select the command "Update OS" in the "Project > Transfer" menu.
Activate the "Reset to factory settings" check box.

A text box opens where you can enter the MAC address.

Enter the HMI device's MAC address in the text box.

In "Image path", select the HMI device image file "*.img

The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation CD.

In the output area, you are provided information on the version of the HMI device image
file after it is opened.
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9. In WinCC flexible, select "Update OS" on the configuring PC to run the operating
system update.

10. In the Control Panel of the HMI device, open the "OP Properties" dialog and select the
"Device" tab.

11. Click on the "Reboot" button.
A query is opened.
12. Click on the "Prepare for Reset" button.
13. On the configuration PC, follow the instructions in WinCC flexible.

During the operating system update a status view opens to indicate progress.

Result
A message is displayed when the operating system update is successfully completed.

This operation has deleted the project data from the HMI device. The factory settings
are reset.

Note

If you can no longer call the Control Panel on the HMI device, as the operating system is
missing, switch off the HMI device. Then reset to factory settings and restart the HMI device.

If the HMI device doesn’t start up, switch it off and then on again.

Note
Calibrating the touch screen

After the reset, you may have to recalibrate the touch screen.
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7.7.6 Resetting to factory settings with ProSave

Requirement

o The HMI device is connected over the Ethernet to a PC on which ProSave is installed.

Have the MAC address of the Ethernet interface on your HMI device to hand.

— The MAC address is displayed briefly when the HMI device is turned on.
— The MAC address is displayed in the "PROFINET" dialog in the Control Panel.

Procedure - Setting the PC interface

1.
2.
3.

Select "Start > Control Panel > Set PG / PC interface" on the configuration PC.
Select "STONLINE (STEP7) -> TCP / IP" from the "Application access point" area.

Select the interface which is connected to the HMI device from the "Interface
parameterization used" area.

Confirm your entries.

Procedure - Restoring factory settings
Proceed as follows:

1.

From the Windows Start menu, start ProSave on the PC.

2. Select the HMI device type from the "General" tab, and select "Ethernet" from
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the Connection area.

Enter an IP address.

Note
Possible address conflicts with incorrect IP address
Do not use a dynamic IP configuration for "Reset to factory settings".

Specify a unique IP address of the subnet in which the configuration PC is located. For
the duration of the update process, the HMI device is automatically assigned to the
specified address of ProSave.

If the HMI device has already been used with WinCC flexible or ProSave you can use the
existing IP address for "Reset to factory settings.”
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7.7 Updating the operating system

* « SIMATIC ProSave
File Language Help

|] Backup] Hestu:ure] Dptiu:uns] 05 Update]

Device type

|[Operatu:ur Panel] LJ

Connection

| Ethernet ﬂ

Connection parameters-

* [P address " Computer name

192 168 . 1 . 10

Completed Ethernet
Change to the "OS Update" tab.

Activate the "Reset to factory settings" check box.

A text box opens where you can enter the MAC address.
Enter the HMI device's MAC address in the text box.
In "Image path", select the HMI device image file "*.img".

The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation CD.

In the output area, you are provided information on the version of the HMI device image
file after it is opened.

Select "Update OS" on the PC to start the "Reset to factory settings" process.

In the Control Panel of the HMI device, open the "OP Properties" dialog and select
the "Device" tab.

10. Click on the "Reboot" button.

A query is opened.
11. Click on the "Prepare for Reset" button.
12. Follow the instructions in ProSave.

During the operating system update a status view opens to indicate progress.
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Result
A message is displayed when the operating system update is successfully completed.

This operation has deleted the project data from the HMI device. The factory settings
are reset.

Note

If you can no longer call the Control Panel on the HMI device, as the operating system is
missing, switch off the HMI device. Then reset to factory settings and restart the HMI device.

If the HMI device doesn’t start up, switch it off and then on again.

Note
Calibrating the touch screen

After the reset, you may have to recalibrate the touch screen.

7.8 Installing and removing options

7.8.1 Overview

Installing and removing options

You can install options on the HMI device, for example, additional programs developed
especially for the HMI device.

You can also remove the option from the HMI device again.

Note
License key

A license key may be needed to run an option. The license key unlocks the option for use.
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7.8.2 Installing and removing options using WinCC flexible

Requirements

No project is open on the configuring PC in WinCC flexible.
The HMI device is connected to this configuring PC.

The data channel is configured on the HMI device.

Procedure for installing an option
Proceed as follows:

1.

On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

2. Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuring PC, then set

N o o &

Result

the connection parameters.

Close the dialog with "OK".

Select the "Options" command in the menu "Project > Transfer" in WinCC flexible.
Select the desired option under "Available options".

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the installation of an option is initiated.

Start the installation of the option in WinCC flexible on the configuring PC with
the ">>" button.

Follow the instructions in WinCC flexible.

A status display appears indicating the progress of the installation.

The option has now been installed on the HMI device.
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Procedure for removing an option
Proceed as follows:

1. On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.
2. Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuring PC, then set
the connection parameters.

Close the dialog with "OK".
Select the "Options" command in the menu "Project > Transfer" in WinCC flexible.
Press the "Device status" button to update the display.

Select the desired option under "Installed options".

© N o o &

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the removal of an option is initiated.

9. Start the removal of the option in WinCC flexible on the configuring PC with
the "<<" button.

Follow the instructions in WinCC flexible.

A status display appears indicating the progress of the removal.

Result
The option has now been removed on the HMI device.
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7.8 Installing and removing opfions

7.8.3 Installing and removing options using ProSave

Requirements

The HMI device is connected to a PC on which ProSave is installed.

The data channel is configured on the HMI device.

Procedure for installing an option

Proceed as follows:

1.
2.
3.

From the Windows Start menu, start ProSave on the PC.
Select the HMI device type in the "General" tab.

Select the type of connection between the HMI device and the PC, then set the
connection parameters.

4. Select the "Options" tab.

5. Select the desired option under "Available options".

Result

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the installation of an option is initiated.

Start the installation of the option in ProSave with the ">>" button.
Follow the instructions in ProSave.

A status display appears indicating the progress of the installation.

The option has now been installed on the HMI device.
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Procedure for removing an option
Proceed as follows:
1. From the Windows Start menu, start ProSave on the PC.
2. Select the HMI device type in the "General" tab.

3. Select the type of connection between the HMI device and the PC, then set the
connection parameters.

Select the "Options" tab.
Press the "Device status" button to update the display.

Select the desired option under "Installed options".

N o o &

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the removal of an option is initiated.

8. Start the removal of the option in ProSave with the "<<" button.
Follow the instructions in ProSave.

A status display appears indicating the progress of the removal.

Result

The option has now been removed on the HMI device.
7.9 Transferring and transferring back license keys
7.91 Overview

Transferring and transferring back license keys

With the purchase of an optional package, you obtain a specific user license with an
associated license key. Once you have installed an option, transfer a license key to the
HMI device. The license key unlocks an option for use.

You can also transfer back the license key from the HMI device to the storage location.

Note
You only transfer license keys with the Automation License Manager or WinCC flexible.

MP 377, MP 377 PRO (WinCC flexible)
186 Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO



Commissioning a project

7.9 Transferring and transferring back license keys

7.9.2 Transferring and transferring back license keys

Requirements

When transferring or transferring back using WinCC flexible:
No project is open on the configuring PC in WinCC flexible.
The HMI device is connected to this configuring PC.

The data channel is configured on the HMI device.

The storage location and the license key awaiting transfer are ready.

Procedure for transferring a license key

Proceed as follows:

1.
2.

N o o &

Result

Switch to "Transfer" mode on the HMI device.
When transferring using WinCC flexible:

Select the "License Keys" command in the menu "Project > Transfer".
The Automation License Manager opens.

When transferring using the Automation License Manager:
Start the Automation License Manager via the Windows Start menu.

In the Automation License Manager, select the command "Connect HMI device" in the
menu "Edit > Connect target system".

The "Connect Target System" dialog opens.

Under "Device Type", select the appropriate HMI device type.
Select the type of connection from the "Connection" box.

Set the connection parameters.

Select "OK".

The connection to the HMI device is established. The connected HMI device is displayed
in the left window of the Automation License Manager.

In the left window, select the source drive.
The right window displays the available license keys.

Drag one or more license keys from the right window and drop them on the HMI device in
the left window.

The license keys are then transferred to the HMI device.

The license key is transferred from the storage location to the HMI device.
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7.9 Transferring and transferring back license keys

Procedure for transferring a license key back
Proceed as follows:

Result

188

1.
2.

N o o »~

Switch to "Transfer" mode on the HMI device.
When transferring back using WinCC flexible:

Select the "License Keys" command in the menu "Project > Transfer".
The Automation License Manager opens.

When transferring back using the Automation License Manager:
Start the Automation License Manager via the Windows Start menu.

In the Automation License Manager, select the command "Connect HMI device" in the
menu "Edit > Connect target system".

The "Connect Target System" dialog opens.

Under "Device Type", select the appropriate HMI device type.
Select the type of connection from the "Connection" box.

Set the connection parameters.

Select "OK".

The connection to the HMI device is established. The connected HMI device is displayed
in the left window of the Automation License Manager.

In the left window, select the HMI device.
The right window displays the available license keys.

Drag one or more license keys from the right window and drop them on the destination
drive in the left window.

The license keys are transferred back to the storage location.

The license key is transferred back from the HMI device to the storage location.
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8.1

Overview

Configuration and process control phase

HMI devices can be used to operate and monitor tasks in process and production
automation. The plant screens on the HMI devices are used to provide a clear overview
of the active processes.

The HMI device project, which includes the plant screens, is created during the configuration
phase. The configuration engineer defines which tasks the HMI device has in the process
and defines the following in detail:

e \Which process data is displayed on the individual HMI device
e \Which plant components are controlled by this HMI device

The configuration engineer stores this information in the project's screens. The project is
transferred to the HMI device during commissioning.

After transfer to the HMI device, current processes can be operated and monitored in the
project's screens. The screens enable you to observe, for example, operational states,
current process data and faults in a plant. Operating elements which are used to operate the
process, for example buttons, I/O fields and alarm windows, are displayed in the screens.

Operator input options

The hardware of the HMI device determines which of the following operator control options
are available:

® Touch screen

The operating elements shown in the dialogs are touch-sensitive. Touch objects are
basically operated in the same way as mechanical keys. You activate operating elements
by touching them with your finger. To double-click them, touch an operating element
twice in succession.

o HMI device keyboard

The operating elements shown in the screens are selected and operated using the keys
of the HMI device.

e External keyboard, connected via USB

® External mouse, connected via USB

A\cauTion

Do not use any pointed or sharp objects when operating the touch screen. Otherwise
this may damage the plastic membrane of the touch screen.

The following provides instructions for operating a project with the touch screen
and the keyboard.
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8.1 Overview

Operating a project with an external keyboard

An external keyboard can be used to operate a project in exactly the same way as with the
HMI keyboard or screen keyboard.

Note

The function keys of the external keyboard are disabled.

Use the other keys of the external keyboard, which correspond to the HMI device keys
in the description.

Operating a project with an external mouse

An external mouse can be used to operate a project in exactly the same way as with the
HMI touch screen. Click the described operating elements with the mouse.

Unintentional actions

A\ crution

Do not carry out several operations simultaneously. You may otherwise trigger
unintentional actions.

e With touch control:

Always touch only one operating element on the screen
e With key control:

Do not press more than two keys simultaneously

Observing the plant documentation

Some operations with the project may require in-depth knowledge about the specific plant on
the part of the operator. Proceed with caution, for example, when you use jog mode. Further
information on this may be available in your plant documentation.

Operation feedback from operating elements

The HMI device provides operation feedback as soon as it detects that an operating element
has been selected. This operation feedback is independent of any communication with the
PLC. Therefore, this operation feedback does not indicate whether the relevant action is
actually executed or not.
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8.1 Overview

Optical feedback from operating elements

The operating element receives the focus and is selected. The configuration engineer can
also configure the selection of an operating element so that it deviates from the standard.
Further information on this may be available in your plant documentation.

The type of optical feedback depends on the operating element:
e Buttons

The HMI device outputs different views of the "Pressed" and "Unpressed" states,
provided the configuration engineer has configured a 3D effect:

"Pressed" state:

"Unpressed" state:

The configuration engineer determines the appearance of a selected field, for example,
line width and color for the focus.

® |nvisible buttons

By default, invisible buttons are not displayed as pressed when they are touched.
No optical operation feedback is provided in this case.

The configuration engineer may, however, configure invisible buttons so that their outline
appears as lines when touched. This outline remains visible until you select another
operating element.

e |/O fields

When you select an I/O field, the content of the 1/O field is displayed against a colored
background. With touch operation, a screen keyboard is displayed for the entering
of values.

Acoustic feedback from operating elements

As soon as the HMI device detects a touch of the touch screen or that a key has been
pressed, an acoustic signal is issued. You can activate or deactivate this acoustic
operation feedback.

Note

The acoustic feedback is only possible if you interact with the project directly on the touch
screen or press one of the keys of the HMI device. If you use an external mouse or keyboard
for interaction, no acoustic signal is issued.

Acoustic signal for inadvertent operations

If you try to enter an invalid character, the HMI device issues an acoustic signal in
accordance with the setting.
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8.2 Direct keys

8.2 Direct keys

Introduction
Direct keys on the HMI device are used to set bits in the 1/0 area of a SIMATIC S7.

Direct keys enable operations with short reaction times that are, for example,
a jog mode requirement.

NOTICE

Direct keys are still active when the HMI device is in "offline" mode.

NOTICE

If you operate a function key with direct key functionality in a running project, the direct key
function is always executed, independent of the current screen contents.

Note

You can only use direct keys when there is a connection via PROFIBUS DP or
PROFINET IO.

Direct keys result in additional basic load on the HMI device.

Direct keys
The following objects can be configured as a direct key:
e Buttons

® Function keys
You can also define image numbers in the case of HMI devices with touch operation. In this
way, the project engineer can configure the direct keys on an image-specific basis.

Further information on configuring direct keys can be found in the
"WinCC flexible Communication" system manual.
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8.3 Setting the project language

Introduction

The HMI device supports multilingual projects. You must have configured a corresponding
operating element which lets you change the language setting on the HMI device
during runtime.

The project always starts with the language set in the previous session.

Requirements
® The required language for the project must be available on the HMI device.

® The language switching function must be logically linked to a configured operating
element such as a button.

Selecting a language

You can change project languages at any time. Language-specific objects are immediately
output to the screen in the new language when you switch languages.

The following options are available for switching the language:
® A configured operating element switches from one language to the next in a list
® A configured operating element directly sets the desired language

Further information on this may be available in your plant documentation

8.4 Entries using the touch screen

8.4.1 Overview

Screen keyboard

When you touch an operating element requiring entry on the HMI device touch screen,
a screen keyboard appears. The screen keyboard is displayed in the following cases:

® An |/O field is selected for input
e A password must be entered for accessing a password-protected function
The screen keyboard is automatically hidden again when input is complete.

Based on the configuration of the operating element, the system displays different screen
keyboards for entering numerical or alphanumerical values.

Note

The screen keyboard display is independent of the configured project language.
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8.4 Entries using the fouch screen

General procedure
The operating elements of a screen are operated by touching the touch screen.
Proceed as follows:
1. Touch the desired operating element within the screen.

2. Depending on the operating element, perform further actions. Detailed descriptions can
be found under the respective operating element.

Examples:
— /O field: Enter numerical, alphanumeric or symbolic values in the 1/O field
— Symbolic I/O field: Select an entry from the drop down list box

— Slider control: Move the slider control

Procedure for text boxes

Values are entered in the project text boxes. Based on your configuration, the values are
saved to tags and transferred, for example, to the PLC.

Proceed as follows:
1. Touch the desired text box within the screen.
The screen keyboard opens.

Depending on your configuration, you can enter values in the text box in
the following manner:

— Numerical values, for example decimal numbers, hexadecimal numbers, binary values
— Alphanumerical values, for example digits and letters
— Date/time

2. Enter the value.

3. Confirm your entry with 4|"E or discard your entry with the button ﬂl
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8.4 Entries using the fouch screen
8.4.2 Entering and editing numerical values

Numerical screen keyboard

When you touch an operating element for numerical input on the HMI-device touch screen,
the numerical screen keyboard appears. This is the case, for example, for a text box. The
screen keyboard is automatically hidden again when input is complete.

7| 8| 9|« [FE=Ix

4 6 Cel | Ins
1 3 <J |Num Help

U . |Esc| |

N |on o

Note
Opened screen keyboard

PLC job 51 "Select screen" has no effect while the screen keyboard is open.

Formats for numerical values
You can enter values in numerical text boxes based on the following formats:
® Decimal
® Binary

® Hexadecimal

Note
Entry of hexadecimal values

When you enter values in hexadecimal format, the alphanumerical screen
keyboard opens.

Checking numerical value limits

Tags can be assigned limit values. If you enter a value that lies outside of this limit, it will not
be accepted, for example, 80 with a limit value of 78. In this case the HMI device will deliver
a system alarm, if an alarm window is configured. The original value is displayed again.

Decimal places of numerical values

The configuration engineer can define the number of decimal places for a numerical text box.
The number of decimal places is checked when you enter a value in this type of I/O field.

® Decimal places in excess of the limit are ignored

® Empty decimal places are filled with "0"
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Procedure

Numerical values can be entered character-by-character via the buttons on the numerical
screen keyboard.

Proceed as follows:
1. Touch the desired operator control on the screen.

The numerical screen keyboard opens. The existing value is displayed in the screen
keyboard and is selected.

2. Enter the value.

The keys with for example the letters G to Z are available to enter a hexadecimal value;
however, the characters are not entered. Depending on the settings, the HMI device
outputs an audible signal.

You have the following options to enter a value:

— The selected value is deleted when you enter the first character. Completely reenter
the value.

— Use the :l and il keys to move the cursor within the current value. You can

now edit the characters of the current value or add characters.

Use the == | key to delete the character to the left of the cursor. If the value is

selected, use this key to delete the selected part of the value.

The Del | key deletes the character positioned to the right of the cursor. If the value is

selected, use this key to delete the selected part of the value.

— Use the ﬂl key to display the infotext of the /O field.

This key is only enabled if infotext has been configured for the input object or the
current screen.

3. Use the 4|"E key to confirm your entry or cancel it with ESC | Either action closes

the screen keyboard.

Result

You have changed the numerical value or entered a new one.
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8.4.3 Entering and editing alphanumerical values

Alphanumerical screen keyboard

When you touch an operating element for alphanumerical input on the HMI-device touch
screen, the alphanumerical screen keyboard appears. This is the case, for example, for a
text box. The screen keyboard is automatically hidden again when input is complete.

“T1lz2[3]as]e[7]elo]o]-[=]«— [E  _Ix]

—quertyuiop[]JInsHomEI;'

¢ |a|s|d|f|lg|h|ji|k|I|:]" |\ pel | End |
t(\|z|x|c|v|b|n|m|,|.|[f| © |&c| mm| 4 |Help
I E: | acer | B ow | ¥ |
Note

Opened screen keyboard

PLC job 51 "Select screen" has no effect while the screen keyboard is open.
Language change

Language change in the project has no influence on the alphanumerical screen keyboard.
This means you cannot enter Cyrillic or Asian characters.

Keyboard levels
The alphanumerical screen keyboard has various levels.
e Normal level
e Shift level

If you change the levels with key = | the key assignments change.
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Procedure

Alphanumerical values can be entered character-by-character via the buttons on the
alphanumerical screen keyboard.

Proceed as follows:
1. Touch the desired operator control on the screen.

The alphanumerical screen keyboard opens. The existing value is displayed in the screen
keyboard and is selected.

2. Enter the value.
You have the following options to enter a value:

— The selected value is deleted when you enter the first character. Completely reenter
the value.

— Use the il and il keys to move the cursor within the current value. You can

now edit the characters of the current value or add characters.

Use the = | key to delete the character to the left of the cursor. If the value is

selected, use this key to delete the selected part of the value.

The el | key deletes the character positioned to the right of the cursor. If the value is

selected, use this key to delete the selected part of the value.

- Usingkey % | it is possible to switch between the keyboard levels of the screen
keyboard. On switchover, the key assignments of the screen keyboard change.

— Use the ﬂl key to display the infotext of the 1/O field.

This key is only enabled if infotext has been configured for the input object or the
current screen.

3. Use the 4|'E key to confirm your entry or cancel it with ESC| Either action closes the

screen keyboard.

Result

You have changed the alphanumeric value or entered a new one.
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844 Entering the date and time

Entering the date and time
Enter the date and time in the same way you enter alphanumerical values.

Note

When entering the date and time, please note that the format is determined by the
configured project language.

8.45 Entering symbolic values

Drop down list

Operating elements for entering symbolic values offer you a list from which you can select
the input values. When you touch a symbolic I/O field on the HMI device touch screen, the
following drop down list opens.

Procedure
Proceed as follows:

1. Touch the required operating element.
The drop down list of the operating element opens. Select =l and 2l to scroll in the drop
down list.

2. Touch the required entry in the drop down list.

The selected entry is accepted as an entry.

Result
You have changed the symbolic value or entered a new one.
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8.4.6 Displaying infotext

Purpose

The configuration engineer uses infotext to provide additional information and operating
instructions. The configuration engineer can configure infotext on screens and operating
elements.

The infotext of an I/O field may contain, for example, information on the value to be entered.

Info text x|

Enter termperature setpoint for Tank_1
{Range 40...80 °C)

Opening infotext for operating elements
1. Touch the required operating element.

The screen keyboard opens. You can see from the appearance of the HE'Pl key whether

infotext has been configured for the operating element or the current screen.

2. Touch the ﬂl key on the screen keyboard.

The infotext for the operating element is displayed. If there is no infotext for the selected
screen object, the infotext for the current screen is displayed, if it has been configured.

You can scroll through the contents of long infotext with =] and =1,

Note
Switching between displayed infotext

The configuration engineer can configure infotext for an 1/O field and the associated
screen. You can switch between two infotexts by touching the infotext window.

3. Close the displayed infotext by pressing .

Alternative procedure

Depending on your configuration, infotext can also be called via a configured
operating element.

Refer to your plant documentation to find any additional information on this topic.
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8.5 Entries using the keys

8.5.1 Control keys

Introduction

The following tables show the control keys with which you operate the project. You will also
find detailed descriptions under the individual operating elements.

Select operating elements

Key Functions Description

Tabulator Selects the next/previous operating element in the

TAB
tab sequence.

SHFT
+

Cursor keys Selects the next operating element to the left, right,
IE' above or below the current screen object.

> [4]

Iz' Navigates in the operating element.

Using operating elements

A

ey Functions Description

Position the cursor Positions the cursor within an operating element,
for example in the I/O field.

+

+

<MY

Scroll back Scrolls back a page in a list.

. HO:ME Scroll to the beginning Scrolls to the beginning of a list.
Scroll forward Scrolls one page forward in a list.
Scroll to the end Scrolls to the end of a list.

i I %] %} %) %}
n = n Opp I I s I
= S =z = T T ! T
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+

+
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H
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Key Functions Description
Enter key e Operates buttons.
e Accepts and ends an entry.
e Opens a drop down list box.
e Toggles within a text box between character
mode and normal mode.
In character mode, a single character is
selected. In this mode, you can advance in the
character set using the cursor keys.
Cancel e Deletes the characters of a value entry and

restores the original value.
¢ Closes the active dialog.

INS
DEL

Delete characters

Deletes the character to the right of the current
cursor position.

Delete characters

Deletes the character to the left of the current
cursor position.

+

Open drop down list box

Opens a drop down list box.

2
EH“.
2 o

ENTER

I

Accept value

Accepts the selected value in the drop down list
box without closing the list.

Enter key combinations

202

Key

Functions

Purpose

74

ﬂ

Toggle key assignment

Switches over key assignment of keys with
multiple assignment.

e No LEDis lit:
The number assignment is enabled. Pressing
the button once toggles to letter assignment.
e AnLEDislit

The left or right letter assignment is enabled.

Each time the key is pressed, the system toggles
between the left letter assignment, the right letter
assignment and the number assignment.

Toggle between upper-case
and lower-case

Used in key combinations, for example for entering
upper-case letters.

[%)
l I
=z l
i

Switch to additional
key assignment

Some of the keys contain a blue imprinted key
assignment , for example the "%" character.

Used in key combinations for the blue
key assignment.

General control function

Used in key combinations

General control function

Used in key combinations

MP 377, MP 377 PRO (WinCC flexible)
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Acknowledge alarms

8.5 Entries using the keys

Key Functions

Description

Acknowledge

Acknowledges the currently displayed fault
alarm or all the alarms of an alarm group as
group acknowledgment.

The LED lights up as long as unacknowledged fault
alarms are active.

Displaying infotext

Key Functions

Description

Displaying infotext

Opens a window with the configured infotext at the
selected object, for example alarm or /O field. If an
infotext exists for the selected object, the LED
lights up.

Multi-key operation

Unwanted actions may be triggered, if the operator unintentionally actuates a

key combination.

A\ caution

Unintentional actions

actions in the plant.

In "Online" mode, simultaneous operation of more than two keys may cause unintentional

Never press more than two keys simultaneously.

MP 377, MP 377 PRO (WinCC flexible)
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8.5 Entries using the keys

8.5.2

8.5.3

Function keys

Example: enter characters using the alphanumeric keyboard

Using the same keys of the alphanumeric keyboard you can enter up to six different
characters. The entry result depends on the combination of the keys pressed.

The values "5", "M", "m", "N", "n" and "%" are entered using the same key of

the keyboard. You can use the keys , and to switch between the

different assignments.

The following table shows the entry options using the key .

Key Key Key Result
No LED is lit Not relevant Not pressed 5
Left LED is illuminated. Not pressed Not pressed m
Left LED is illuminated. Pressed Not pressed M
Right LED is illuminated. Not pressed Not pressed n
Right LED is illuminated. Pressed Not pressed N
Not relevant Not relevant Pressed %

Function keys

Function key assignment is defined during configuration. The configuration engineer can
assign function keys globally and locally.

Function keys with global function assignment

A globally assigned function key always triggers the same action on the HMI device or in
the PLC irrespective of the screen displayed. Such an action could be, for example,
the activation of a screen or the closure of an alarm window.

Function keys with local function assignment

204

A function key with local function assignment is screen-specific and is therefore only
effective within the active screen.

The function assigned locally to a function key can vary from screen to screen.

The function key of a screen can be assigned one function only, either a global or local one.
The local assignment function takes priority over the global setting.

The configuration engineer can assign function keys in such a way that you can operate
operating elements with function keys, for example, the alarm view, trend view, recipe view
or Status Force.

MP 377, MP 377 PRO (WinCC flexible)
Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO



Operating a project
8.5 Entries using the keys

8.54 General procedures

Introduction
The control keys and function keys of the HMI device are available for key control

General procedure
The operating elements of a screen are operated using the control keys of the HMI device.

Proceed as follows:

1. Continue to press the key or the cursor keys until the required operating element is

selected on the screen.

2. Depending on the operating element, perform further actions. Detailed descriptions can
be found under the respective operating element.

Examples:
— 1/O field: Enter numerical, alphanumeric or symbolic values in the 1/O field

— Slider control: Move the slider control

3. Confirm the operation with the key or abort the operation with the key .

8.5.5 Entering and editing numerical values

Formats for numerical values
You can enter values in numerical text boxes based on the following formats:
® Decimal
® Hexadecimal

® Binary

Limit value test of numerical values

Tags can be assigned limit values. If you enter a value that lies outside of this limit, it will not
be accepted, for example, 80 with a limit value of 78. In this case the HMI device will deliver
a system alarm, if an alarm window is configured. The original value is displayed again.

MP 377, MP 377 PRO (WinCC flexible)
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8.5 Entries using the keys

Procedure

Numerical and alphanumerical values can be entered in character mode using
the system keys.

Proceed as follows:

. Select the desired text box within the screen with .
The existing value is selected in the text box.

. Enter the value using the numerical keypad.
You have the following options to enter a value:

— The existing value is deleted when you enter the first character. Completely reenter

the value.

Press and a cursor key simultaneously. The selection of the field content is
canceled. Move the cursor in the existing value. You can now edit the characters of

the current value or add characters.

INS
The key deletes the character positioned to the right of the cursor. Use the
key to delete the character to the left of the cursor.

To enter the hexadecimal characters "A" to "F", switch the numerical keypad to letter

assignment using the key .

If the LED of the key is lit, infotext is available for the selected object or the

current screen.

Use the key to display the infotext for the operating element or current screen.

3. Select to confirm your entry.

Result

You have changed the numerical value or entered a new one.
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8.5 Entries using the keys

8.5.6 Entering and editing alphanumerical values

Procedure

Alphanumerical values can be entered in character mode using the system keys.
Proceed as follows:

1. Select the desired text box within the screen with .

The existing value is selected in the text box.
2. Enter the value using the system keys.
You have the following options to enter a value:

— The existing value is deleted when you enter the first character. Completely reenter
the value.

— Press and a cursor key simultaneously. The selection of the field content is
canceled. Move the cursor in the existing value. You can now edit the characters of

the current value or add characters.

INS
The key deletes the character positioned to the right of the cursor. Use the
key to delete the character to the left of the cursor.

To enter letters, switch the numerical keypad to letter assignment using the key .

— Ifthe LED of the key is lit, infotext is available for the selected object or the
current screen.

Use the key to display the infotext for the operating element or current screen.

3. Select to confirm your entry.

Result

You have changed the alphanumeric value or entered a new one.
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8.5 Entries using the keys

8.5.7 Entering the date and time

Entering the date and time

Enter the date and time in the same way you enter alphanumerical values.

Note

When entering the date and time, please note that the format is determined by the
configured project language.

8.5.8 Entering symbolic values

Drop down list

Procedure

Result

208

When you select a symbolic I/O field, a drop down list opens.

Symbolic values are selected from the entries of a drop down list.

Proceed as follows:

1. Select the desired symbolic text box within the screen with .
2. Open the drop down list using the key . The drop down list opens.
3. Select the required entry using the cursor keys IZI E or IEI

4. Select to confirm your entry.

You have changed the symbolic value or entered a new one.

MP 377, MP 377 PRO (WinCC flexible)
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8.5 Entries using the keys

8.5.9 Displaying infotext

Purpose
The configuration engineer uses infotext to provide additional information and
operating instructions. The configuration engineer can configure infotext on screens
and operating elements.
The infotext of an I/O field may contain, for example, information on the value to be entered.
Enter ternperature setpoint for Tank_1
(Range 40...80 =C)
If the LED of the key lights up, an infotext has been configured for the selected display
object or for the current screen.
Procedure

1. Press .

The infotext for the selected screen object is displayed. If there is no infotext for
the selected screen object, the infotext for the current screen is displayed, if it
has been configured.

You can scroll through the contents of long infotexts using the cursor keys E and IZI

Note
Switching between displayed infotext

The configuration engineer can configure infotext for an I/O field and the associated

screen. You can switch between two infotexts by pressing the key .

2. Close the infotext by pressing key .

Alternative procedure

Depending on your configuration, infotext can also be called via a function key or via an
existing operating element.

Refer to your plant documentation to find any additional information on this topic.
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8.6 Bar and gauge

8.6 Bar and gauge

Bar

Layout

Gauge

Layout

Operation
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The bar is a dynamic display object. The bar displays a value from the PLC as a
rectangular area. The bar allows you to recognize the following at a glance:

® The distance of the current value from the configured limit values
e \Whether a set point value has been reached

The bar can display values such as fill levels or batch counts.

100

&0
30
0

The layout of the bar depends on the configuration:
® The bar may feature a scale of values
® The configured limit values can be indicated by lines

® (Color changes can signal when a limit value has been exceeded or has not been reached

The gauge is a dynamic display object. The gauge displays numeric values in analog form
by means of a pointer. This enables an operator at the HMI device to see at a glance if the
boiler pressure is in the normal range, for example.

The layout of the gauge depends on the configuration:

® A trailing pointer can display the maximum value reached so far on the scale. The trailing
pointer is reset when the screen is reloaded

® The label on the scale can show the measured variable, for example boiler pressure and
the physical unit, for example bar

The bar and the gauge are for display only. Both objects cannot be controlled
by the operator.

MP 377, MP 377 PRO (WinCC flexible)
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8.7 Operating the swifch

8.7 Operating the switch

Introduction
The switch is an operating element and display object with two predefined switching states,
for example "On" and "Off". Switches can signalize the state of a plant section, for example if
a motor is running or not. At the same time, you can use the switch to change the state of
the corresponding plant section via the HMI device, for example from "On" to "Off".

Layout

The layout of the switch depends on the configuration:
® Switch with slider

The two states are displayed by the position of the slider

Switch

©) Slider
e Switch with text or graphic
The two states are displayed by the label on the slider

Depending on the switching state, the switch is labeled with one of two texts or
one of two graphics.

Examples:

"Backward" or "Forward"

.............. | or [

Procedure using the touch screen
e Switch with slider
Proceed as follows:
Move the slider to the other position or double-click the slider area
® Switch with text or graphic
Proceed as follows:

Touch the switch

Procedure using the keys
Proceed as follows:

1. Select the desired switch within the screen with .

2. Press .

Result
The switch changes its appearance. The associated value is switched.
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8.8 Operating the trend view

8.8 Operating the trend view

Trends
Trends continuously display the current process data or process data from a log.

Trend view

Trends are displayed in the trend view. A trend view can display several
trends simultaneously.

1007]
O,

D_I , 1

| W« | »| @a| al|le| @] % —0
Trend Tag assignment Value Date/time A
Pressure Pressure pattern 25( 31.01.2006 13:06:34 w

|

@ Ruler

@ Buttons for trend operation
©] Trend value in the value table

Layout and operation

The layout and operation of the trend view depends on the configuration. The configuration
engineer determines, for example, the following:

® Appearance of the trend view, the axes, value ranges and labels

® Operating options of the trend view

Limit values for the trend values
® The change of color of the trend in the event of limit violation

Refer to your plant documentation to find any additional information on this topic.

MP 377, MP 377 PRO (WinCC flexible)
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Value table

Ruler

Operation

MP 377, MP 377 PRO (WinCC flexible)

8.8 Operating the trend view

The trend values can be read from the value table if this is configured:

e \When the ruler is displayed, the trend values are shown at a position of the ruler in the
value table

® When the ruler is hidden, the latest trend values are displayed in the value table

When configured, a ruler is available to provide an exact reading of the trend values in the

value table.

You can move the ruler to the desired position of the trend view.

The trend view can be operated as follows:

Move the ruler

Hide and display the ruler

Enlarge or reduce the time interval displayed
Scroll forward or back by one display width

Stop and resume trend recording

The following table shows the trend view buttons:

Key combination

Function

Stops or continues trend recording.

Y z
[

Enlarges the displayed time section.

o

Reduces the displayed time section.

Scrolls one display width backwards (to the left)

Scrolls one display width forwards (to the right)

Scrolls back to the beginning of the trend recording. The start
values of the trend recording are displayed there.

Moves the ruler backwards (to the left)

Moves the ruler forwards (to the right)

e o

-
in
-

Shows or hides the ruler.

In addition, the configuration engineer can configure function keys or operating elements

with which you can control trend views.

Refer to your plant documentation to find any additional information on this topic.

Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO
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8.9 Operating the slider contro/

Touch operation
Touch the required button in the trend view.

The position of the ruler can also be changed by means of touching and dragging the ruler
on the touch screen.

Procedure using the keys
Proceed as follows:

1. Using the key select the desired button within the trend view.

2. Confirm your entry by pressing the key ,

8.9 Operating the slider control

Introduction

The slider control can be used to monitor and change process values within a defined range.
The slider control can also be configured without a slider. In this case, you cannot enter a
value. The slider control is then only used for displaying values.

SIMATIC

100 =

s0———2)

@ Slider control for entering values

® Value display with current value

Layout
The layout of the slider control depends on the configuration:
® The slider control can contain a label and a setting range

® The current value can be displayed below the area of the slider control

MP 377, MP 377 PRO (WinCC flexible)
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8.9 Operating the slider control

Procedure using the touch screen
Proceed as follows:
1. Touch the slider of the desired slider control.
2. Move the slider to the required value.
If a value display has been configured, you can check the exact value that has been set.

3. Release the slider.

Key control
The following table shows the control keys used to set the slide to a desired value:

Key combination Description

. IZ' o .\ IE' Increase value by 1
Reduce value by 1
- (9] v
Increase value in 5% increments.
HOME

. Decrease value in 5% increments.
N

4 Set maximum value
N
= Set minimum value
N | +
END

Procedure using the keys
Proceed as follows:
1. Using the key mark the desired switch within the screen.

2. Move the slider to the required value.
If a value display has been configured, you can check the exact value that has been set.

Result
The set value is applied.
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8.10 Operating the Status Force

8.10 Operating the Status Force

8.10.1 Overview

Application
You read or write access values of the connected PLC directly with Status Force. Status
Force allows you to monitor or change addresses of the PLC program, etc. You don't need
to connect an additional programming device or additional PC to the PLC.
Note
Status Force can only be used in combination with SIMATIC S5 or SIMATIC S7.
Layout
The layout of Status Force depends on the configuration.
The figure shows the general layout of Status Force. A value can be monitored or controlled
on every line.
The following figure shows an example of Status Force.
CDnnectiDnl Typel Oﬂ‘aetl FDrmatl Control Yalue | |l
FLC_1 M |120 |DEC 33
FLC_1 T |40 |T 24,00
PLC_1 o |50 |DEC o
PLC_1 o |50 |HEX nano |
2l [ ;IJ
I
The configuration engineer specifies which columns appear in Status Force.
The table shows the significance of all configurable columns.
Column Functions
"Connection" The PLC whose address ranges must be displayed.
"Type", "DB Number", "Offset", "Bit" The address range of the value
"Data Type", "Format" The data type of the value
"Status Value" The value read from the specified address.
"Control Value" The value to be written to the specified address.
Further information on this may be available in your plant documentation
MP 377, MP 377 PRO (WinCC flexible)
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8.10 Operating the Status Force

Operating elements

Depending on your configuration, you can operate the Status Force using
the following buttons:

Buttons Functions

G Read" button

Updates the display in the "Status Value" column.

This button engages when it is pressed. You cannot operate any text boxes until
the button is actuated again and the refresh is stopped.

. "Write" button

Applies the new value in the "Control Value" column. The control value is written
to the PLC.

8.10.2 Touch operation

Operator input options
Status Force can be operated as follows:
® Change the column sequence
® Read the status values of the connected PLC

e Enter values and transfer them to the PLC

Change column sequence
Depending on the configuration, you can change the column sequence of Status Force.
Proceed as follows:
1. Touch the column header which you wish to exchange with a different column header

2. Keeping the touch screen pressed, move the column heading to the column heading you
wish to exchange it with

Result
The columns are displayed in the modified sequence.
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8.10 Operating the Status Force

Procedure for reading the status value
Proceed as follows:
1. Enter the address and the desired format of a value for each line. Touch the respective
columns to display the screen keyboard.

2. Once you have entered all of the desired values, touch the $ button.

Result

All values are read cyclically by the PLC and entered in the "Status Value" column until

the i button is touched again.

Requirements for forcing
The following requirements must be fulfilled in order to force values:
® The "Control Value" column must be available

® The "Write" button must be available

Procedure for forcing a value
Proceed as follows:

1. Enter the address of a value for each line. Enter the desired value in the "Control Value
column. Touch the respective columns to display the screen keyboard.

2. Once you have entered all of the desired values, touch the # button.

Result
The values from the "Control Value" column are transferred once to the PLC.

8.10.3 Key control

Operator input options
Status Force can be operated as follows:
® Change the column width.
® Read the status values of the connected PLC

e Enter values and transfer them to the PLC

MP 377, MP 377 PRO (WinCC flexible)
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Key control
The following table lists the key combinations for operating the Status Force:

Keys Functions
. Operates the "Read" button.

9]

= Operates the "Write" button.

Selects the first/last field in the current line.

(¢}
=
Py}
z
+

Selects the first/last field in the current column.

O
4
py)
z
+

O
4
py)
z
+

INS Deletes the current line.

CTR! DEL

5 [€ 5 9@ [

H
+

Otherwise:
Do not select a PLC in the "Connection" column.

Opens selection box.

m
z
5
m
byl

Increases the width of the current column.

O
=1
T
2

ALT

AT Decreases the width of the current column.

4 ¥

o Optimizes column width.

n n
5 5
T T
— —
+
+

+

Procedure for reading the status value
Proceed as follows:

1. Enter the address and format of the status value for each status value you wish to read in
one line. Select the respective fields and enter the values using the keyboard.

{ 1}
CTRL]
2. Press + .

Result

All status values are read cyclically from the PLC and entered in the "Status Value" column

t 1}
until the + keys are pressed again.
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8.117 Operating the Sm@rtClient view

Requirements for forcing
The following requirements must be fulfilled in order to force values:
® The "Control Value" column must be available

® The "Write" button must be available

Procedure for forcing a value
Proceed as follows:

1. Enter the address of a value for each line. Enter the desired control value in the "Control
Value" column. Select the respective fields and enter the values using the keyboard.

2. Once you have entered all of the desired control values, press the + key.

Result
The values from the "Control Value" column are transferred once to the PLC.

Alternative procedure

Alternatively, you can also select the buttons g and 22 using the key

and operate it using key .

8.11 Operating the Sm@rtClient view

8.11.1 Overview

Application
The Sm@rtClient view enables you to monitor and remotely operate the current project of a
remote HMI device. With the correct configuration, several equal priority HMI devices can
access a remote HMI device.
Note
If another HMI device accesses your HMI device via the Sm@rtClient view, this leads to an
additional load on your HMI device.

Layout

In the Sm@rtClient view, the remote HMI is displayed with the complete layout.
Depending on the configuration, you can monitor and also operate this screen.

You can also operate the function keys like buttons on an HMI device with a touch screen.

MP 377, MP 377 PRO (WinCC flexible)
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8.11 Operating the Sm@rtClient view

Monitoring mode

On a Sm@rtClient view which is configured for monitoring mode, you can only monitor the
remote HMI device. You cannot control its operation.

Operation

Note

It is not possible to operate the direct keys of the remote HMI device from the
local HMI device.

The available operating elements depend on the HMI devices used:
e Same type of HMI devices

You can operate the project of the remote HMI device with the operating elements of
your HMI device

® Operate keys from a local touch screen

All the keys of the remote HMI device are displayed as buttons on the touch screen.
You can also touch them to operate them

® Touch operation from a local HMI device using keys

You operate the buttons in the usual manner.

8.11.2 Touch operation

Operator input options
The Sm@rtClient view can be operated as follows:
e Starting remote control
® Forcing permission

® Ending remote operation
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8.117 Operating the Sm@rtClient view

Procedure for starting remote operation

Proceed as follows:

1.

On the HMI device change to the screen with the Sm@rtClient view.

The following options are available for establishing the connection to the remote
HMI device:

— The connection is established automatically.
— The connection must be established by touching the appropriate button.

Depending on the configuration, you may be required to enter the address of the
remote HMI device and a password.

. The current screen of the project running on the remote device is displayed on the screen

of your HMI device.
You can now monitor and control this screen depending on your configuration.

Scroll bars are displayed if the screen of the remote HMI device is larger than that of the
current HMI device.

Procedure for forcing permissions

If several HMI devices have access to a HMI device, only one HMI device has operating
permission at any one time.

Two cases must be distinguished for this case:

If another HMI device is already controlling the remote HMI device, if configured
accordingly, you can force operating permission for the remote HMI device

— You are trying to operate the remote HMI device

— A dialog appears in which you are prompted to enter the appropriate password for
forcing remote control

— You are now authorized to operate the remote HMI device

If another HMI device is accessing your HMI device via the Sm@rtClient view, you can
force local operating permission for your HMI device

— Touch the screen of your HMI device five times consecutively

— You are given permission to operate your local HMI device

Procedure for ending remote control

You can end monitoring and control of a remote HMI device with one of the following
methods depending on the configuration:

® Touch a button configured for this action

® Exit the screen containing the Sm@rtClient view

If configured, a menu is displayed after you have touched an empty space over a
longer period. Select the "Close" menu item.

Further information on this may be available in your plant documentation

222

MP 377, MP 377 PRO (WinCC flexible)
Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO



Operating a project
8.11 Operating the Sm@rtClient view

8.11.3 Key control

Operator input options
The Sm@rtClient view can be operated as follows:
e Starting remote control
® Forcing permission

® Ending remote control

Procedure for starting remote operation
Proceed as follows:
1. On the HMI device change to the screen with the Sm@rtClient view.

The following options are available for establishing the connection to the remote
HMI device:

— The connection is established automatically.

— Continue to press the key until the Sm@rtClient view is selected.

Depending on the configuration, you may be required to enter the address of the
remote HMI device and a password.

The connection is established. The current screen of the project running on the remote
device is displayed on the screen of your HMI device.

2. You can now monitor and control this screen depending on your configuration.

3. Scroll bars are displayed if the screen of the remote HMI device is larger than that of the

current HMI device. Move the scroll bars in the direction required using keys + IZ'

o5 [

Procedure for forcing permissions

If several HMI devices access an HMI device, only one HMI device has permission
to operate.

Two cases must be distinguished for this case:

e |f another HMI device is already controlling the remote HMI device, if configured
accordingly, you can force operating permission for the remote HMI device

— You are trying to operate the remote HMI device

— A dialog appears in which you are prompted to enter the appropriate password for
forcing remote control

You are now authorized to operate the remote HMI device
e [f another HMI device is accessing your HMI device via the Sm@rtClient view, you can
force local operating permission for your HMI device
— Press five times consecutively.

You are given permission to operate your local HMI device
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8. 12 Project security

Procedure for ending remote control

You can end monitoring or control of a remote HMI device with one of the following methods
depending on the configuration:

® Press the key configured for this

® Exit the screen containing the Sm@rtClient view

e |f configured, display a menu with + . Select the desired menu command
with and the respective identification letter.

Further information on this may be available in your plant documentation.
8.12 Project security

8.12.1 Overview

Design of the security system

The configuration engineer can protect the operation of a project by implementing
a security system.

The security system is based on authorizations, user groups and users.

If operating elements protected by a password are operated, the HMI device first requests
that you log on. A logon screen is displayed in which you enter your user name and
password. After logging on, you can operate the operating elements for which you have
the necessary authorizations.

The logon dialog can be set up by the configuration engineer via an individual
operating element.

In the same way, the configuration engineer can set up an operating element to log off. After
logging off, objects assigned password protection can no longer be operated; to do so,
log on again.

Further information on this may be available in your plant documentation.

User groups and authorizations

Project-specific user groups are created by the configuration engineer. The "Administrators"
and "PLC User" groups are included in all projects by default. User groups are assigned
authorizations. Authorization required for an operation is specifically defined for each
individual object and function in the project.
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Users and passwords
Each user is assigned to exactly one user group.
The following people are allowed to create users and assign them passwords:
® The configuration engineer during configuration
® The administrator on the HMI device
® A user with user management authorization on the HMI device

Irrespective of the user group, each user is allowed to change his own password.

Logoff times

A logoff time is specified in the system for each user. If the time between any two user
actions, such as entering a value or changing screens, exceeds this logoff time, the user is
automatically logged off. The user must then log on again to continue to operate objects
assigned password protection.

Backup and restore

The user data is encrypted and saved on the HMI device to protect it from loss due to
power failure.

The users, passwords, group assignments and logoff times set up on the HMI device can be
backed up and restored. This prevents you having to enter all of the data again on another
HMI device.

NOTICE

The currently valid user data is overwritten in the following cases:
¢ Depending on the transfer settings, when the project is transferred again
e Upon restore of a backed-up project

e Upon import of the user administration via an operating element. Further information on
this may be available in your plant documentation

The retransferred or restored user data and passwords are valid with immediate effect.

Limits for user, password and user View

Number of characters
Length of user name, maximum 40
Length of password, minimum 3
Length of password, maximum 24
Entries in user view, maximum 50

MP 377, MP 377 PRO (WinCC flexible)
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8.12.2 User view

Application
The user view is used to display the users on the HMI device:

e All users on the HMI device are displayed in the user view to the administrator or
to a user with administrator authorizations

® |f you are a user without user management authorization, you can only see your
personal user entry

The authorizations of a user after logging on depends on the user group to which
the user is assigned.

Further information on this may be available in your plant documentation

Layout
The configuration engineer can implement a simple or enhanced user view.

The two user views offer the same functions. They differ only in the display of information.

Simple user view

If you are not logged on to the HMI device, the only entry contained in the simple user
view is "<ENTER>".

If you are logged on to the HMI device, the simple user view only displays the user name
and user group.

Group (9
PLC User Group (1)
Uzer 1 Group (1)
<ew Lisers=

Enhanced user view

The enhanced user view displays information about the users.

Logoff time
admin | R fcon@ s
PLC gy || ok sk e GrDup (1) =}

Uger 1 | *#*#**rs | Group (1) 5

1| [ E

The enhanced user view contains the following columns:
® Users

® Password

e Group

® [ ogoff time

The passwords are encrypted by appear as asterisks.
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8.12.3 User logon

Logon dialog

Use the logon dialog to log on to the security system of the HMI device. Enter your user
name and password in the logon dialog.

x

Lser: I

Password: I

(04 | Cancel |

The logon dialog opens in the following cases:

® You are operating an operating element with password protection

® You are operating an operating element that was configured for displaying the logon
dialog

® You activate the "<ENTER>" entry in the simple user view
® You activate a blank entry in the extended user view

® The logon dialog will be automatically displayed when the project is started, depending on
the configuration

Further information on this may be available in your plant documentation.

Requirements
The logon dialog is open.

Procedure using the touch screen
Proceed as follows:
1. Enter the user name and password.
Touch the corresponding text box. The alphanumerical screen keyboard is displayed.
2. Select "OK" to confirm logon.
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Procedure using the keys
Proceed as follows:

1. Using the key select the "User" text box within the logon dialog.

2. Enter the user name using the system keys.

To enter letters, switch the numerical keypad to letter assignment using the key .

3. Using the key select the "Password" text box.

4. Enter the password using the system keys.

5. Touch the "OK" button to confirm your entries.

Note
The user name is not case-sensitive.

The password is case-sensitive.

Result

After successful logon to the security system, you can execute password-protected functions
on the HMI device for which you have authorizations.

If you enter a wrong password, an error message is displayed when an alarm window has
been configured.

8.124 User logoff

Requirements
You have logged into the security system of the HMI device.

Procedure
You have the following options for logging off:
® You operate an operating element that was configured for logoff
® You will be logged off automatically if you are not operating the project and if the logoff
time has been exceeded
You will also be automatically logged off if you enter an incorrect password.
Result

You are no longer logged into the project. In order to operate an operating element with
password protection, you must first log on again.
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8.12.5 Creating users
8.12.5.1

Requirements

Creating users with touch operation

You have opened a screen containing the user view.

You have user management authorization or you are the administrator.

8.12 Project security

NOTICE

e Blank
e Special characters *? . % /\'"

The following characters cannot be used in passwords:

Procedure for creating a user in the simple user view

Proceed as follows:

1. Touch the "<New User>" entry in the user view.

The following dialog opens:

X

B
Lser: I
Password: I
(04 | Cancel |

2. Enter the desired user name and password.

Touch the corresponding text box. The alphanumerical screen keyboard is displayed.

3. Touch the "OK" button.

The following dialog opens:

DN x|
Group: [Giroup (1) =]

Logoff time: |5

[ ox |

Cancel |

4. Assign the user to a group.

In order to do so, open the "Group" drop down list box by means of the =l button. Select

2l and =l to scroll in the drop down list box.

5. Touch the required entry in the drop down list box.

The selected entry is then accepted as input.

MP 377, MP 377 PRO (WinCC flexible)
Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO

229



Operating a project
8. 12 Project security

6. Touch the text box "Logoff time". The screen keyboard is displayed.

7. Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for "no
automatic logoff."

8. Touch the "OK" button to confirm your entries.

Procedure for creating a user in the enhanced user view
Proceed as follows:
1. Touch the desired field in the blank line of the user view.

The appropriate screen keyboard is displayed.

2. Switch into input mode by means of the 4|"‘E key.

3. Enter the respective user data in the field:
— Assign the user to one of the groups from the drop down list box.

— Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for
"no automatic logoff."

Result
The new user is created.

8.12.5.2  Creating users with key operation

Requirements
You have opened a screen containing the user view.
You have user management authorization or you are the administrator.

NOTICE

The following characters cannot be used in passwords:
e Blank
e Special characters *? . % /\""
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Procedure for creating a user in the simple user view
Proceed as follows:

1. Select the user view using the key or using the cursor keys.

2. Select the entry "<New user>" in the user view with the cursor keys and confirm with .

The following dialog opens:

7 x|
Liser: I
Password: I
Ok | Cancel |

3. Enter the desired user name using the system keys.

4. Select the next text box with the key and enter a password using the system keys.

5. Touch the "OK" button to confirm your entries.

The following dialog opens:

DN x|
Group: [Giroup (1) =]

Logoff time: |5

(04 I Cancel |

6. Select the "Group" selection box with .

7. Assign the user to a group.

— Select to open the drop down list box. The drop down list box opens.

— Select the required entry using IZI or Izl

— Confirm your entry by pressing the key _

8. Select the text box "Logoff time" with .

9. Enter the desired logoff time using the system keys.

Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for
"no automatic logoff."

10.Touch the "OK" button to confirm your entries.
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Procedure for creating a user in the enhanced user view
Proceed as follows:

1. Select the user view with the key via the configured tab order.

N

. Select a blank line with the |Z| or Izl keys.

3. Select the desired field in the blank line of the user view with the IE' or IEI keys.

4. Confirm your entry by pressing the key .
5. Enter the desired user data:
— Enter the data using the system keyboard. To enter letters, switch the numerical
keypad to letter assignment using the key .
— Assign the user to one of the groups from the drop down list box. Open the drop down

list box with the key and select the desired entry with the IZ' or Iz' keys.

— Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for
"no automatic logoff."

6. Confirm your entry by pressing the key _

Result
The new user is created.
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8.12.6 Changing user data

8.12.6.1  Changing user data with touch operation

Requirements
You have opened a screen containing the user view.
Which data you are allowed to change depends on your authorization:

® You are an administrator or a user with user management authorization. In these cases
you are allowed to change the data for all the users on the HMI device in the user view:

User name

Group assignment

Password

Logoff time

® You are a user without user management authorization. In this case you are only allowed
to change your personal user data:

— Password

— Logoff time, if configured

Note
You can only change the logoff time and password for the "Admin" user.

You can only change the logoff time for the "PLC_User". This user is used for logging
on via the PLC.

Procedure for changing user data in the simple user view
Proceed as follows:
1. In the user view, touch the user whose user data you want to change

2. When entering the data, use exactly the same procedure as for creating a user

Procedure for changing user data in the enhanced user view
Proceed as follows:
1. In the user view, touch the user whose user data you want to change

2. When entering the data, use exactly the same procedure as for creating a user

Result
The user data for the user is changed.
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8.12.6.2

Changing user data with key operation

Requirements

You have opened a screen containing the user view.

Which data you are allowed to change depends on your authorization:

® You are an administrator or a user with user management authorization. In these cases
you are allowed to change the data for all the users on the HMI device in the user view:

User name
Group assignment
Password

Logoff time

® You are a user without user management authorization. In this case you are only allowed
to change your personal user data:

Password

Logoff time, if configured

Note
You can only change the logoff time and password for the "Admin" user.

You can only change the logoff time for the "PLC_User". This user is used for logging
on via the PLC.

Procedure for changing user data in the simple user view
Proceed as follows:

1. Confirm your entry by pressing the key .

T

2. In the user view, use the cursor keys to select the user whose user data you want to

change. Confirm your entry by pressing the key _

3. When entering the data, use exactly the same procedure as for creating a user.

Procedure for changing user data in the enhanced user view

Result
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Proceed as follows:

1. Confirm your entry by pressing the key .

2. Use the cursor keys to select the field in which you want to change data. Confirm your

entry by pressing the key .
3. When entering the data, use exactly the same procedure as for creating a user

The user data for the user is changed.

MP 377, MP 377 PRO (WinCC flexible)
Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO



Operating a project
8.12 Project security

8.12.7 Deleting users

Requirements
You have opened a screen containing the user view.

To delete a user, you must be an administrator or have user management authorization.

Note

The "Admin" and "PLC_User" users exist by default. These users cannot be deleted.

Procedure

To delete a user, delete the user name entered.

Result

The user has been deleted and may no longer log onto the project.
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8.13 Closing the project

Procedure
Proceed as follows:
1. Use the corresponding operating element object to close the project.
Wait for the Loader to open after you closed the project.

2. Switch off power to the HMI device.

MP 377, MP 377 PRO (WinCC flexible)
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9.1 Overview

Alarms

Alarms indicate events and states on the HMI device which have occurred in the system,
in the process or on the HMI device itself. A status is reported when it is received.

An alarm could trigger one of the following alarm events:
® |ncoming

e Qutgoing

® Acknowledge

The configuration engineer defines which alarms must be acknowledged by the user.
An alarm may contain the following information:

e Date

® Time

® Alarm text

® Location of fault

e State

® Alarm class

® Alarm number

e Alarm group

e Diagnostics capability

MP 377, MP 377 PRO (WinCC flexible)
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Alarm classes

Alarm groups

Alarm buffer

Alarm report

Alarm log
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Alarms are assigned to various alarm classes:
® Error

Alarms in this class must always be acknowledged. Error alarms normally indicate critical
errors within the plant such as "Motor temperature too high"

® Qperation

Warning alarms usually indicate states of a plant such as "Motor switched on"
e System

System alarms indicate states or events which occur on the HMI device
e SIMATIC diagnostic alarms

SIMATIC diagnostic alarms show states and events of the SIMATIC S7
or SIMOTION PLCs

® User-specific alarm classes
The properties of this alarm class must be defined in the configuration

Further information on this may be available in your plant documentation.

The configuration engineer can group alarms into alarm groups. When you acknowledge an
individual alarm of an alarm group, you acknowledge all alarms which belong to the same
alarm group.

The alarm events are stored in an internal buffer. The size of this alarm buffer depends on
the HMI device type.

The configuration engineer can activate alarm reporting on the project. In this case, alarm
events are output directly on the connected printer.

The configuration engineer can define whether each individual alarm is logged. An alarm of
this type is printed when the alarm events "Incoming" and "Outgoing" occur.

If you want to print alarms of the "System" alarm class, you have to print the contents of the
associated alarm buffer. For this case the configuration engineer has to configure an
operating element for printing the alarm buffer.

Alarm events are stored in an alarm log, provided this log file is configured. The capacity of
the log file is limited by the storage medium and system limits.
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9.2 Detecting queued alarms

Introduction

You can recognize the presence of alarms which must be acknowledged by the following:

® For an HMI device with keys: The LED in the key lights up.

® Depending on the configuration: An alarm indicator is displayed on screen.

The configuration determines whether an alarm has to be acknowledged or not. This is also
defined by the alarm class which an alarm belongs to.

LED in the "ACK" key

Alarm indicator

On an HMI device with keys, an LED is integrated in the key . The LED is lit if there are

alarms requiring acknowledgment which must still be acknowledged.

The LED goes out when you acknowledge all alarms requiring acknowledgment.

The alarm indicator is a graphic symbol indicating pending alarms or alarms requiring
acknowledgment, depending on the configuration.

/N

3

The alarm indicator flashes as long as alarms are pending for acknowledgment. The number
displayed indicates the number of pending alarms. The configuration engineer can assign
functions to be executed when the alarm indicator is operated.

Usually, the alarm indicator is only used for error alarms. Further information may be
available in your plant documentation.
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9.3 Message display

Displaying alarms
Alarms are displayed in the alarm view or in the alarm window on the HMI device.

Alarm view
Depending on the configuration, the alarm view is displayed as follows:

® As a single line. Alarm numbers and alarm texts are displayed as single lines
® As simple alarm view
® As enhanced alarm view

In the simple or enhanced alarm views the configuration engineer specifies the alarm
information to be displayed.

Depending on the configuration, alarms from alarm logs are also displayed in the alarm view.

Simple alarm view

19.04.2005 11:41:37 ! 1 "
Motor 23 too hot t
¥

ﬂ J

The buttons have the following functions:

Buttons Functions

Displaying infotext for an alarm.

Process alarm.

Acknowledge alarm.

Scroll one page up or down.

]

2l

J
v a Select the next or previous alarm in the list.
V|4

No. Time Date Status
[ 12:04:59 19.04.2005 K

Motor 23 too hot

MP 377, MP 377 PRO (WinCC flexible)
240 Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO



Operating alarms

9.3 Message display

The buttons have the following functions:

Buttons Functions

Displaying infotext for an alarm.

Process alarm.

Acknowledging alarms.

.

Changing the column sequence and sorting in the enhanced alarm view

Depending on the configuration, you can change the column sequence and sorting order on
HMI devices with touch operation.

e Change column sequence
— Touch the column header which you wish to exchange with a different column header

— Keeping the touch screen pressed, move the column heading to the column heading
you wish to exchange it with

e (Change sorting order

To change the sorting order of the alarms, touch the respective column header on the
touch screen

Alarm class layout

The various alarm classes are identified in order to distinguish between them in
the alarm view.

Icon Alarm class

! Error

Without a symbol Operation

Symbol depending on the configuration User-defined alarm classes

S7 SIMATIC or SIMOTION diagnostic alarms
$ System

The configuration engineer can change the symbols for the alarm classes. Further
information on this may be available in your plant documentation.

Alarm window

The alarm window is independent of the process screen. Depending on the configuration,
the alarm window opens automatically as soon as a new alarm is pending for
acknowledgment. The alarm window can be configured so that it only closes after all the
alarms have been acknowledged.

The layout and the operation of the alarm window are the same as for the alarm view.

Further information on this may be available in your plant documentation.
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9.4 Displaying infotexts

Displaying infotext

The configuration engineer can also provide infotext for alarms.

Procedure using the touch screen

Proceed as follows:

1.

Touch the desired alarm in the alarm view or the alarm window.

The alarm is selected.

Touch the j button in the simple alarm view or in the enhanced alarm view.

If configured, the infotext assigned to this alarm is displayed.

. Close the screen for displaying the Infotext by means of the button.

Procedure using the keys

Proceed as follows:

1.

2.
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Select the desired alarm in the alarm view.

Press .

If configured, the infotext assigned to this alarm is displayed.

Close the infotext by pressing key .
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9.5 Acknowledge alarm

Requirements

The alarm to be acknowledged is displayed in the alarm window or the alarm view.

Procedure using the touch screen
Proceed as follows:
1. Touch the desired alarm in the alarm view or the alarm window.

The alarm is selected.

2. Touch the j button in the simple alarm view or id | in the enhanced alarm view.

Procedure using the keys
The alarm view and the alarm window have a tab sequence with which you can select
operating elements and the last selected alarm using the keyboard.

1. Select the desired alarm view or alarm window with .

2. Select the desired alarm. Use the , , |z| or |Z| keys.
3. Press .

Alternative operation

Depending on the configuration, you can also acknowledge an alarm with a function key.

Result

The alarm is acknowledged. If the alarm belongs to an alarm group, all the alarms of the
associated group are acknowledged.

More information on acknowledgment and on available alarm groups may be found in your
plant documentation.
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9.6 Editing alarms

Introduction

Requirements

The configuration engineer can assign additional functions to each alarm. These functions
are executed when the alarm is processed.

Note
When you edit an unacknowledged alarm, it is acknowledged automatically.

The alarm to be edited is displayed in the alarm window or the alarm view.

Procedure using the touch screen

Proceed as follows:
1. Touch the desired alarm in the alarm view or the alarm window. The alarm is selected.

2. Touch the ﬂ button in the simple alarm view or & | in the enhanced alarm view.

Procedure using the keys

Result
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Proceed as follows:

1. Select the desired alarm view or alarm window with .

2. Select the desired alarm. Use the , , IZI or Izl keys.

3. Continue to press the key until the button ﬂ is selected in the simple alarm view or

& | in the extended alarm view.

ENTER|

4. Confirm your entry by pressing the key .

The system executes the additional functions of the alarm. Further information on this may
be available in your plant documentation.
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10.1 Overview

Introduction

Recipes are used when different variants of a product are manufactured with the same
process. In this case, the product variants differ in terms of their type and quantity of the
components, but not in terms of the manufacturing process sequence. The configuration
engineer can store the combination of each individual product variant in a recipe.

Field of application

Recipes can be used everywhere the same product components are used in variable
combinations to create different product variants.

Examples:

® Beverage industry

® Food processing industry
® Pharmaceutical industry

® Paint industry

e Building materials industry

e Steel industry
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10.2 Structure of a recipe

Recipes

The recipe collection for the production of a product family can be compared to a file cabinet.
A recipe which is used to manufacture a product corresponds to a drawer in a file cabinet.

Example:

In a plant for producing fruit juice, recipes are required for different flavors. There is a recipe,
for example, for the flavors orange, grape, apple and cherry.

®

(
®

(
®

®

//
o

@

©O) File cabinet Recipe collection Recipes for a fruit juice plant
® Drawer Recipe Orange flavored drinks

® Drawer Recipe Grape flavored drinks

@ Drawer Recipe Apple flavored drinks

® Drawer Recipe Cherry flavored drinks
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Recipe data records

The drawers of the file cabinet are filled with suspension folders. The suspension folders in
the drawers represent records required for manufacturing various product variants.

Example:

Product variants of the flavor apple might be a soft drink, a juice or nectar, for example.

>

Drawer Recipe Product variants of apple flavored drinks
Suspension folder Recipe datarecord  Apple drink
Suspension folder Recipe datarecord  Apple nectar

® 006

Suspension folder Recipe datarecord  Apple juice

Elements

In the figure showing the file cabinet, each suspension folder contains the same number of
sheets. Each sheet in the suspension folder corresponds to an element of the recipe data
record. All the records of a recipe contain the same elements. The records differ, however,
in the value of the individual elements.

Example:

All drinks contain the same components: water, concentrate, sugar and flavoring. The
records for soft drink, fruit juice or nectar differ, however, in the quantity of sugar
used in production.
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10.3 Recipes in the project

Overview

248

If recipes are used in a project, the following components interact:

® Recipe view / recipe screen

On the HMI device, recipes are displayed and edited in the recipe view or in
a recipe screen.

— The recipe data records from the internal memory of the HMI device are displayed and
edited in the recipe view.

— The values of the recipe tags are displayed and edited in the recipe screen

Depending on the configuration, the values displayed in the recipe view are synchronized
with the values of recipe tags.

HMI device recipe memory

Recipes are saved in the form of data records in the HMI device recipe memory.
The recipe data can also be saved in recipe tags.

Recipe tags

The recipe tags contain recipe data. When you edit recipes in a recipe screen, the recipe
values are stored in recipe tags. Depending on the configuration, the values of the recipe
tags are exchanged with the PLC.

The recipe tags can be synchronized with the recipe data records so that the same
values are saved in both.

Memory card

The memory card is an external storage medium for recipe data records. The recipe
data records are exported from the HMI device recipe memory and are saved on the
memory card in a *.csv file. The records can be reimported from the memory card to
the recipe memory.
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Data flow

The following figure shows the data flow in a project with recipes.

HMI device m
Recipe view @ u

Recipe 1
/‘> < Recipe 2
/ < o= Recipe 3
] ®
Recipe < > Recipe tag A

® f ~_ |
@

®

v

<

Memory card

[

Editing, saving or deleting a recipe data record
Display recipe data record

Synchronize or do not synchronize recipe tags
Display and edit recipe tags in the recipe screen

Write records from the recipe view to the PLC or read records from the PLC and
display them in the recipe view

Recipe tags are to the PLC online or offline
Export or import recipe data record to memory card

Qe 0600
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10.4 Recipe displays

Displaying recipes

You can display and edit recipes on the HMI device with a recipe view or recipe screen.

Recipe view

A recipe view is a screen object used to manage recipe data records. The recipe view shows

recipe data records in tabular form.

Depending on the configuration, the recipe view is displayed as follows:

® As enhanced recipe view

® As simple recipe view

The configuration engineer also defines which operating elements are displayed in

the recipe view.

Enhanced recipe view

The following figure shows an example of the enhanced recipe view.

Recipe Mame:

@7 |Orange

Data Record Marne:

o,
5 Fx e e
Mo,

@7| Mectar

A =0

Entry Mame Yalue 5
@7 Water 40—
Concentrate [

—®

elEx  aa

[Ready

Display field

Qe ©® 00

250

Selection box for the recipe
Selection box for the recipe data record

Element name
The element name designates a specific element in the recipe data record

Value of the element
Buttons for editing a recipe data record
Status bar for display of the status messages

—®

=@

This show the number of the selected recipe or the selected recipe data record
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Simple recipe view

Display of values

MP 377, MP 377 PRO
Operating Instructions,

The simple recipe view consists of three areas:
® Recipe list

e Record list

® Element list

In the simple recipe view, each area is shown separately on the HMI device. Depending on
the configuration, the simple recipe view starts with the recipe list or data record list.

The following figure shows an example of the record list.

1 Juice

2 Beverage :J

3 Nectar

4) :b

©) Number of the recipe data record
@
®

Recipe data records
Buttons for changing the displayed list and calling the menu

NOTICE
Changing the recipe data record in the background

Applies to the processing of a recipe data record:
If values of the corresponding recipe data record are changed by a PLC job, the recipe view
is not updated automatically.

To update the recipe view, reselect the respective recipe data record.

(WinCC flexible)
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Recipe screen

A recipe screen allows the correlation between the plant and the recipe data to be displayed
in graphic form. The configuration engineer combines /O fields and screen objects to form a
custom input screen. The configuration engineer can distribute the 1/O fields of a recipe over
several recipe screens, thus allowing recipe elements to be arranged by subject. The recipe
screen can be operated using buttons configured accordingly.

The following figure shows an example of the recipe screen.

) D\
Water I 40 I | recipe name No.:
\Concentiaiet i 70 BN || [orange e
_ 30 - Data record name No.:
T iz
( T
Save | Data from the PLC |
Load | Data to PLC |
2
®

® é@
Element name and associated values

The element name designates a specific element in the recipe data record
Buttons for editing a recipe data record
Modified recipe view

®e 0 06

Buttons for transferring recipe data

The values displayed or entered in the recipe screen are saved in recipe tags. The recipe
values are exchanged with the PLC immediately or later via these tags.

A configured recipe view can itself be a component of a recipe screen. You must
synchronize the tags in order to synchronize data between the tags of the recipe screen
and the recipe data records displayed in the recipe view. Synchronization of tags is only
possible in the enhanced recipe view.

Further information on this may be available in your plant documentation.
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10.5 Recipe values in the HMI device and the PLC

Introduction

You can change the values of a recipe on the HMI device and therefore influence the
manufacturing process or a machine.

Depending on the configuration, the recipe values are displayed, edited and saved in
different ways:

e |f you are editing recipes with a recipe view in your project, the values are saved
in recipe data records

® |f you are editing recipes in a recipe screen in your project, the values are saved
in recipe tags

Differences may occur between the display values in the recipe view and the values saved in
the associated tags in an ongoing project when you edit recipes with a recipe view and in a
recipe screen. To prevent this, the recipe data record values must be synchronized with the
values of the recipe tags.

You have however the option to perform synchronization operations at any time.
Synchronization only takes place if the configuration engineer has activated the respective
settings for a recipe.

Note
Recipe tags can only be synchronized in the enhanced recipe view.

Synchronizing recipe tags
Synchronization of the recipe tags depends on the configuration:
® Automatic synchronization:

The values of the recipe view are synchronized with the associated recipe tags. In this
case, changes to values in the recipe view have an immediate effect on the values of the
associated recipe tags. The values are only synchronized, when an operating element
that is outside the recipe view is operated.

® Synchronization by the user:

The values of the recipe view and the associated recipe tags are not synchronized

automatically. The configuration engineer has assigned the same function to the él
button or a different operating element in the recipe view. The recipe tags and the recipe
view are only synchronized when you operate the buttons or the appropriate operating

element.
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Recipe tags online / offline

The configuration engineer can configure a recipe so that changes to the values of the recipe
tags do not have an immediate effect on the current process.

Synchronization of the recipe values between the HMI device and the PLC depends on
whether the configuration engineer has selected the settings "Tags online" or the setting
"Tags offline" for a recipe.

"Tags online™:
This setting has the following effect:

— When you change recipe values in the recipe screen, these changes are applied
immediately by the PLC and immediately influence the process

— If recipe values are changed in the PLC, the changed values are displayed
immediately in the recipe screen

"Tags offline":

With this setting, changed recipe values are not synchronized immediately between the
HMI device and the PLC

In this case, the configuration engineer must configure operating elements for transferring
the values to the PLC or reading them from the PLC in a recipe screen. The recipe values
are only synchronized between HMI device and PLC when you operate the appropriate
operating element

10.6 Operating the recipe view

10.6.1 Overview

Operation

The recipe view can be operated as follows:

254

Enter values for the recipe elements

Create recipe data records

Save recipe data records or save them under a new name

Delete recipe data records

Synchronize values of the recipe view with the associated recipe tags

Transfer recipe data records from the PLC and to the PLC

MP 377, MP 377 PRO (WinCC flexible)
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Operating elements of the recipe view
The following table shows the operating elements of the recipe view.

Buttons | Key combination Functions

; T3 Creates a new recipe data record.
i~ | + If a start value is configured, it is shown in the text box.
= Saves the displayed values of the recipe data record.
| + The storage location is predefined by the project.
The recipe data record is saved under a different name irrespective
= | + of the recipe view. A dialog box opens in which the name is entered.
The displayed recipe data record is deleted.
X . [=]
The values of the recipe view are synchronized with the associated
& | + IE' recipe tags. The values changed during editing are written to the

associated recipe tags. Subsequently all the values of the tags are
read out and updated in the table.

The recipe values from the PLC are displayed in the recipe view.
gt
L] .[A]
The values of the set recipe data record displayed in the recipe view
i | + Iz' are transferred to the PLC.

Operating the recipe screen

You operate the recipes in a recipe screen with the operating elements provided by the
configuration engineer.

Further information on this may be available in your plant documentation.

10.6.2 Creating a recipe data record

Introduction

You create a new recipe data record by modifying an existing record. You then save the
modified data record under a new name.

Requirements
A screen with a recipe view is displayed.
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Procedure using the touch screen
Proceed as follows:

1.

If the recipe view contains several recipes: Select the recipe for which you want to create
a new recipe data record.

Touch El

A new recipe data record with the next available number is created.

If you change the new data record number to an existing data record number, the existing
data record is overwritten.

Enter values for the elements of the data record.

The elements of the recipe data record can be assigned default values depending on the
configuration.

Touch il

Enter a name for the data record.
The data record is saved under the new name.

If the recipe data record already exists, a dialog is opened. In this dialog, specify whether
the existing data record is to be overwritten.

Procedure using the keys
Proceed as follows:

1.

If the recipe view contains several recipes: Select the recipe for which you want to create
a new recipe data record.

[
press [11] + []

A new recipe data record with the next available number is created.

If you change the new data record number to an existing data record number, the existing
data record is overwritten.

Enter values for the elements of the data record.

The elements of the recipe data record can be assigned default values depending on the
configuration.

5. Enter a name for the data record.

6. Confirm your entry.

Result

The data record is saved under the new name.

If the recipe data record already exists, a dialog is opened. In this dialog, specify whether
the existing data record is to be overwritten.

The new recipe data record is saved to the selected recipe.
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10.6.3 Editing a recipe data record

Introduction
Edit the values of the recipe data records and save them in a recipe view.

Synchronization with the PLC
If you want to display the current recipe values from the PLC in the recipe view,

you first have to read the current values from the PLC with El

The values changed in the recipe view only become effective when the amended

data record is transferred to the PLC by means of theﬂl button.

Requirements
A screen with a recipe view is displayed.

Procedure using the touch screen
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to change.

3. Change the data record as required.
4. Save your changes by means of the El button.

If you want to save the recipe data record under a different name, touch the = | key.

5. The recipe data record is saved.

Procedure using the keys
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to change.

3. Change the data record as required.

4. Save your changes with + .

If you want to save the recipe data record under a different name, press + .

The recipe data record is saved.

Result
The edited recipe data record has now been saved in the selected recipe.
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10.6.4 Deleting a recipe data record

Introduction
You can delete all the data records of a recipe which are not required.

Requirements
A screen with a recipe view is displayed.

Procedure using the touch screen
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to delete.

3. Touch il

Procedure using the keys
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to delete.

3. Press + .

Result
The recipe data record is deleted.
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10.6.5 Synchronizing tags

Introduction

The values of the recipe elements can be saved to recipe tags, depending on the
configuration.

Differences may occur between the display values in the recipe view and the actual values of
tags in an ongoing project. Synchronize the tags to equalize such differences.

Synchronization always includes all the variables which belong to a recipe data record.

NOTICE

Changed tag name

Tags and the value of the recipe data record cannot be assigned to each other if the tag
name of the tag to be synchronized has been changed. The tags in question are not
synchronized.

Note
Recipe tags can only be synchronized in the enhanced recipe view.

Requirements
A screen with a recipe view is displayed.

Procedure using the touch screen
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to synchronize.

3. Touch él

Procedure using the keys
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to synchronize.

3. Press + IEI

Result
The elements of the recipe data record are synchronized with the recipe tags.
If the values of the recipe view and the tag do not match, the more current value is accepted.
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10.6.6 Reading a recipe data record from the PLC

Introduction

Requirements

In the current project, the values which are also stored in the recipes in the HMI device can

be changed directly in the plant. This is the case, for example, if a valve was opened further
directly at the plant than is stored in the recipe. The values of the recipe data records saved
in the HMI device possibly no longer match the values in the PLC.

To synchronize the recipe values, read the values from the PLC and display them in the
recipe view.

A screen with a recipe view is displayed.

Procedure using the touch screen
Proceed as follows:

1.

If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

Select the recipe data record to which you want to apply the values from the PLC.

Touch ﬂ

The values are read from the PLC.

If you want to store the displayed values in the HMI device, touch the El button.

Procedure using the keys
Proceed as follows:

Result

260

1.

If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

Select the recipe data record to which you want to apply the values from the PLC.

. Press + IZ'

The values are read from the PLC.

If you want to store the displayed values in the HMI device, press the keys + .

The values were read from the PLC, displayed on the HMI device and saved to the selected
recipe data record.
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10.6.7 Transferring a recipe data record to the PLC

Introduction

In order for an edited recipe data record to take effect in the process, you must transfer the
values to the PLC.

The display values in the recipe view are always transferred to the PLC.

Requirements
A screen with a recipe view is displayed.

Procedure using the touch screen
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains
the desired recipe data record.

2. Select the recipe data record whose values you want to transfer to the PLC.

3. Touch El

Procedure using the keys
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains
the desired recipe data record.

2. Select the recipe data record whose values you want to transfer to the PLC.

3. Press 7]+ [ V]

Result

The display values in the recipe view were transferred to the PLC and take effect
in the process.
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10.7 Operating the simple recipe view

10.7 1 Overview

Introduction

The simple recipe view consists of three areas:

® Recipe list

® Record list

® FElement list

You can use the context menu to operate each of these display areas.
Operation

The simple recipe view can be operated as follows:

® Enter values for the recipe elements

® (Create recipe data records

® Save recipe data records or save them under a new name
® Delete recipe data records

® Transfer recipe data records from the PLC and to the PLC

Operating elements of the simple recipe view
Toggle between the display areas and the context menus to operate the simple recipe views.

The following table shows the operation of the display area.

Touch operation Key control Functions

Touching an entry The next lower display area opens.

:l Esc The next higher display area opens.

:l :l The context menu of the display area opens.

The following table shows the operation of the context menu.

Touch operation Key control Functions
:l The menu is closed.
ESE .
The display area opens.
Touch the menu Input of the number | The menu command is executed.
command of the menu
command
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Context menus of the simple recipe view

A number is assigned to each menu command which you can use to call the menu
command with key control.

With touch operation, touch the menu command to execute it.

Some menu functions can also be called directly in the lists of the simple recipe view using
the keys.

® Recipe list

No. Menu Key combination | Functions
command
0 New A new recipe data record is created for the selected
recipe.

If a start value is configured, it is shown in the text box.

1 Displaying
infotext

2 Open The record list of the selected recipe opens.

The infotext configured for the simple recipe view is
displayed.

HELP

ENTER

® Record list

No. Menu Key combination | Functions

command

0 New A new recipe data record is created for the selected
recipe.

If a start value is configured, it is shown in the text box.

1 Delete The selected record is deleted.

2 Save as The selected record is saved under a different name
irrespective of the simple recipe view. A dialog box
opens in which the name is entered.

3 Rename The selected record is renamed. A dialog box opens in
which the name is entered.

® FElement list

No. Menu Key combination | Functions
command
0 Save The selected record is renamed.
To PLC The display values of the selected record are
transferred from the HMI device to the PLC.
2 From PLC The recipe values from the PLC are displayed on the

HMI device in the recipe view.

3 Save as The selected record is renamed. A dialog box opens in
which the name is entered.

Touch operation of the menu
Touch the desired menu command. The command is executed.
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Key control of the menu

Select the required entry using Izl or IZI Press .

Alternatively, press the numerical key with the number of the desired menu command.

The command is executed.

Operating the recipe screen

You operate the recipes in a recipe screen with the operating elements provided by the
configuration engineer.

Further information on this may be available in your plant documentation.

10.7.2 Creating a recipe data record

Introduction

Create a new recipe data record in the recipe list or in the record list. Then enter the values
for the new record in the element list and save the record.

Requirements
A screen with a simple recipe view is displayed.

Procedure
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe for which you want to create a
new recipe data record.

2. Open the recipe list menu.
3. Select the menu command "0 New".
A new record is created.
The element list of the new record opens.
4. Enter values for the elements of the data record.
The tags of the record can be assigned default values depending on the configuration.
5. Open the element list menu and select the menu command "0 Save".
6. Enter a name for the new record.
7. Confirm your entries.

If you change the new data record number to an existing data record number, the existing
data record is overwritten.

Result
The new recipe data record is saved to the selected recipe.
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10.7.3 Editing a recipe data record

Introduction

Edit the values of the recipe data records in a simple recipe view.

Synchronization with the PLC

If you want to display the current recipe values from the PLC in the simple recipe view,
you first have to read the current values from the PLC with the menu command
"2 from PLC" in the element list.

The values changed in the recipe view only take effect in the PLC when you transfer
the edited data record to the PLC with the menu command "1 to PLC".

Requirements

A screen with a simple recipe view is displayed.

Procedure

Proceed as follows:

1.

o gk~ 0w N

Result

If the recipe list contains several recipes: Select the recipe which contains
the desired recipe data record.

Open the data record list.

Select the recipe data record you want to change.
Open the element list.

Change the values of the records as required.

Save your changes with the menu command "0 Save".

The recipe data record is saved.

The edited recipe data record has now been saved in the selected recipe.
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10.7.4 Deleting a recipe data record

Introduction

You can delete all the data records which are not required.

Requirements

A screen with a simple recipe view is displayed.

Procedure using the touch screen
Proceed as follows:

1.

o > 0N

If the recipe list contains several recipes: Select the recipe which contains
the desired recipe data record.

Open the data record list.
Select the data record you want to delete.
Open the menu.

Select the menu command "1 Delete".

Procedure using the keys
Proceed as follows:

1.

If the recipe list contains several recipes: Select the recipe which contains
the desired recipe data record.

2. Open the data record list.

3. Select the data record you want to delete.

Result

INS
Press .

The data record is deleted.
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10.7.5 Reading a recipe data record from the PLC

Introduction
The values of recipe elements are exchanged with the PLC via tags.

In the current project, the values which are also stored in the recipes in the HMI device can
be changed directly in the plant. This is the case, for example, if a valve was opened further
directly at the plant than is stored in the recipe. The values of the tags on the HMI device
possibly no longer match the values in the PLC.

To synchronize the recipe values, read the values from the PLC and display them in the
recipe view.

Requirements
A screen with a simple recipe view is displayed.

Procedure
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains
the desired recipe data record.

2. Select the element list of the recipe data record to which you want to apply
the values from the PLC.

3. Open the menu.
4. Select the menu command "2 from PLC".
The values are read from the PLC.

5. If you want to save the display values in the HMI device, select the menu
command "0 Save".

Result

The values were read from the PLC, displayed on the HMI device and saved to
the selected recipe data record.
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10.7.6 Transferring a recipe data record to the PLC

Introduction

In order for an edited recipe data record to take effect in the process, you must transfer the
values to the PLC.

The display values in the recipe view are always transferred to the PLC.

Requirements
A screen with a simple recipe view is displayed.

Procedure
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains
the desired recipe data record.

2. Select the element list of the recipe data record whose values you want
to transfer to the PLC.

3. Open the menu.

4. Select the menu command "1 To PLC".

Result

The values of the recipe data record were transferred to the PLC and take effect
in the process.
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10.8 Importing a recipe data record

Introduction

You can import values from a CSV file to a recipe data record,
depending on the configuration.

Requirements

® An operating element with the function "Import data record" has been configured,
for example a button

® A screen with a recipe view is displayed.

Procedure
Proceed as follows:
1. If the recipe view contains several recipes: Select the recipe which contains the recipe
data record to be imported.
2. Operate the operating element with the function "Import data record".
The record is imported from an external data medium as a CSV file and then displayed
in the recipe view after import.
Result

The imported recipe data record is saved on the HMI device.

Deviating structure

If the structure of the CSYV file differs from the structure of the recipe, deviations are
handled as follows:

® Any additional values in the CSV file will be rejected

® The system applies the configured default value to the recipe data record if the CSV file
contains an insufficient number of values

e |f the CSV file contains values of the wrong data type, the configured default value is set
in the recipe data record

Example:
The imported CSV file contains values that were entered as floating point numbers.

However, the corresponding tag expects an integer value. In this case, the system
discards the imported value and uses the configured default.
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10.9 Exporting a recipe data record

Introduction

You can export one or more recipe data records to a CSV file, depending on the
configuration. After export, the values in the recipe data record can be further processed in a
spreadsheet program such as MS Excel. The degree to which you can influence the export
depends on the configuration.

Requirements
® A screen with a recipe view is displayed.
® An operating element with the function "Export record" has been configured.

® The following tags are configured equally in the recipe view and for the
"Export record" operating element:

— Recipe number

— Data record number

Procedure
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to export.

3. Operate the operating element which was configured for export, for example the
"Export data record" button.

The data record is exported as a CSV file to an external data medium.

Further information on this may be available in your plant documentation.

Result
The recipe data record is exported.
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10.10 Examples

10.10.1  Entering a recipe data record

Introduction
You would like to enter production data on the HMI device without interrupting
the process in the machine or plant. For this reason, the production data should
not be transferred to the PLC.

Procedure

Proceed as follows:
1. Call the recipe view or a recipe screen.
Select the desired recipe data record.

Enter the values of the elements.

oD

Save the recipe data record.
The recipe data record is saved in the internal memory of the HMI device.

The following figure shows the data flow schematically.

HMI device m
Recipe view @ w

Recipe 1
Recipe 2
o—o @ Recipe 3
1 ©
Recipe tag
Recipe
screen @ v

>
©

PLC

Display recipe data record

Save recipe data record

Tags are synchronized

Display and edit recipe tags in the recipe screen
Tags are offline

®©@®e 6 06
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10.10.2 Manual production sequence

Introduction
You request the production data of different workpieces from the PLC and display this data
on the screen of the HMI device for inspection. You want to correct the transferred
production data in the recipe view or the recipe screen if necessary.

Procedure

A scanner connected to the PLC reads the barcode of a workpiece. The barcode names
correspond to the names in the recipe data record. Based on the barcode name, the PLC
can read the required recipe data record. The recipe data record is displayed for inspection
on the HMI device. You can now edit and save the recipe data record. Then transfer the
edited recipe data record to the PLC again.

The following figure shows the data flow schematically.

HMI device m
Recipe view @ w

Recipe 1
Recipe 2

o—o Recipe 3
1 ©
Recipe tag

Recipe

screen @ v

The recipe data record is read from the PLC and written to the PLC again following
changes

Display and edit recipe tags in the recipe screen
Tags are synchronized

®e 6 6

Recipe data records are saved in the recipe memory of the HMI device

MP 377, MP 377 PRO (WinCC flexible)
272 Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO



Maintenance and care

11.1

Introduction

Maintaining and caring for the touch screen and keyboard overlay

The HMI device is designed for maintenance-free operation. The touch screen and
keyboard overlay should nevertheless be cleaned regularly.

Requirement

Procedure

® Damp cleaning cloth

® \Washing up liquid or foaming screen cleaning agent

11

NOTICE

Unintentional response

on, you may cause maloperations.

Damage caused by unauthorized cleaning products

damage the HMI device.

Do not clean the HMI device with compressed air or steam jet blowers. Do not use
aggressive solvents or scouring powder.

If you clean the touch screen or an HMI device with a keyboard overlay when it is switched

Switch off the HMI device, or if the HMI device is running, clean the touch screen only in
a blocked state! Note that the touch screen block automatically ends after 15 seconds.

Using compressed air or steam cleaners, or aggressive solutions or scouring agents will

Proceed as follows:

1. Switch off the HMI device or block the touch screen.

2. Spray the cleaning solution onto a cleaning cloth.
Do not spray directly onto the HMI device.

3. Clean the HMI device.

When cleaning the display wipe from the screen edge inwards.

MP 377, MP 377 PRO (WinCC flexible)
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11.2 Clean screen on MP 377 Touch

11.2 Clean screen on MP 377 Touch

Introduction

11.3

Repairs

Spare parts

274

The HMI touch screen can be cleaned when it is switched on and a project is running. An
operating element must be available in the project that can be used to call the "clean"
screen. Once the clean screen is activated, touch screen operation is locked for a configured
period of time. The time the touch screen is locked can be set between 5 and 30 seconds.
The time remaining for the lockout is indicated by a progress bar.

NOTICE
Unintentional responses

When cleaning the touch screen, an unintentional response in the controller can be
triggered by touching keys.

Always open the clean screen or switch off the HMI device before you clean the touch
screen while the system is running!

Once the period for the clean screen has passed, operations are again possible. Avoid data
inadvertent operations.

Cannot be operated when the clean screen is active
When the clean screen is active, operations on the HMI device are not possible.

Wait for the period for the clean screen to lapse. Then you can operate the plant again with
the HMI device.

Spare parts and repairs

In case of repair, the HMI device must be shipped to the Return Center in Firth. Repairs
may only be carried out at the Return Center in Firth.

Depending on the work necessary to repair the device, the Center may decide to give you a
credit note. A credit note is only granted when the sender orders a new HMI device.

The address is:

Siemens AG
Industry Sector
Returns Center
Siemensstr. 2
90766 Furth
Germany

You can find spare parts and accessories for the HMI devices in
the section Accessories [(Page 26).

MP 377, MP 377 PRO (WinCC flexible)
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121 Dimension drawings

1211 Dimension drawings of the MP 377 12" Touch
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12.1 Dimension drawings

12.1.2

276

Dimension drawings of the MP 377 12" Key
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12.1 Dimension drawings

12.1.3 Dimension drawings of the MP 377 15" Touch
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12.1 Dimension drawings

1214 Dimension drawings of the MP 377 19" Touch
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Technical specifications
12.1 Dimension drawings

12.1.5 Dimension drawings of the MP 377 PRO 15" Touch
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12.2 Specifications
12.2 Specifications
HMI device
MP 377 MP 377 MP 377 MP 377 PRO MP 377
12" Touch 12" Key 15" Touch 15" Touch 19" Touch
Weight without packaging 3.75 kg 5.41 kg 4.69 kg Approx. 7.3 kg, 7.65 kg
with basic
adapter approx.
7.7 kg
Display
MP 377 MP 377 MP 377 MP 377 PRO MP 377
12" Touch 12" Key 15" Touch 15" Touch 19" Touch
Type LCD TFT
Display area, active 246 mm x 184.5 mm (12.1") 304.1 mm x 228.1 mm (15") 376.3 mm x
301.1 mm
(19"
Resolution 800 x 600 pixels 1 024 x 768 pixels 1280 x 1024
pixels
Colors, displayable 64 K
Brightness control Yes
Backlighting CCFL
Half brightness life time, typical 50 000 h
Pixel error class according to Il
DIN EN ISO 13406-2
Input device
MP 377 MP 377 MP 377 MP 377 PRO MP 377
12" Touch 12" Key 15" Touch 15" Touch 19" Touch
Type Touch screen, Keyboard Touch screen, analog, resistive
analog, resistive
Memory
MP 377 MP 377 MP 377 MP 377 PRO MP 377
12" Touch 12" Key 15" Touch 15" Touch 19" Touch
Application memory 12 MB
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12.2 Specifications
Interfaces
MP 377 MP 377 MP 377 MP 377 PRO MP 377
12" Touch 12" Key 15" Touch 15" Touch 19" Touch
1 x RS 422/RS 485 Max. 12 Mbps, applies to DP operations
2xUSB 2.0 USB host

Conforms to USB standard 2 (supporting low-speed and full-speed USB devices),
maximum load 500 mA

RJ45 10/100 Mbps

2 x Ethernet

Audio Line out
Supply voltage
MP 377 MP 377 MP 377 MP 377 PRO MP 377
12" Touch 12" Key 15" Touch 15" Touch 19" Touch
Rated voltage +24V DC

Voltage range, permissible

19.2 t0 28.8 V (—20%, +20%)

Transients, maximum
permissible

35V (500 ms)

Time between two transients,
minimum

50s

Current consumption
e Typical

e Constant current,
maximum

e Power on current surge 12t

Approx. 1 300 mA
Approx. 1 800 mA
Approx. 4 A2s

Approx. 1 700 mA
Approx. 2 500 mA
Approx. 4 A%s

Approx. 2 200
mA

Approx. 3 100
mA

Approx. 4 A%s

Fuse, internal Electronic
Miscellaneous
MP 377 MP 377 MP 377 MP 377 PRO MP 377
12" Touch 12" Key 15" Touch 15" Touch 19" Touch
Realtime clock, buffered " Yes
Loudspeaker Onboard

Magnetic field intensity

50/60 Hz;100 A/m RMS

N Bridging time of the buffering - approx. 6 weeks.

MP 377, MP 377 PRO (WinCC flexible)
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12.3 Bit assignment of the direct keys

12.3 Bit assignment of the direct keys

The following figures show the assignment of the keys and LEDs to the bytes in the
PLC process image.

Further information may be available in your plant documentation.

Note

Do not use the LED bits "ACK", "A-Z", and "HELP" when a project is running on
the HMI device.

Bit assignment of the direct keys for the MP 377 12" Key

| Button bits | | LED bits
7 6 5 4 3 2 1 0 Byte 7 6 5 4 3 2 1 0
s8 | s7|s6|s5|s4|s3|s2]| st " s8 | s7|s6|s5|sal|s3|s2]| st

S16 | S15 [ S14 | S13 | S12 | S11 | S10 | S9 n+ 1 S§16 | S15 [ S14 | S13 | S12 | S11 | S10 | S9
F8 | F7 | F6 | F5 | F4 [ F3 | F2 [ F1 n+ 2 F8 | F7 | F6 [ F5 | F4 [ F3 | F2 | H1
F16 [ F15 | F14 | F1I3 | F12 | F11 [ F10 | F9 n+ 3 F16 [ F15 | F14 | F13 | F12 | F11 [ F10 | F9
ACK | ALT [CTRL|SHIFT| F20 | F19 | F18 | F17 n+ 4 ACK | A-Z" A-Z?|INFO| F20 | F19 | F18 | F17

) Left LED
2 Right LED

Bit assignment of the direct keys for the MP 377 12" Touch, MP 377 15" Touch and
MP 377 19" Touch

| Touch assignment |

7 6 5 4 3 2 1 0 Byte
7 6 5 4 3 2 1 0 n
15 | 14 | 13 | 12 | 11 10 9 8 n+1
23 | 22 |21 | 20| 19 | 18 | 17 | 16 n+2
31 | 30 [ 29 | 28 | 27 | 26 | 25 | 24 n+3
39 | 38 | 37 [ 36 | 35 | 34 | 33 [ 32 n+4

MP 377, MP 377 PRO (WinCC flexible)
282 Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO



Technical specifications

12.4 Description of the ports

12.4.1 Power supply

Plug connector, 2-pin

]

12.4 Description of the ports

Pin Assignment
1 +24 VDC (L+)
2 GND 24 V (M)

12.4.2  X10/IF 1B (RS 422/RS 485)

Sub-D socket, 9-pin, with screw lock

5 1
B9
9 6
Pin Assignment for the RS 422 Assignment for the RS 485
1 n. c. n. c.
2 GND 24 V GND 24V
3 TxD+ Data channel B (+)
4 RD+ RTS"
5 GND 5V, floating GND 5V, floating
6 +5 VDC, floating +5 VDC, floating
7 +24 VDC, out (max. 100 mA) +24 VDC, out (max. 100 mA)
8 TxD- Data channel A (-)
9 RxD—- RTS"

N On pin 4 or pin 9, can be set with DIP switch on the rear of the device

MP 377, MP 377 PRO (WinCC flexible)
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12.4 Description of the ports

12.4.3 X1 (PROFINET)
RJ45 plug connector

1

[nanannn
1 8

Pin Assignment
Tx+
Tx—

Rx+

n. c.

n. c.
Rx—

n. c.

n. c.

O IN|oo|a|ldWIN]|~

1244  X20, X21 (USB)
USB socket

=]

Pin Assignment
+5 VDC, out (max. 500 mA)
USB-DN
USB-DP
GND

AW IN]|~-

MP 377, MP 377 PRO (WinCC flexible)
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1245  X40 (line out)

Line out connector

12.4 Description of the ports

Pin

Assignment

Left audio channel

Right audio channel

GND

MP 377, MP 377 PRO (WinCC flexible)
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12.4 Description of the ports
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Appendix l \

A1 ESD guideline

Definition of ESD

All electronic modules are equipped with large-scale integrated ICs or components. Due to
their design, these electronic elements are highly sensitive to overvoltage, and thus to

any electrostatic discharge. These electronic components are therefore specially

identified as ESDs.

Abbreviations
The following abbreviation is commonly used for electrostatic sensitive devices:
® EGB - Elektrostatisch Gefahrdete Bauteile/Baugruppen (Germany)
® ESD - Electrostatic Sensitive Device (internationally recognized term)
Labeling

ESDs are labeled with the following symbol:

A
Atad

Electrostatic charging

CAUTION

Electrostatic charging

ESDs may be destroyed by voltages far below the level perceived by human beings.
Voltages of this kind develop when a component or an assembly is touched by a person
who is not grounded against static electricity. Usually, it is unlikely that damage to an ESD
as a result of overvoltage is detected immediately but may become apparent only after a
longer period of operation.

Prevent electrostatic charging of your body before you touch the ESD!

MP 377, MP 377 PRO (WinCC flexible)
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A.1 ESD guideline

Anyone who is not connected to the electrical potential of their surroundings is subjected to

electrostatic charging.

The following figure indicates the maximum electrostatic charge anyone is subjected to when
coming into contact with the materials shown. These values correspond with specifications

to IEC 801-2.

[kv]

Voltage
>
]

15
14
13
12
11
10

“SNWhOOoN OO

: T T T T T T T T
510 20 30 40 50 60 70 80 90 100 [%]
Relative humidity

©) Synthetic materials
® Wool
® Antistatic materials such as wood or concrete

Protective measures against electrostatic discharge

CAUTION

Observe grounding measures

electrostatic charging.

When working with electrostatic sensitive devices, make sure that the person,
the workplace and the packaging are properly grounded. This helps to avoid

As a rule, only touch the ESD if this is unavoidable, for example for maintenance. When you
touch modules, make sure that you do not touch the pins on the modules or the PCB tracks.
In this way, the discharged energy can not affect the sensitive devices.

Discharge electrostatic electricity from your body if you are performing measurements on an

ESD. Do so by touching grounded metallic parts.

Always use grounded measuring instruments.

MP 377, MP 377 PRO (WinCC flexible)
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A.2 System alarms

A.2 System alarms

Introduction
System alarms on the HMI device provide information about internal states of the HMI device
and PLC.
The following overview shows the causes of system alarms and how to eliminate the cause
of error.

Some of the system alarms described in this section are relevant to individual HMI devices
based on their range of features.

Note

System alarms are only indicated if an alarm window was configured. System alarms are
output in the language currently set on your HMI device.

System alarm parameters

System alarms may contain encrypted parameters which are relevant to troubleshooting
because they provide a reference to the source code of the runtime software. These
parameters are output after the text "Error code:"

MP 377, MP 377 PRO (WinCC flexible)
Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO 289



Appendix

A.2 System alarms

Meaning of the system alarms

All the system alarms that can be displayed are listed below. The system alarms are divided

into different ranges:

10000 - Printer alarms

Number Effect/cause Remedy

10000 The print job could not be started or was canceled | Check the printer settings, cable connections and the
due to an unknown error. Faulty printer setup. Or: power supply.
No authorization is available for accessing the Set up the printer once again. Obtain a network printer
network printer. authorization.
Power supply failure during data transfer. If the error persists, contact the Hotline!

10001 No printer is installed or a default printer has not Install a printer and/or select it as the default printer.
been set up.

10002 Overflow of the graphics buffer for printing. Up to Allow sufficient intervals between successive print jobs.
two images are buffered.

10003 Images can now be buffered again. --

10004 Overflow of the buffer for printing lines in text mode | Allow sufficient intervals between successive print jobs.
(e.g. alarms). Up to 1000 lines are buffered.

10005 Text lines can now be buffered again. --

10006 The Windows printing system reports an error. Repeat the action if necessary.

Refer to the output text and the error ID to
determine the possible causes. Nothing is printed
or the print is faulty.

20000 - Global script alarms

Number Effect/causes Remedy

20010 An error has occurred in the specified script line. Select the specified script line in the configuration.
Execution of the script was therefore aborted. Note | Ensure that the tags used are of the allowed types.
the system alarm that may have occurred prior to Check system functions for the correct number and
this. types of parameters.

20011 An error has occurred in a script that was called by | In the configuration, select the script that has been
the specified script. called directly or indirectly by the specified script.
Execution of the script was therefore aborted in the | Ensure that the tags used are of the allowed types.
called script. Check system functions for the correct number and
Note the system alarm that may have occurred types of parameters.
prior to this.

20012 The configuration data is inconsistent. The script Recompile the configuration.
could therefore not be generated.

20013 The scripting component of WinCC flexible Reinstall WinCC flexible Runtime on your PC.
Runtime is not correctly installed. Therefore, no Rebuild your project with "Project > Generator >
scripts can be executed. Generate" and transfer the project to the HMI device.

20014 The system function returns a value that is not Select the specified script in the configuration.
written in any return tag. Check whether the script name has been assigned a

value.

20015 Too many successive scripts have been triggered | Find what is triggering the scripts. Extend the times,
in short intervals. When more than 20 scripts are e.g. the polling time of the tags which trigger the
queued for processing, any subsequent scripts are | scripts.
rejected. In this case, the script indicated in the
alarm is not executed.

MP 377, MP 377 PRO (WinCC flexible)
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30000 - Alarms for IFwSetValue: SetValue()

A.2 System alarms

Number Effect/causes Remedy

30010 The tag could not accept the function result, e.g. Check the tag type of the system function parameter.
when it has exceeded the value range.

30011 A system function could not be executed because | Check the parameter value and tag type of the invalid
the function was assigned an invalid value or type | parameter. If a tag is used as a parameter, check its
in the parameter. value.

30012 A system function could not be executed because | Check the parameter value and tag type of the invalid

the function was assigned an invalid value or type
in the parameter.

parameter. If a tag is used as a parameter, check its
value.

40000 - Linear scaling alarms

Number Effect/causes Remedy

40010 The system function could not be executed since Check the parameter types in the configuration.
the parameters could not be converted to a
common tag type.

40011 The system function could not be executed since Check the parameter types in the configuration.

the parameters could not be converted to a
common tag type.

50000 - Data server alarms

Number Effect/causes Remedy

50000 The HMI device is receiving data faster than it is --
capable of processing. Therefore, no further data is
accepted until all current data have been
processed. Data exchange then resumes.

50001 Data exchange has been resumed. --

60000 - Win32 function alarms

Number Effect/causes Remedy

60000 This alarm is generated by the --
“DisplaySystemAlarms” function. The text to be
displayed is transferred to the function as a
parameter.

60010 The file could not be copied in the direction defined | Restart the system function or check the paths of the
because one of the two files is currently open or the | source/target files. Using Windows NT/2000/XP: The
source/target path is not available. user executing WinCC flexible Runtime must be
It is possible that the Windows user has no access | granted access rights for the files.
rights to one of the two files.

60011 An attempt was made to copy a file to itself. Check the path of the source/target file.

It is possible that the Windows user has no access | Using Windows NT/2000/XP with NTFS: The user
rights to one of the two files. executing WinCC flexible Runtime must be granted
access rights for the files.

MP 377, MP 377 PRO (WinCC flexible)
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A.2 System alarms

70000 - Win32 function alarms

Number Effect/causes Remedy

70010 The application could not be started because it Check whether the application exists in the specified
could not be found in the path specified or there is | path or close other applications.
insufficient memory space.

70011 The system time could not be modified. Check the time which is to be set.
The error alarm only appears in connection with Using Windows NT/2000/XP: The user executing
area pointer "Date/time PLC". Possible causes: WinCC flexible Runtime must be granted the right to
e Aninvalid time was transferred in the job change the system time of the operating system.
mailbox.
e The Windows user has no right to modify the
system time.

If the first parameter in the system alarm is
displayed with the value 13, the second parameter
indicates the byte containing the incorrect value.

70012 An error occurred when executing the function Close all programs currently running.
"StopRuntime" with the option "Runtime and Then close Windows.

operating system".

Windows and WinCC flexible Runtime are not
closed.

One possible cause is that other programs cannot
be closed.

70013 The system time could not be modified because an | Check the time which is to be set.
invalid value was entered. Incorrect separators may
have been used.

70014 The system time could not be modified. Possible Check the time which is to be set.
causes: Using Windows NT/2000/XP: The user executing
e Aninvalid time was transferred. WinCC flexible Runtime must be granted the right to

« The Windows user has no right to modify the change the system time of the operating system.

system time.
Windows rejects the setting request.

70015 The system time could not be read because --
Windows rejects the reading function.

70016 An attempt was made to select a screen by means | Check the screen number in the function or job with the
of a system function or job. This is not possible screen numbers configured.
because the screen number specified does not Assign the number to a screen if necessary.
exist. Check the details for the screen call and whether the
Or: A screen could not be generated due to screen is blocked for specific users.

insufficient system memory.
Or: The screen is blocked.
Or: Screen call has not been executed correctly.

70017 Date/time is not read from the area pointer because | Change the address or set up the address in the PLC.
the address set in the PLC is either not available or
has not been set up.

70018 Acknowledgment that the password list has been --
successfully imported.

70019 Acknowledgment that the password list has been --
successfully exported.

70020 Acknowledgment for activation of alarm reporting. | --

70021 Acknowledgment for deactivation of alarm --
reporting.

MP 377, MP 377 PRO (WinCC flexible)
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A.2 System alarms

Number

Effect/causes

70022

Acknowledgment to starting the Import Password
List action.

70023

Acknowledgment to starting the Export Password
List action.

70024

The value range of the tag has been exceeded in
the system function.

The calculation of the system function is not
performed.

Check the desired calculation and correct it
if necessary.

70025

The value range of the tag has been exceeded in
the system function.

The calculation of the system function is not
performed.

Check the desired calculation and correct it
if necessary.

70026

No other screens are stored in the internal screen
memory.
No other screens can be selected.

70027

The backup of the RAM file system has been
started.

70028

The files from the RAM have been copied in the
Flash memory.

The files from the RAM have been copied in the
Flash memory. Following a restart, these saved
files are copied back to the RAM file system.

70029

Backup of the RAM file system has failed.
No backup copy of the RAM file system has been
made.

Check the settings in the "Control Panel > OP" dialog
and save the RAM file system using the "Save Files"
button in the "Persistent Storage" tab.

70030

The parameters configured for the system function
are faulty.

The connection to the new PLC was not
established.

Compare the parameters configured for the system
function with the parameters configured for the PLCs
and correct them as necessary.

70031

The PLC configured in the system function is not
an S7 PLC.

The connection to the new PLC was not
established.

Compare the S7 PLC name parameter configured for
the system function with the parameters configured for
the PLC and correct them as necessary.

70032

The object configured with this number in the tab
order is not available in the selected screen.

The screen changes but the focus is set to the first
object.

Check the number of the tab order and correct it if
necessary.

70033

An e-mail cannot be sent because a TCP/IP
connection to the SMTP server no longer exists.
This system alarm is generated only at the first
attempt. All subsequent unsuccessful attempts to
send an e-mail will no longer generate a system
alarm. The event is regenerated when an e-mail
has been successfully sent in the meantime.

The central e-mail component in WinCC flexible
Runtime attempts, in regular intervals (1 minute), to
establish the connection to the SMTP server and to
send the remaining e-mails.

Check the network connection to the SMTP server and
re-establish it if necessary.

70034

Following a disruption, the TCP/IP connection to
the SMTP server could be re-established.
The queued e-mails are then sent.

MP 377, MP 377 PRO (WinCC flexible)
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A.2 System alarms

Number Effect/causes Remedy
70036 No SMTP server for sending e-mails is configured. | Configure an SMTP server:
An attempt to connect to an SMTP server has In WinCC flexible Engineering System
failed and it is not possible to send e-mails. using "Device settings > Device settings"
WinCC flexible Runtime generates the system . .
) . In the Windows CE operating system
alarm after the first attempt to send an e-mail. - . .
using "Control Panel > Internet Settings > E-mail >
SMTP Server"

70037 An e-mail cannot be sent for unknown reasons. Check the e-mail parameters (recipient etc.).
The contents of the e-mail are lost.

70038 The SMTP server has rejected sending or Check the domain of the recipient address or
forwarding an e-mail because the domain of the deactivate the authentication on the SMTP server if
recipient is unknown to the server or because the possible. SMTP authentication is currently not used in
SMTP server requires authentication. WinCC flexible Runtime.

The contents of the e-mail are lost.

70039 The syntax of the e-mail address is incorrect or Check the e-mail address of the recipient.
contains illegal characters.

The contents of the e-mail are discarded.

70040 The syntax of the e-mail address is incorrect or --
contains illegal characters.

70041 The import of the user management was aborted Check your user management or transfer it again to
due to an error. the panel.

Nothing was imported.
70042 The value range for the tags has been exceeded Check the desired calculation and correct it
while executing the system function. if necessary.
The system function calculation has not been
carried out.
70043 The value range for the tags has been exceeded Check the desired calculation and correct it

while executing the system function.

The system function calculation has not been
carried out.

if necessary.

80000 - Archive alarms

Number Effect/causes Remedy
80001 The log specified is filled to the size defined (in Store the file or table by executing a ‘move’ or ‘copy’
percent) and must be stored elsewhere. function.
80002 A line is missing in the specified log. --
80003 The copying process for logging was not --
successful.
In this case, it is advisable to check any
subsequent system alarms, too.
80006 Since logging is not possible, this causes a In the case of databases, check whether the
permanent loss of the functionality. corresponding data source exists and start up the
system again.
80009 A copying action has been completed successfully. | --
80010 Since the storage location was incorrectly entered | Configure the storage location for the respective log
in WinCC flexible, this causes a permanent loss of | again and restart the system when the full functionality
the functionality. is required.
MP 377, MP 377 PRO (WinCC flexible)
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A.2 System alarms

Number Effect/causes Remedy

80012 Log entries are stored in a buffer. If the values are | Archive fewer values.
read to the buffer faster than they can be physically | Or:
written (using a hard disk, for example), Increase the logging cycle.
overloading may occur and recording is then
stopped.

80013 The overload status no longer applies. Archiving --
resumes the recording of all values.

80014 The same action was triggered twice in quick --
succession. Since the process is already in
operation, the action is only carried out once.

80015 This system alarm is used to report DOS or --
database errors to the user.

80016 The logs are separated by the system function Reconnect the logs.

"CloseAllLogs" and the incoming entries exceed
the defined buffer size.
All entries in the buffer are deleted.

80017 The number of incoming events cause a buffer Stop the copy action.
overflow. his can be caused, for example, by
several copying actions being activated at the
same time.

All copy jobs are deleted.

80019 The connection between WinCC flexible and all --
logs were closed, for example, after executing the
system function "CloseAllLogs".

Entries are written to the buffer and are then written
to the logs when a connection is re-established.
There is no connection to the storage location and
the storage medium may be replaced, for example.

80020 The maximum number of simultaneously copy Wait until the current copying actions have been
operations has been exceeded. Copying is not completed, then restart the last copy action.
executed.

80021 An attempt was made to delete a log which is still Wait until the current copying actions have been
busy with a copy action. Deletion has not been completed, then restart the last action
executed.

80022 An attempt was made to use the system function In the project, check
"StartSequencelog" to start a sequence log fora | o If the "StartSequencelLog" system function was
log which is not configured as a sequence log. No properly configured
sequence log file is created. « if the tag parameters are properly provided with

data on the HMI device

80023 An attempt was made to copy a log to itself. In the project, check
The log is not copied. e if the "CopyLog" system function was properly

configured
o if the tag parameters are properly provided with
data on the HMI device

80024 The "CopyLog" system function does not allow Edit the "CopyLog" system function in the project if

copying when the target log already contains data
("Mode" parameter). The log is not copied.

necessary. Before you initiate the system function,
delete the destination log file.

MP 377, MP 377 PRO (WinCC flexible)
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A.2 System alarms

Number

Effect/causes

Remedy

80025

You have canceled the copy operation.

Data written up to this point are retained. The
destination log file (if configured) is not deleted.
The cancellation is reported by an error entry
$RT_ERRS at the end of the destination log.

80026

This alarm is output after all logs are initialized.
Values are written to the logs from then on. Prior to
this, no entries are written to the logs, irrespective
whether WinCC flexible Runtime is active or not.

80027

The internal Flash memory has been specified as
the storage location for a log. This is not
permissible.

No values are written to this log and the log file is
not created.

Configure "Storage Card" or a network path as the
storage location.

80028

The alarm returns a status report indicating that the
logs are currently being initialized. No values are
logged until the alarm 80026 is output.

80029

The number of logs specified in the alarm could not
be initialized. The logs are initialized.

The faulty log files are not available for logging
jobs.

Evaluate the additional system alarms related to this
alarm. Check the configuration, the ODBC (Open
Database Connectivity) and the specified drive.

80030

The structure of the existing log file does not match
the expected structure.
Logging is stopped for this log.

Delete the existing log data manually, in advance.

80031

The log in CSV format is corrupted.
The log cannot be used.

Delete the faulty file.

80032

Logs can be assigned events. These are triggered
as soon as the log is full. If WinCC flexible Runtime
is started and the log is already full, the event is not
triggered.

The log specified no longer logs data because it is
full.

Close WinCC flexible Runtime, delete the log, then
restart WinCC flexible Runtime.

Or:

Configure a button which contains the same actions as
the event and press it.

80033

"System Defined" is set in the data log file as the
data source name. This causes an error. No data is
written to the database logs, whereas the logging to
the CSV logs works.

Install MSDE again.

80034

An error has occurred in the initialization of the
logs. An attempt has been made to create the
tables as a backup. This action was successful. A
backup has been made of the tables of the
corrupted log file and the cleared log was restarted.

No action is necessary. However, it is recommended to
save the backup files or delete them in order to make
the space available again.

80035

An error has occurred in the initialization of the
logs. An attempt has been made to create backups
of the tables and this has failed. No logging or
backup has been performed.

It is recommended to save the backups or to delete
them in order to release memory.

80044

The export of a log was interrupted because
Runtime was closed or due to a power failure. It
was detected that the export needed to be resume
when Runtime restarted.

The export resumes automatically.
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A.2 System alarms

Number Effect/causes Remedy
80045 The export of a log was interrupted due to an error | The export is repeated automatically. Check:
in the connection to the server or at the server e The connection to the server
itself. e If the server is running
e If there is enough free space on the server
80046 The destination file could not be written while Check whether there is enough space on the server
exporting the log. and it you have permission to create the log file.
80047 The log could not be read while exporting it. Check whether the storage medium is correctly
inserted.
80049 The log could not be renamed while preparing to Check whether the storage medium is correctly
export it. inserted and if there is sufficient space on the medium.
The job can not be completed.”
80050 The log which shall be exported is not closed. Make sure the "CloseAll Logs" system function is

The job can not be completed.

called before using the "ExportLog" system function.
Change the configuration as required.

90000 - FDA alarms

Number Effect/causes Remedy

90024 No operator actions can be logged due to lack of Make more space available by inserting an empty
space on the storage medium for log. The operator | storage medium or swapping out the log files on the
action will therefore not be executed. server using "ExportLog".

90025 No user actions can be logged because of error Check whether the storage medium is correctly
state of the archive. Therefore the user action will | inserted.
not be executed.

90026 No operator actions can be logged because the log | Before further operator actions are carried out, the log
is closed. The operator action will therefore not be | must be opened again using the system function
executed. "OpenAllLogs". Change the configuration as required.

90028 The password you entered is incorrect. Enter the correct password.

90029 Runtime was closed during ongoing operation Ensure that you are using the correct storage medium.
(perhaps due to a power failure) or a storage
medium in use is incompatible with Audit Trail. An
Audit Trail is not suitable if it belongs to another
project or has already be archived.

90030 Runtime was closed during ongoing operation --

(perhaps due to a power failure).

90031 Runtime was closed during ongoing operation --
(perhaps due to a power failure).

90032 Running out of space on the storage medium Make more space available by inserting an empty
for log. storage medium or swapping out the log files on the

server using "ExportLog".

90033 No more space on the storage medium for log. As | Make more space available by inserting an empty
of now, no more operator actions requiring logging | storage medium or swapping out the log files on the
will be executed. server using "ExportLog".

90039 You do not have the necessary authorization to Adapt or upgrade your authorizations.
perform this action.

90040 Audit Trail is switched off because of a forced user | Activate the "Audit Trail" again using the system

action.

function "StartLog".
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A.2 System alarms

Number Effect/causes Remedy
90041 A user action which has to be logged has been A user action requiring logging should only be possible
executed without a logged on user. with permission. Change the configuration by setting a
required permission for the input object.
90044 A user action which has to be confirmed was Repeat the user action if necessary.

blocked, because there is another user action
pending.

110000 - Offline function alarms

Number Effect/causes Remedy
110000 The operating mode was changed. "Offline" mode | --
is now set.
110001 The operating mode was changed. "Online" mode | --
is now set.
110002 The operating mode was not changed. Check the connection to the PLCs.
Check whether the address area for the area pointer 88
“Coordination" in the PLC is available.
110003 The operating mode of the specified PLC was --
changed by the system function
"SetConnectionMode".
The operating mode is now "offline".
110004 The operating mode of the specified PLC has been | --
changed by the system function
"SetConnectionMode".
The operating mode is now "online".
110005 An attempt was made to use the system function Switch the complete system to "online" mode, then
SetConnectionMode to switch the specified PLC to | execute the system function again.
"online" mode, although the entire system is in
"offline" mode. This changeover is not allowed.
The PLC remains in "offline" mode.
110006 The content of the "project version" area pointer Check:

does not match the user version configured in
WinCC flexible. WinCC flexible Runtime is
therefore closed.

e The project ID entered on the PLC.
e The project ID entered in WinCC flexible.

120000 - Trend alarms

Number Effect/causes Remedy

120000 The trend is not displayed because you configured | Change the configuration.
an incorrect axis to the trend or an incorrect trend.

120001 The trend is not displayed because you configured | Change the configuration.
an incorrect axis to the trend or an incorrect trend.

120002 The trend is not displayed because the tag Check whether the data area for the tag exists in the
assigned attempts to access an invalid PLC PLC, the configured address is correct and the value
address. range for the tag is correct.
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130000 - System information alarms

A.2 System alarms

Number Effect/causes Remedy
130000 The action was not executed. Close all other programs.
Delete files no longer required from the hard disk.
130001 The action was not executed. Delete files no longer required from the hard disk.
130002 The action was not executed. Close all other programs.
Delete files no longer required from the hard disk.
130003 No data medium found. The operation is canceled. | Check, for example, if
e The correct data medium is being accessed
e The data medium is inserted
130004 The data medium is write-protected. The operation | Check whether access has been made to the correct
is canceled. data carrier. Remove the write protection.
130005 The file is read only. The operation is canceled. Check whether access has been made to the correct
file. Edit the file attributes if necessary.
130006 Access to file failed. The operation is canceled. Check, for example, if
e The correct file is being accessed
e The file exists
e Another action is preventing simultaneous access to
the file
130007 The network connection is interrupted. Check the network connection and eliminate the cause
Records cannot be saved or read over the network | of error.
connection.
130008 The storage card is not available. Insert the storage card.
Records cannot be saved to / read from the
storage card.
130009 The specified folder does not exist on the storage | Insert the storage card.
card.
Any files saved to this directory are not backed up
when you switch off the HMI device.
130010 The maximum nesting depth can be exhausted Check the configuration.

when, for example, a value change in a script
results in the call of another script and the second
script in turn has a value change that results in the
call of yet a further script etc.

The configured functionality is not supported.

140000 - Connection alarms chns7: Connection + device

Number Effect/causes Remedy

140000 An online connection to the PLC is established. --

140001 The online connection to the PLC was shut down. | --

140003 No tag updating or writing is executed. Check the connection and if the PLC is switched on.

Check the parameter definitions in the Control Panel
using "Set PG/PC interface".
Restart the system.
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A.2 System alarms

Number Effect/causes

Remedy

140004 No tag update or write operations are executed
because the access point or the module
configuration is faulty.

Verify the connection and check whether the PLC is
switched on.

Check the access point or the module configuration
(MPI, PPI, PROFIBUS) in the Control Panel with "Set
PG/PC interface".

Restart the system.

140005 No tag updating or writing is executed because the

HMI device address is incorrect (possibly too high).

Use a different HMI device address.

Verify the connection and check whether the PLC is
switched on.

Check the parameter definitions in the Control Panel
using "Set PG/PC interface".

Restart the system.

140006 No tag updating or writing is executed because the
baud rate is incorrect.

Select a different baud rate in WinCC flexible
(according to module, profile, communication peer,
etc.).

140007 Tags are not updated or written because the bus
profile is incorrect (see %1).

The following parameters could not be written to
the registry:

: Tslot

Tqui

Tset

MinTsdr

MaxTsdr

Trdy

Tid1

Tid2

: Gap Factor

10: Retry Limit

OoNIARLON 2

Check the user-defined bus profile.

Check the connection and if the PLC is switched on.
Check the parameter definitions in the Control Panel
using "Set PG/PC interface".

Restart the system.

140008 No tag updating or writing is executed because
baud rate is incorrect. The following parameters
could not be written to the registry:

0: General error

1: Wrong version

2: Profile cannot be written to the registry.

3: The subnet type cannot be written to the

Check the connection and if the PLC is switched on.
Check the parameter definitions in the Control Panel
using "Set PG/PC interface".

Restart the system.

The option “PG/PC is the only master” is not set in
the Control Panel under “Set PG/PC interface.”

registry.
4: The Target Rotation Time cannot be written to
the registry.
5: Faulty Highest Address (HSA).
140009 Tags are not updated or written because the Reinstall the module in the Control Panel using "Set
module for S7 communication was not found. PG/PC interface".
140010 No S7 communication partner found because the | Switch the PLC on.
PLC is shut down. DP/T:
DP/T: If only one master is connected to the network, disable

"PG/PC is the only master" in "Set PG/PC interface".

If several masters are connected to the network, enable
these. Do not change any settings, for this will cause
bus errors.

140011 No tag updating or writing is executed because
communication is down.

Check the connection and that the communication
partner is switched on.
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A.2 System alarms

Number Effect/causes Remedy
140012 There is an initialization problem (e.g. when Restart the HMI device.
WinCC flexible Runtime was closed in Task Or:
Manager). Run WinCC flexible Runtime, then start your other
Or: applications.
Another application (e.g.STEP7) with different bus
parameters is active and the driver cannot be
started with the new bus parameters (transmission
rate, for example).

140013 The MPI cable is disconnected and, thus, there is | Check the connections.
no power supply.

140014 The configured bus address is in already in use by | Edit the HMI device address in the PLC configuration.
another application.

140015 Wrong transmission rate Correct the relevant parameters.

Or:

Faulty bus parameters (e.g. HSA)

Or:

OP address > HSA or: Wrong interrupt vector
(interrupt does not arrive at the driver)

140016 The hardware does not support the configured Change the interrupt number.
interrupt.

140017 The set interrupt is in use by another driver. Change the interrupt number.

140018 The consistency check was disabled by Enable the consistency check with SIMOTION Scout
SIMOTION Scout. Only a corresponding note and once again download the project to the PLC.
appears.

140019 SIMOTION Scout is downloading a new project to | Wait until the end of the reconfiguration.
the PLC. Connection to the PLC is canceled.

140020 The version in the PLC and that of the project The following remedies are available:

(FWX file) do not match.
Connection to the PLC is canceled

Download the current version to the PLC using
SIMOTION Scout.

Regenerate the project using WinCC flexible ES, close
WinCC flexible Runtime and restart with a new
configuration.

150000 - Connection alarms chnAS511: Connection

Number Effect/causes Remedy

150000 No more data is read or written. Possible causes: | Ensure that the cable is plugged in, the PLC is
e The cable is defective operational, the correct port is being used.
« The PLC does not respond, is defective, etc. Restart the system if the system alarm persists.
e The wrong port is used for the connection
e System overload

150001 Connection is up because the cause of the --

interruption has been eliminated.
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A.2 System alarms

160000 - Connection alarms IVar (WinLC) / OPC: Connection

Number Effect/causes Remedy
160000 No more data is read or written. Possible causes: Ensure that the cable is plugged in, the PLC is
e The cable is defective operational, the correct port is being used.
« The PLC does not respond, is defective, etc. Restart the system if the system alarm persists.
e The wrong port is used for the connection
e System overload
160001 Connection is up because the cause of the --
interruption has been eliminated.
160010 No connection to the server because the server Check access rights.
identification (CLS-ID) cannot be determined.
Values cannot be read or written.
160011 No connection to the server because the server Check, for example, if
identification (CLS-ID) cannot be determined. e The server name is correct
Values cannot be read or written. « The computer name is correct
e The server is registered
160012 No connection to the server because the server Check, for example, if
identification (CLS-ID) cannot be determined. e The server name is correct
Values cannot be read or written. « The computer name is correct
e The server is registered
Note for advanced users:
Interpret the value from HRESULT.
160013 The specified server was started as InProc server. | Configure the server as OutProc Server or Local
This has not been released and may possibly lead | Server.
to incorrect behavior because the server is running
in the same process area as the WinCC flexible
Runtime software.
160014 Only one OPC server project can be started on a Do not start a second project with OPC server

PC/MP. An alarm is output when an attempt is
made to start a second project.

The second project has no OPC server
functionality and cannot be located as an OPC
server by external sources.

functionality on the computer.

170000 - S7 dialog alarms

Number Effect/causes Remedy
170000 S7 diagnostics events are not indicated because it | --
is not possible to log on to the S7 diagnostics
functions at this device. The service is not
supported.
170001 The S7 diagnostics buffer cannot be viewed Set the PLC to online mode.
because communication with the PLC is shut
down.
170002 The S7 diagnostics buffer cannot be viewed --
because reading of the diagnostics buffer (SSL)
was canceled with error.
170003 An S7 diagnostics event cannot be visualized. The | --
system returns internal error %2.
MP 377, MP 377 PRO (WinCC flexible)
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Number Effect/causes Remedy
170004 An S7 diagnostics event cannot be visualized. The | --
system returns an internal error of error class %2,
error number %3.
170007 It is not possible to read the S7 diagnostics buffer | --
(SSL) because this operation was canceled with an
internal error of class %2 and error code %3.
180000 - Misc/common alarms
Number Effect/causes Remedy
180000 A component/OCX received configuration data with | Install a newer component.
a version ID which is not supported.
180001 System overload because too many actions Several remedies are available:
running in parallel. Not all the actions can be  Generate the alarms at a slower rate (polling)
executed, some are rejected. ¢ |Initiate scripts and functions at greater intervals
If the alarm appears more frequently:
Restart the HMI device.
180002 The screen keyboard could not be activated. Reinstall WinCC flexible Runtime.

Possible causes:

"TouchlnputPC.exe" was not registered due to a
faulty Setup.

190000 - Tag alarms

Number Effect/causes Remedy
190000 It is possible that the tag is not updated. -
190001 The tag is updated after the cause of the last error | --
state has been eliminated (return to normal
operation).
190002 The tag is not updated because communication Select the system function "SetOnline" to go online.
with the PLC is down.
190004 The tag is not updated because the configured tag | Check the configuration.
address does not exist.
190005 The tag is not updated because the configured Check the configuration.
PLC type does not exist for this tag.
190006 The tag is not updated because it is not possible to | Check the configuration.
map the PLC type in the data type of the tag.
190007 The tag value is not modified because the Set online mode or reconnect to the PLC.
connection to the PLC is interrupted or the tag is
offline.
190008 The threshold values configured for the tag have Observe the configured or current threshold values of

been violated, for example, by
e A value entered

e A system function

e Ascript

the tag.
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Number Effect/causes Remedy
190009 An attempt has been made to assign the tag a Observe the range of values for the data type of the
value which is outside the permitted range of tags.
values for this data type.
For example, a value of 260 was entered for a byte
tag or a value of -3 for an unsigned word tag.
190010 Too many values are written to the tag (for The following remedies are available:
example, in a loop triggered by a script). e Increase the time interval between multiple write
Values are lost because only up to 100 actions are actions.
saved to the buffer. Do not use an array tag longer than 6 words when
you configure an acknowledgment on the HMI
device using "Acknowledgment HMI".
190011 Possible cause 1:
The value entered could not be written to the Make sure that the value entered lies within the range
configured PLC tag because the high or low limit of values of the control tags.
was exceeded.
The system discards the entry and restores the
original value.
Possible cause 2:
The connection to the PLC was interrupted. Check the connection to the PLC.
190012 It is not possible to convert a value from a source | Check the range of values or the data type of the tags.
format to a target format, for example:
An attempt is being made to assign a value to a
counter that is outside the valid, PLC-specific value
range.
A tag of the type Integer should be assigned a
value of the type String.
190013 The user has entered a string that is longer than Only enter strings that do not exceed the permitted tag
the tag. The string is automatically shortened to the | length.
permitted length.
MP 377, MP 377 PRO (WinCC flexible)
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190100 - Area pointer alarms

A.2 System alarms

Number Effect/causes

Remedy

190100 The area pointer is not updated because the
address configured for this pointer does not exist.
Type

Warnings

Errors

PLC acknowledgment

HMI device acknowledgment

LED mapping

Trend request

Trend transfer 1

Trend transfer 2

No.:

Consecutive number displayed in WinCC flexible
ES.

ONO O~ WN -

Check the configuration.

190101 The area pointer is not updated because it is not
possible to map the PLC type to the area pointer
type.

Parameter type and no.:

see alarm 190100

190102 The area pointer is updated after the cause of the
last error state has been eliminated (return to
normal operation). Parameter type and no.: See
alarm 190100.

200000 - PLC coordination alarms

Number Effect/causes

Remedy

200000 Coordination is not executed because the address
configured in the PLC does not exist/is not set.

Change the address or set up the address in the PLC.

200001 Coordination is canceled because the write access | Change the address or set the address in the PLC at an
to the address configured in the PLC is not area which allows write access.
possible.

200002 Coordination is not carried out at the moment Internal error

because the address format of the area pointer
does not match the internal storage format.

200003 Coordination can be executed again because the | --
last error state is eliminated (return to normal
operation).
200004 The coordination may not be executed. --
200005 No more data is read or written. Possible causes: | Ensure that the cable is plugged in and the PLC is

e The cable is defective
e The PLC does not respond, is defective, etc.
e System overload

operational.
Restart the system if the system alarm persists.
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200100 - PLC user version alarms

Number Effect/causes Remedy

200100 Coordination is not executed because the address Change the address or set up the address in the
configured in the PLC does not exist/is not set. PLC.

200101 Coordination is canceled because the write access to | Change the address or set the address in the PLC at
the address configured in the PLC is not possible. an area which allows write access.

200102 Coordination is not carried out at the moment Internal error
because the address format of the area pointer does
not match the internal storage format.

200103 Coordination can be executed again because the last | --
error state is eliminated (return to normal operation).

200104 The coordination may not be executed. --

200105 No more data is read or written. Possible causes: Ensure that the cable is plugged in and the PLC is

e The cable is defective
e The PLC does not respond, is defective, etc.
e System overload

operational.
Restart the system if the system alarm persists.

210000 - PLC job alarms

control request. As a result, the control request is not
executed. Observe the next/previous system alarms.

Number Effect/causes Remedy
210000 Jobs are not processed because the address Change the address or set up the address in the
configured in the PLC does not exist/has not been set | PLC.
up.
210001 Jobs are not processed because read/write access to | Change the address or set up the address in the
the address configured in the PLC is not possible. PLC in an area which allows read/write access.
210002 Jobs are not executed because the address format of | Internal error
the area pointer does not match the internal storage
format.
210003 The job buffer is processed again because the last -
error status has been eliminated (return to normal
operation).
210004 It is possible that the job buffer will not be processed. |--
210005 A control request with an illegal number was initiated. | Check the PLC program.
210006 An error occurred while attempting to execute the Check the parameters of the control request.

Recompile the configuration.

220000 - WInCC channel adapter alarms

Number Effect/causes Remedy
220001 The tag is not downloaded because the associated Change the configuration.
communication driver / HMI device does not support
the download of Boolean/discrete data types.
220002 The tag is not downloaded because the associated Change the configuration.
communication driver / HMI device does not support
write access to the data type BYTE.
220003 The communication driver cannot be loaded. The Install the driver by reinstalling WinCC flexible
driver may not be installed. Runtime.
MP 377, MP 377 PRO (WinCC flexible)
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Number Effect/causes Remedy
220004 Communication is down and no update data is Check the connection.
transferred because the cable is not connected or
defective etc.
220005 Communication is up. -
220006 The connection between the specified PLC and the -
specified port is active.
220007 The connection to the specified PLC is interrupted at | Check whether
the specified port. e The cable is plugged in
e The PLCis OK
e The correct port is used
e Your configuration is OK (port parameters,
protocol settings, PLC address)
Restart the system if the system alarm persists.
220008 The communication driver cannot access or open the | Close all the applications which access this port and

specified port. The port may be in use by another
application or the port used is not available on the
destination device.

There is no communication with the PLC.

restart the computer.
Use another port of the system.

230000 - View alarms

Number

Effect/causes

Remedy

230000

The value entered could not be accepted. The system
discards the entry and restores the previous value.
Either

e The value range has been exceeded
¢ lllegal characters have been entered

e The maximum permitted number of users has
been exceeded

Enter a practical value or delete any unneeded
users.

230002

The currently logged in user has not the required
authorization. The system therefore discards the input
and restored the previous value.

Log on as a user with appropriate authorization.

230003

Changeover to the specified screen failed because
the screen is not available/configured. The current
screen remains selected.

Configure the screen and check the screen selection
function.

230005

The value range of the tag has been exceeded in the
1/O field.
The original value of the tag is retained.

Observe the range of values for the tag when
entering a value.

230100

During navigation in the web browser, the system
returned a message which may be of interest to the
user.

The web browser continues to run but may not (fully)
show the new page.

Navigate to another page.

230200

The connection to the HTTP channel was interrupted
due to an error. This error is explained in detail by
another system alarm.

Data is no longer exchanged.

Check the network connection.
Check the server configuration.

230201

The connection to HTTP channel was established.
Data is exchanged.
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230202 WININET.DLL has detected an error. This error Depending on the cause:

usually occurs when an attempt to connect to the When an attempt to connect fails or a timeout error

server fails or the server refuses to connect because | 5ccyrs:

the client lacks the proper authorization. e Check the network connection and the network

An unknown server certificate may also be the cause

if the connection is encrypted by means of SSL. e Check the server address

The alarm text provides details. e Check whether the WebServer is actually running

This text is always in the language of the Windows on the destination station.

installation because it is returned by the Windows OS. | Faulty authorization:

Process values are no longer exchanged. ¢ The configured user name and/or password do
not match those on the server. Establish
consistency

When the server certificate is rejected:
Certificate signed by an unknown CA ( ):
o Either ignore this item in your project, or
o Install a certificate that has been signed with a
root certificate known to the client computer
The date of the certificate is invalid:
e Either ignore this item in your project, or
o |Install a certificate with a valid date on the server
Invalid CN (Common Name or Computer Name):
o Either ignore this item in your project, or
e Install a certificate with a name that corresponds
to that of the server address
230203 Although a connection can be made to the server, the | Error 503 Service unavailable:
HTTP server refuses to connect because Check that WinCC flexible Runtime is running on the
e WinCC flexible Runtime is not running on the server and the HTTP channel is supported.
server, or
e The HTTP channel is not supported (503 Service
unavailable)

Other errors can only occur if the Webserver does not

support the HTTP channel. The language of the alarm

text depends on the Webserver.

Data is not exchanged.

230301 An internal error has occurred. An English text -

explains the error in more detail. This may be caused

by insufficient memory.

OCX does not work.

230302 The name of the remote server cannot be resolved. Check the configured server address.
The attempt to connect failed. Check whether the DNS service is available on the
network.
230303 The remote server is not running on the addressed Check the configured server address.

computer. Check whether the remote server is running on the

Wrong server address. target computer.

The attempt to connect failed

230304 The remote server on the addressed computer is Use a compatible remote server.
incompatible with VNCOCX.

The attempt to connect failed.

230305 The authentication has failed because the password Configure the correct password.

is incorrect.

The attempt to connect failed.
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230306

Error in the connection to the remote server. This may
occur as a result of network problems.
The attempt to connect failed.

Check whether
e The bus cable is plugged in
e There are network problems

230307

The connection to the remote server was shut down
because

e The remote server was shut down, or

e The user instructed the server to close all
connections

The connection is closed.

230308

This alarm provides information on the connection
status.
An attempt is made to connect.

240000 - Authorization alarms

Number Effect/causes Remedy
240000 WinCC flexible Runtime is operating in demo mode. Install the authorization.
You have no authorization or your authorization is
corrupted.
240001 WinCC flexible Runtime is operating in demo mode. Load an adequate authorization / powerpack.
Too many tags are configured for the installed
version.
240002 WinCC flexible Runtime is operating with a time- Restore the full authorization.
limited emergency authorization.
240004 Error while reading the emergency authorization. Restart WinCC flexible Runtime, install the
WinCC flexible Runtime is operating in demo mode. authorization or repair the authorization (see
Commissioning Instructions Software Protection).
240005 The Automation License Manager has detected an Reboot the HMI device or PC. If this does not solve

internal system fault.
Possible causes:

e A corrupt file
e A defective installation

¢ No free space for the Automation License
Manager etc.

the problem, remove the Automation License
Manager and install it again.

250000 - S7 Force alarms

Number Effect/causes Remedy

250000 The tag in the specified line in "Status Force" is not Check the set address and then verify that the
updated because the address configured for this tag address is set up in the PLC.
is not available.

250001 The tag in the specified line in "Status Force" is not Check the set address.

updated because the PLC type configured for this tag
does not exist.
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250002 The tag in the specified line in "Status Force" is not Check the set address.
updated because it is not possible to map the PLC
type in the tag type.
250003 An attempt to connect to the PLC failed. The tags are | Check the connection to the PLC. Check that the

not updated.

PLC is switched on and is online.

260000 - Password system alarms

Number Effect/causes Remedy

260000 An unknown user or an unknown password has been | Log on to the system as a user with a valid
entered in the system. password.

The current user is logged off from the system.

260001 The logged in user does not have sufficient Log on to the system as a user with sufficient
authorization to execute the protected functions on authorization.
the system.

260002 This alarm is triggered by the system function --

"TrackUserChange".

260003 The user has logged off from the system. --

260004 The user name entered into the user view already Select another user name because user names have
exists in the user management. to be unique in the user management.

260005 The entry is discarded. Enter a shorter user name.

260006 The entry is discarded. Use a shorter or longer password.

260007 The logon timeout value entered is outside the valid Enter a logon timeout value between 0 and 60
range of 0 to 60 minutes. minutes.

The new value is discarded and the original value is
retained.

260008 An attempt was made to read a PTProRun.pwl file -
created with ProTool V 6.0 in WinCC flexible.

Reading the file was canceled due to incompatibility of
the format.

260009 You have attempted to delete the user "Admin" or If you need to delete a user, because perhaps you
"PLC User". These users are fixed components of the | have exceeded the maximum number permitted,
user management and cannot be deleted. delete another user.

260012 The passwords entered in the "Change Password" You have to log on to the system again. Then enter
dialog and the confirmation field are not identical. the identical password twice to be able to change the
The password has not been changed. User will be password.
logged off.

260013 The password entered in the "Change Password" You have to log on to the system again. Then enter
dialog is invalid because it is already in use. a new password that has not been used before.
The password has not been changed. User will be
logged off.

260014 You have tried unsuccessfully to log on 3 times in You can log on to the system with your correct
succession. password. Only an administrator can change the
You will be locked out and assigned to group no. 0. assignment to a group.

260023 The password you entered does not meet the Enter a password that contains at least one number.
necessary security guidelines.

260024 The password you entered does not meet the Enter a password that contains at least one
necessary security guidelines. character.
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260025 The password you entered does not meet the Enter a password that contains at least one special
necessary security guidelines. character.

260028 Upon system start-up, an attempt to log on, or when Check the connection to the SIMATIC Logon Server
trying to change the password of a SIMATIC log-on and its configuration; for example:
user, the system attempts to access the SIMATIC 1. Port number
Logon Server. 2 IP address
If attempting to log on, the new user is not logged in. If 3s
a different user was logged on before, then this user - Servername
is logged off. 4. Functional transfer cable

Or use a local user.

260029 The SIMATIC Logon user is not associated to any or | Check the user data on the SIMATIC Logon Server
several groups. and the configuration in your WinCC flexible project.
The new user is not logged in. If a different user was | A User may only be assigned to one group.
logged on before, then this user is logged off.

260030 The SIMATIC Logon user could not change his Log in again and choose a different password.
password on the SIMATIC Logon Server. The new Check the password rules on the SIMATIC Logon
password may not comply with the password Server.
regulations on the server or the user does not have
the right to change his password.

The old password remains and the user is logged off.

260031 It was not possible to log the user on to the SIMATIC | Try again. If necessary, check the password data on
Logon Server. The user name or the password could | the SIMATIC Logon Server.
be incorrect or the user does not have sufficient rights
to log on.

The new user is not logged in. If a different user was
logged on before, then this user is logged off.

260032 It was not possible to log the user on to the SIMATIC | Check the user data on the SIMATIC Logon Server.
Logon Server as his account is blocked.

The new user is not logged in. If a different user was
logged on before, then this user is logged off.

260033 The action change password or log on user could not | Check the configuration of the SIMATIC Logon
be carried out. Server.

260034 The last logon operation has not yet ended. A user Wait until the logon operation is complete.
action or a logon dialog can therefore not be called.

The logon dialog is not opened. The user action is not
executed.

260035 The last attempt to change the password was not Wait until the procedure is complete.
completed. A user action or a logon dialog can
therefore not be called.

The logon dialog is not opened. The user action is not
executed.

260036 There are insufficient licenses on the SIMATIC Logon | Check the licensing on the SIMATIC Logon Server.
Sever. The logon is not authorized.

260037 There is no license on the SIMATIC Logon Sever. A Check the licensing on the SIMATIC Logon Server.

logon is not possible.

It is not possible to log on via the SIMATIC Logon
Server, only via a local user.
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270000 - System alarms

DLL is missing, a directory is unknown, etc.).

Number Effect/causes Remedy

270000 A tag is not indicated in the alarm because it attempts | Check whether the data area for the tag exists in the
to access an invalid address in the PLC. PLC, the configured address is correct and the value

range for the tag is correct.

270001 There is a device-specific limit as to how many alarms | --
may be queued for output (see the operating
instructions). This limit has been exceeded.
The view no longer contains all the alarms.
However, all alarms are written to the alarm buffer.

270002 The view shows alarms of a log for which there is no | Delete older log data if necessary.
data in the current project.
Wildcards are output for the alarms.

270003 The service cannot be set up because too many Reduce the number of HMI devices which want to
devices want to use this service. use the service.
A maximum of four devices may execute this action.

270004 Access to persistent buffer is not possible. Alarms If the problems persist at the next startup, contact
cannot be restored or saved. Customer Support (delete Flash).

270005 Persistent buffer damaged: Alarms cannot be If the problems persist at the next startup, contact
restored. Customer Support (delete Flash).

270006 Project modified: Alarms cannot be restored from the | The project was generated and transferred new to
persistent buffer. the HMI device; The error should no longer occur

when the device starts again.
270007 A configuration problem is preventing the restore (a Update the operating system and then transfer your

project again to the HMI device.

280000 - DPHMI alarms Connection

Number Effect/causes Remedy
280000 Connection is up because the cause of the --
interruption has been eliminated.
280001 No more data is read or written. Possible causes: Check whether
e The cable is defective e The cable is plugged in
e The PLC does not respond, is defective, etc. e The PLCis OK
e The wrong port is used for the connection e The correct port is used
e System overload Restart the system if the system alarm persists.
280002 The connection used requires a function block in the | --
PLC.
The function block has responded. Communication is
now enabled.
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Remedy

280003

The connection used requires a function block in the
PLC.
The function block has not responded.

Check whether

e The cable is plugged in
e The PLCis OK

e The correct port is used

Restart the system if the system alarm persists.
Remedy depends on the error code:

1: The function block must set the COM bit in the
response container.

2: The function block must not set the ERROR bit in
the response container.

3: The function block must respond within the
specified time (timeout).

4: Go online to the PLC.

280004

The connection to the PLC is interrupted. There is no
data exchange at present.

Check the connection parameters in WinCC flexible.
Ensure that the cable is plugged in, the PLC is
operational, the correct port is being used.

Restart the system if the system alarm persists.

290000 - Recipe system alarms

Number Effect/causes Remedy
290000 The recipe tag could not be read or written. It is Check in the configuration that the address has been
assigned the start value. set up in the PLC.
The alarm can be entered in the alarm buffer for up to
four more failed tags if necessary. After that, alarm
290003 is output.
290001 An attempt has been made to assign a value to a Observe the value range for the tag type.
recipe tag which is outside the value range permitted
for this type.
The alarm can be entered in the alarm buffer for up to
four more failed tags if necessary. After that, alarm
290004 is output.
290002 It is not possible to convert a value from a source Check the value range or type of the tag.
format to a target format.
The alarm can be entered in the alarm buffer for up to
four more failed recipe tags if necessary. After that,
alarm 290005 is output.
290003 This alarm is output when alarm number 290000 is Check in the configuration that the tag addresses
triggered more than five times. have been set up in the PLC.
In this case, no further separate alarms are
generated.
290004 This alarm is output when alarm number 290001 is Observe the value range for the tag type.
triggered more than five times.
In this case, no further separate alarms are
generated.
290005 This alarm is output when alarm number 290002 is Check the value range or type of the tag.
triggered more than five times.
In this case, no further separate alarms are
generated.
290006 The threshold values configured for the tag have been | Observe the configured or current threshold values

violated by values entered.

of the tag.
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290007 There is a difference between the source and target Insert the specified data recipe tag in the source
structure of the recipe currently being processed. The | structure.
target structure contains an additional data recipe tag
which is not available in the source structure.
The data recipe tag specified is assigned its start
value.
290008 There is a difference between the source and target Remove the specified data recipe tag in the specified
structure of the recipe currently being processed. The | recipe from the project.
source structure contains an additional data recipe tag
which is not available in the target structure and
therefore cannot be assigned.
The value is rejected.
290010 The storage location configured for the recipe is not Check the configured storage location.
permitted.
Possible causes:
lllegal characters, write protection, data carrier out of
space or does not exist.
290011 The record with the specified number does not exist. | Check the source for the number (constant or tag
value)
290012 The recipe with the specified number does not exist. Check the source for the number (constant or tag
value)
290013 An attempt was made to save a record under a record | The following remedies are available:
number which already exists. e Check the source for the number (constant or tag
The action is not executed. value)
e First, delete the record
e Change the "Overwrite" function parameter
290014 The file specified to be imported could not be found. Check:
e The file name
e Ensure that the file is in the specified directory
290020 Alarm reporting that the download of records from the | --
HMI device to the PLC has started.
290021 Alarm reporting that the download of records from the | --
HMI device to the PLC was completed.
290022 Alarm reporting that the download of records from the | Check in the configuration whether:
HMI device to the PLC was canceled due to an error. | 4  The tag addresses are configured in the PLC
e The recipe number exists
e The record number exist
e The "Overwrite" function parameter is set
290023 Alarm reporting that the download of records from the | --
PLC to the HMI device has started.
290024 Alarm reporting that the download of records from the | ---
PLC to the HMI device was completed.
290025 Alarm reporting that the download of records from the | Check in the configuration whether:
PLC to the HMI device was canceled due to an error. | 4 The tag addresses are configured in the PLC
e The recipe number exists
e The record number exist
e The "Overwrite" function parameter is set
MP 377, MP 377 PRO (WinCC flexible)
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290026 An attempt has been made to read/write a record Set the record status to zero.
although the record is not free at present.
This error may occur in the case of recipes for which
downloading with synchronization has been
configured.
290027 Unable to connect to the PLC at present. As a result, | Check the connection to the PLC.
the record can neither be read nor written.
Possible causes:
No physical connection to the PLC (no cable plugged
in, cable is defect) or the PLC is switched off.
290030 This alarm is output after you selected screen which Reload the record from the storage location or retain
contains a recipe view in which a record is already the current values.
selected.
290031 While saving, it was detected that a record with the Overwrite the record or cancel the action.
specified number already exists.
290032 While exporting records it was detected that a file with | Overwrite the file or cancel the process.
the specified name already exists.
290033 Confirmation request before deleting records. --
290040 A record error with error code %1 that cannot be Check the storage location, the record, the "Data
described in more detail occurred. record" area pointer and if necessary, the connection
The action is canceled. to the PLC.
It is possible that the record was not installed correctly | Restart the action after a short time.
on the PLC. If the error persists, contact Customer Support.
Forward the relevant error code to Customer
Support.
290041 A record or file cannot be saved because the storage | Delete files no longer required.
location is full.
290042 An attempt was made to execute several recipe Trigger the action again after waiting a short period.
actions simultaneously. The last action was not
executed.
290043 Confirmation request before storing records. --
290044 The data store for the recipe has been destroyed and | --
is deleted.
290050 Alarm reporting that the export of records has started. | --
290051 Alarm reporting that the export of records was --
completed.
290052 Alarm reporting that the export of records was Ensure that the structure of the records at the
canceled due to an error. storage location and the current recipe structure on
the HMI device are identical.
290053 Alarm reporting that the import of records has started. | --
290054 Alarm reporting that the import of records was --
completed.
290055 Alarm reporting that the import of records was Ensure that the structure of the records at the
canceled due to an error. storage location and the current recipe structure on
the HMI device are identical.
290056 Error when reading/writing the value in the specified Check the specified line/column.

line/column.
The action was canceled.
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290057

The tags of the recipe specified were toggled from
"offline" to "online" mode.

Each change of a tag in this recipe is now
immediately downloaded to the PLC.

290058

The tags of the specified recipe were toggled from
"offline" to "online" mode.

Modifications to tags in this recipe are no longer
immediately transferred to the PLC but must be
transferred there explicitly by downloading a record.

290059

Alarm reporting that the specified record was saved.

290060

Alarm reporting that the specified record memory was
cleared.

290061

Alarm reporting that clearing of record memory was
canceled due to an error.

290062

The record number is above the maximum of 65536.
This record cannot be created.

Select another number.

290063

This occurs with the system function
"ExportDataRecords" when the parameter "Overwrite
is set to No.

An attempt has been made to save a recipe under a
file name which already exists.

The export is canceled.

Check the "ExportDataRecords" system function.

290064

Alarm reporting that the deletion of records has
started.

290065

Alarm reporting that the deletion of records has
successfully completed.

290066

Confirmation request before deleting records.

290068

Security request to confirm if all records in the recipe
should be deleted.

290069

Security request to confirm if all records in the recipe
should be deleted.

290070

The record specified is not in the import file.

Check the source of the record number or record
name (constant or tag value).

290071

During the editing of record values, a value was
entered which exceeded the low limit of the recipe
tag.

The entry is discarded.

Enter a value within the limits of the recipe tag.

290072

When editing record values, a value was entered
which exceeds the high limit of the recipe tag.
The entry is discarded.

Enter a value within the limits of the recipe tag.

290073

An action (e.g. saving a record) failed due to an
unknown error.

The error corresponds to the status alarm
IDS_OUT_CMD_EXE_ERR in the large recipe view.

290074

While saving, it was detected that a record with the
specified number already exists but under another
name.

Overwrite the record, change the record number or
cancel the action.

290075

A record with this name already exists.
The record is not saved.

Please select a different record name.
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290110 The default values could not be set due to an error. --
290111 The Recipes subsystem cannot be used. Recipe Transfer the project to the device again, together

views have no content and recipe-specific functions
will not be performed.

Possible causes:
e An error occurred while transferring the recipes.

e The recipe structure was changed in ES. When
the project was downloaded again, the recipes
were not transferred with it. This means that the
new configuration data is not being transferred to
the old recipes on the device.

with the recipes (the corresponding check box in the
Transfer dialog must be checked).

300000 - Alarm_S alarms

Number Effect/causes Remedy
300000 Faulty configuration of process monitoring (e.g. using | Change the PLC configuration.
PDiag or S7-Graph): More alarms are queued than
specified in the specifications of the CPU. No further
ALARM_S alarms can be managed by the PLC and
reported to the HMI devices.
300001 ALARM_S is not registered on this PLC. Select a controller that supports the ALARM_S

service.

310000 - Report system alarms

Number Effect/causes Remedy

310000 An attempt is being made to print too many reports in | Wait until the previous active log was printed.
parallel. Repeat the print job if necessary.
Only one log file can be output to the printer at a given
time; the print job is therefore rejected.

310001 An error occurred on triggering the printer. The report | Evaluate the additional system alarms related to this

is either not printed or printed with errors.

alarm.
Repeat the print job if necessary.

320000 - Alarms

Number Effect/causes Remedy

320000 The movements have already been indicated by Deselect the movements on the other display units
another device. and select the motion control screen on the required
The movements can no longer be controlled. display unit.

320001 The network is too complex. View the network in STL.
The faulty addresses cannot be indicated.

320002 No diagnosable alarm message (error) selected. Select a diagnostics alarm from the ZP_ALARM
The unit associated with the alarm message could not | alarm screen.
be selected.

320003 No alarm message (error) exists for the selected unit. | Select the defective unit from the overview screen.
The detail view cannot visualize any networks.

320004 The required signal states could not be read by the Check the consistency between the configuration on

PLC. The faulty addresses cannot be found.

the display unit and the PLC program.
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320005 The project contains ProAgent elements which are not | In order to run the project, install the optional
installed. ProAgent diagnostic functions cannot be ProAgent package.
performed
320006 You have attempted to execute a function which is not | Check the type of the selected unit.
supported in the current constellation.
320007 No error-triggering addresses were found on the Switch the detail screen to STL layout mode and
networks. check the status of the addresses and exclusion
ProAgent cannot indicate any faulty addresses. addresses.
320008 The diagnostic data stored in the configuration are not | Transfer the project to the HMI device again.
synchronized with those in the PLC.
ProAgent can only indicate the diagnostic units.
320009 The diagnostic data stored in the configuration are not | Transfer the project to the HMI device again.
synchronized with those in the PLC. The diagnostic
screens can be operated as usual.
ProAgent may be unable to show all diagnostic texts.
320010 The diagnostic data stored in the configuration are not | Transfer the project to the HMI device again.
synchronized with those in STEP7.
The ProAgent diagnostics data is not up-to-date.
320011 A unit with the corresponding DB number and FB Check the parameters of the "SelectUnit" function
number does not exist. and the units selected in the project.
The function cannot be executed.
320012 The "Step sequence mode" dialog is no longer Use the ZP_STEP step sequence screen from the
supported. corresponding standard project for your project.
Instead of calling the
Overview_Step_Sequence_Mode function, call the
"FixedScreenSelection" function using ZP_STEP as
the screen name.
320014 The selected PLC cannot be evaluated for ProAgent. | Check the parameters of the

The Alarm view assigned to the
"EvaluateAlarmDisplayFault" system function could
not be found.

"EvaluateAlarmDisplayFault" system function.

330000 - GUI alarms

Number Effect/causes Remedy
330022 Too many dialogs are open on the HMI device. Close all dialogs you do not require on the HMI
device.
330026 The password will expire after the number of days Enter a new password.
shown.
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350000 PROFIsafe packages have not arrived within the Check the WLAN connection.
necessary period.

There is a communication problem with the F-CPU.
RT is terminated

350001 PROFIsafe packages have not arrived within the Check the WLAN connection.
necessary period.

There is a communication problem with the F-CPU.
The PROFIsafe connection is re-established.

350002 An internal error has occurred. Internal error
Runtime is terminated

350003 Feedback concerning the connection established with | --
the F-CPU.

The Emergency-Off buttons are active immediately.

350004 PROFIsafe communication was set and the --

connection was cleared.

The Runtime can be terminated.

The Emergency-Off buttons are deactivated
immediately.

350005 Incorrect address configured for the F-slave. Check and modify the address of the F slave in
No PROFIsafe connection. WinCC flexible ES.

350006 The acknowledgement buttons in the Press the two acknowledgement buttons one after
"Acknowledgement" and "Panic" functions were not another in the "Acknowledgement" and "Panic"
tested before logging on. positions.

It is not possible to log onto the effective range.

350008 The wrong number of failsafe buttons was configured. | Change the number of failsafe buttons in the project.
No PROFIsafe connection.

350009 The device is in Override mode. Exit Override mode.

It may no longer be possible to detect the location
because transponder detection fails.
350010 Internal error: The device has no failsafe buttons. Send the device back.

Worldwide contact person
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ANS|
CPU
Csv
CTS
DC
DCD
DHCP
DIL
DNS
DP
DSN
DSR
DTR

ESD
EMC

PPI
RAM
PELV
RJ45
RTS

MP 377, MP 377 PRO (WinCC flexible)

American National Standards Institution
Central Processing Unit

Comma Separated Values

Clear To Send

Direct Current

Data Carrier Detect

Dynamic Host Configuration Protocol
Dual-in-Line (electronic chip housing design)
Domain Name System

Distributed /O

Data Source Name

Data Set Ready

Data Terminal Ready

Input and Output

Components and modules endangered by electrostatic discharge
Electromagnetic Compatibility
European standard

Engineering System

Components and modules endangered by electrostatic discharge
Ground

High Frequency

Human Machine Interface

International Electronic Commission
Interface

Internet Protocol

Light Emitting Diode

Media Access Control

Metal Oxide Semiconductor

Multipoint Interface (SIMATIC S7)
Microsoft

Mean Time Between Failures

Not connected

Operator Panel

Personal Computer

Programming device

Point-to-Point Interface (SIMATIC S7)
Random Access Memory

Protective Extra Low Voltage
Registered Jack Type 45

Request to send
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RxD
SD Card
SELV
SP
PLC
STN
Sub-D
TAB
TCP/IP
TFT
TTY
TxD
UL
uUSB
UPS
WINS

Receive Data

Security Digital Card

Safety Extra Low Voltage

Service Pack

Programmable Logic Controller
Super Twisted Nematic
Subminiature D (plug)

Tabulator

Transmission Control Protocol/Internet Protocol
Thin Film Transistor

Teletype

Transmit Data

Underwriter’s Laboratory
Universal Serial Bus
Uninterruptible power supply
Windows Internet Naming Service

MP 377, MP 377 PRO (WinCC flexible)
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"Transfer" mode

An operating mode of the HMI device in which an executable project is transferred from the
configuring PC to an HMI device.

Acknowledge

Acknowledgment of an alarm confirms that it has been noted.

Alarm logging

Output of user-specific alarms to a printer, in parallel to their output to
the HMI device screen.

Alarm, acknowledging
Acknowledgment of an alarm confirms that it has been noted.

Alarm, activated
Moment at which an alarm is triggered by the PLC or HMI device.

Alarm, deactivated

Moment at which the initiation of an alarm is reset by the PLC.

Alarm, user-specific

A user-specific alarm designates a certain operating status of the plant connected to
the HMI device via the PLC.

Automation device
PLC of the SIMATIC S5 series, for example the AG S5-115U

Automation system
Controller of the SIMATIC S7 series, for example a SIMATIC S7-300

Bootloader

Used to start the operating system. Automatically started when the HMI device is switched
on. After the operating system has been loaded, the Loader opens.
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Configuration software

Configuring PC

Display duration

EMC

Event

Field array

Flash memory

Function keys

Software used to generate projects used for the purpose of process visualization.
An example of configuring software is WinCC flexible.

A configuring PC is a programming device or PC on which plant projects are created using
an engineering software.

Defines whether a system alarm is displayed on the HMI device and the duration of
the display.

Electromagnetic compatibility is the ability of electrical equipment to function properly in its
electromagnetic environment without influencing this environment.

Functions are triggered by defined incoming events. Events can be configured. Events which
can be assigned to a button include "Press" and "Release", for example.

Area reserved in configured screens for the input and output of values.

Non-volatile memory with EEPROM chips, used as mobile storage medium or as memory
module installed permanently on the motherboard.

Key on the HMI device which supports user-specific functions. A function is assigned to
the key in the configuration. The assignment of the keys may be specific to an active
screen or not.

Half Brightness Life Time

Hardcopy

324

Time period after which the brightness reaches 50% of the original value. The specified
value is dependent on the operating temperature.

Output of the screen content to a printer.

MP 377, MP 377 PRO (WinCC flexible)
Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO



Glossary

HMI device

An HMI device is a device used for the operation and monitoring of machines and plants.
The statuses of the machine or plant are indicated by means of graphic elements or by
indicator lamps on the HMI device. The operating elements of the HMI device allow the
operator to interact with the processes of the machine or plant.

HMI device image

A file that can be transferred from the configuring PC to the HMI device. The HMI device
image contains the operating system and elements of the runtime software required to
run a project.

I/O field
An 1/O field enables the input or output of values on the HMI device which are transferred
to the PLC.
Infotext
An infotext is a configured information on objects within a project. Infotext for an alarm, for
example, may contain information on the cause of the fault and troubleshooting routines.
Object

An object is a component of a project. Example: screen or alarm. Objects are used to view or
enter texts and values on the HMI device.

Operating element

Component of a project used to enter values and trigger functions. A button, for example, is
an operating element.

Plant
General term referring to machines, processing centers, systems, plants and processes
which are operated and monitored on an HMI device.

PLC
A PLC is a general term for devices and systems with which the HMI device communicates,
e.g. SIMATIC S7.

PLC job

A PLC job triggers a function for the PLC at the HMI device.
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Process visualization

Visualization of technical processes by means of text and graphic elements. Configured
plant screens allow operator intervention in active plant processes by means of the input and
output data.

Project

Result of a configuration using a configuration software. The project normally contains
several screens with embedded system-specific objects, basic settings and alarms. The
project file of a project configured in WinCC flexible is saved under the file name
extension *.hmi.

You need to distinguish between a project on the configuring PC and that on an HMI device.
A project may be available in more languages on the configuring PC than can be managed
on the HMI device. The project on the configuring PC can also be set up for different HMI
devices. Only the runtime project that has been generated for the respective HMI device can
be transferred to it.

Project file

File generated from the runtime project file for use on the HMI device. The project file is
normally not transferred and remains on the configuring PC.

The file name extension of a source file is *.hmi.

Project file, compressed

Compressed format of the project file. The compressed project file can be transferred
together with the runtime project file to the respective HMI device. For this purpose,
backtransfer must be enabled in the project on the configuring PC. The compressed project
file is normally stored on an external memory card.

The file extension of a compressed file is *.pdz.

Recipe

Combination of tags forming a fixed data structure. The data structure configured can be
assigned data on the HMI device and is then referred to as a record. The use of recipes
ensures that all the assigned data is transferred synchronously to the PLC during the
transfer of a record.

Runtime project file

File generated from the project file for a specific HMI device. The runtime project file is
transferred to the corresponding HMI device and used to operate and monitor plants.

The extension of a compressed file is *.pdz.

Runtime software

The runtime software is a process visualization software used to test a project on a
configuring PC.
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Screen

Screen object

Form of the visualization of all logically related process data for a plant. The visualization of
the process data can be supported by graphic objects.

Configured object used to display or operate the plant, e.g. rectangle, I/O field or alarm view.

STEP 7
STEP 7 is the programming software for SIMATIC S7, SIMATIC C7 and
SIMATIC WinAC PLCs.

STEP 7 Micro/WIN

STEP 7 Micro/WIN is the programming software for SIMATIC S7-200 PLCs.

Symbolic 1/O field

System alarm

Tab sequence

Tag

Transfer

A symbolic I/O field is a field for the input and output of the value. Contains a list of default
entries from which one can be selected.

A system alarm is assigned to the "System" alarm class. A system alarm refers to internal
states on the HMI device and the PLC.

During configuration, this defines the sequence in which objects are activated on
pressing the <TAB> key.

Defined memory location to which values can be written to and read from. This can be done
from the PLC or the HMI device. Based on whether the tag is interconnected with the PLC or
not, we distinguish between "external" tags (process tags) and "internal" tags.

Transfer of a runtime project from the configuring PC to the HMI device.
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/
/Audit, 32

A

Accessory Kit, 25
ACK, 239
ACK key, 203
Acknowledge
Alarm, 203, 243
Error alarm, 243
Acknowledge key, 203
Acoustic feedback, 191
Acoustic signal, 196
For inadvertent operation, 191
with inadvertent operation, 99
Acoustics
Feedback, 122, 124
Address assignment
TCP/IP network, 145
Addressing, 142
Admin, 233, 234, 235
Alarm, 237
Acknowledge, 203, 243
Editing, 244
Functional scope, 29
LED, 240
Alarm buffer, 238
Functional scope, 29
Alarm class, 238, 241
Alarm event, 237
Alarm group, 238
Alarm indicator, 239
Alarm line, 240
Alarm log, 238
Alarm report, 238
Alarm view, 240
Expanded, 240
Simple, 240
Alarm window, 241
ALARM_S, 29
Alphanumerical
Key assignment, 105, 202
Screen keyboard, 197
Alphanumerical value
Changing, 207

MP 377, MP 377 PRO (WinCC flexible)
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Editing, 198

Entering, 198, 207
ALT key, 105, 202
Ambient conditions

Climatic, 46

Mechanical, 45

Test, 46
Approvals, 39
Authorization, 224
Automatic

Transfer, 164
Automation License Manager, 186
A-Z key, 105, 202

B

Backlighting
Reducing, 119
Setting, 99
Backspace key, 104, 202
Backtransfer, 163, 166
Backup, 98, 155, 162, 168, 169, 171, 225
Registry Information, 98, 116
Temporary files, 116
to external storage device, 98, 153
With ProSave, 171
With WinCC flexible, 169
Bar, 210
Basic adapter, 27
Basic knowledge
Required, 3
Booting, 125
Bottom view, 15,17, 19, 21, 23
Brightness
Changing, 118
Browser
Home page, 98
Setting, 98
Bus connection, 33
Bus parameters
Profile, 141

C

Cable

Data exchange, 76
Cables

Connecting, 61
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Calibrating UPS, 67

Touch screen, 98, 110 USB device, 74
Cancel Connection, 33

Secure mode, 94 Connection graphic
Cancel UPS, 67

Password protection, 113 Connection sequence, 61
Cancel key, 104, 202 Connections to PLC
Care, 273 Number, 33
CE approval, 39 Contact person, 5
Certificate Control cabinet

Delete, 98, 152 Working on, 38

Importing, 98, 152 Control key, 82

LED, 98 Keyboard unit, 104
Changing Control panel

Brightness, 118 Password protection, 92

User data, 233, 234 Control Panel, 96
Character repeat, 98 MPI, 140

Screen keyboard, 107 Open, 97
Clean screen, 274 Operating, 100, 102
Cleaning product, 273 PROFIBUS, 140
Clearance Screen keyboard, 101

MP 377, 49 Conventions, 4
Climatic Cookies, 98, 150

Storage conditions, 44 Creating

Transport conditions, 44 Recipe data record, 255, 264
Closing Users, 230

Project, 236 C-Tick mark (Australia), 40

Rear wall, 80 CTRL key, 105, 202
Column sequence Currency, 98

Alarm view, 241 Cursor key, 82, 104, 201

Compeatibility conflict, 168
Conductor cross-section, 65
Equipotential bonding, 63 D
Configuration PC
Connecting, 71
Wiring diagram, 71
Configuration phase, 159

Data channel
Enabling, 136
Locking, 136
Parameter assignment, 99, 136

Configure
Screen keyboard, 98, 106 Data flow, P49
Configuring pate. B
Entering, 199, 208
Network, 143 Setting, 114

Operating system, 89

PC/PPI cable, 72

RS-422/RS-485 port, 70
Configuring PC, 159
Connecting

Configuration PC, 71

Equipotential bonding, 63

Mains terminal, 66

Synchronizing, 115
Date format, 98, 116
Date/time properties, 98, 114
Decimal, 195
Default gateway, 146
Degree of protection, 48
Protection against ingress of solid foreign

bodies, 50, 52
PLC, 68 Protection against water, 50, 52
Power supply, 65, 66 Delay time
Printer, 75 i
PROEINET. B3 Setting, 99, 131
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Delete
Certificate, 98, 152
Recipe data record, 258, 266
Users, 235
Delete key, 104, 202
Device name
For network operation, 144
Setting, 99
Dewing, 44
DHCP, 146
DIP switch
Setting, 70
Direct key, 192
Bit assignment, 282
Functional scope, 31
Display
MP 377, 280
Display format, 205
Displaying
Info text, 200, 209
Information on the MP 377, 127
Infotext, 203
Memory information, 129
System information, 129
Disposal, 5
Disturbance
Pulse-shaped, 42
Sinusoidal, 43
DNS, 1146
Server, 142
Documentation
Enclosed, 53
Double-click, 98
Setting, 108
Drop down list, 199, 208
Drop down list box
Open, 104, 202

E

EC Declaration of Conformity, 39
Editing
Alarm, 244
Recipe data record, 257, 265
Elbow adapter, 26
Electrical isolation
Safe, 66
Electrical potential difference, 63
Electrostatic charging, 287
Electrostatic discharge
Electrostatic, 287
Precautions, 288
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Element list, 251, 262
E-Mail
Setting, 99, 148
EMC directive, 39
Emission, 41, 43
Encryption, 150
END key, 104, 201
Enhanced alarm view, 240
Enhanced recipe view, 250
Enhanced user view, 226
Enter key, 202
ENTER key, 104, 202
Entering
Alphanumerical value, 198, 207
Date, 199, 208
Key combination, 105, 202
Numerical value, 196, 206
Recipe data record, 271
Symbolic value, 199
Text box, 194
Time, 199, 208
Entry on the HMI device
By means of function key, 204
Using operating elements, 189
Equipotential bonding
Cable, 64
Connecting, 63
Requirements, 63
Wiring diagram, 64
Equipotential bonding rail, 64
Error alarm
Acknowledge, 243
ESC key, 104, 202
ESD
Abbreviations, 287
Labeling, 287
Ethernet settings
IP address, 146
Excel Viewer, 32
Explorer
Operating, 91
Exporting
Recipe data record, 270
External
Keyboard, 100
Mouse, 100

F

Factory setting
With ProSave, (180
With WinCC flexible, 178
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Factory settings, 73

Feedback
Acoustic, 122, 124, 191
Optical, 191

FM Approval, 40
FN key, 105, 202
Front view, 15, 17, 19, 21, 23
Function
Additional, 31
Function key
Labeling, 86
Function keys, 82
Global assignment, 204
Local assignment, 204
Function test, 78
Functional scope
Alarm buffer, 29
ALARM_S, 29
Alarms, 29
Graphics list, 29
Info text, 31
Limit value monitoring, 29
Log, 30
Recipe, 30
Safety, 31
Scaling, 29
Screen, 30
Tags, 29
Text list, 29

G

Gauge, 210
Graphics list

Functional scope, 29
Group acknowledgement, 203

H

High frequency radiation, 37
HMI device
EMC-compatible installation, 42
Information, 98
Mounting, 57, 59
Ports, 62
Restart, 125
Restarting, 98
Shutting down, 78
Switching on, 77
Technical specifications, 280
Testing, 77
HMI Input Panel
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Options, 106
HOME key, 104, 201
Home page

Internet, 149
Host cable

Safety instruction, 73

Identification, 147
Importing

Certificate, 98, 152

Recipe data record, 269
Inadvertent operation

Acoustic signal, 99, 191
Info text

Displaying, 200, 209

Functional scope, 31
Information

For the HMI device, 127
Infotext

Displaying, 203

Key, 203

LED, 242
Initial startup, 159
Input device

MP 377, 280
Input Panel, 98
Installing

Option, 162, 182, 183, 185
Instructions

General, 41
Insulation test

Test voltage, 50, 52
Interface

Rated load, 74
Interfaces

MP 377, 281
Internal clock, 115
Internet

Browser, 92

Explorer, 92

Home page, 149

Options, 98

Search engine, 149

Security settings, 98

Service, 5

Settings, 99, 148

Support, 5
Internet options

Privacy, 151
IP address

MP 377, MP 377 PRO (WinCC flexible)
Operating Instructions, 10/2008, 6AV6691-1DR01-0ABO



Index

Ethernet, 146
Setting, 98

K

Key
ACK, 203
ALT, 105, 202
A-Z, 105, 202
Backspace, 202
Cancel, 104
CTRL, 1105, 202
Cursor, 104, 201
Delete, 104, 202
END, 104, 201
ENTER, 104, 202
ESC, 104, 202
FN, 105, 202
HOME, 104, 201
Infotext, 203
Scroll back, 104, 201
Scroll forward, 104, 201
SHIFT, 105, 202
TAB, 104, 201
Tabulator, 104
Key combination
Entering, 105, 202
Key control, 201, 205
Trend view, 214
Keyboard
External, 100
Safety instruction, 82
Keyboard properties, 98

L

Labeling
Approvals, 40
EC Declaration of Conformity, 39
Function key, 86
Labeling strips
Attaching, 87
Dimensions, 86
Printing, 86
LAN connection, 98
Language change
Functional scope, 31
Layout
Slider control, 214
Sm@rtClient view, 220
Trend view, 212
LED
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Alarm, 240
Certificate, 98
HMI device information, 98
Infotext, 242
Memory information, 128
System information, 128
LED ACK, 239
License key, 186
Transferring, 162, 187
Transferring back, 162, 188
Limit value
For password, 225
For user, 225
For user view, 225
Limit value check, 195
Limit value monitoring
Functional scope, 29
Limit value test, 205
List of abbreviations, 321
Loader, 89
Opening, 90
Operating, 90
Log
Functional scope, 30
Logoff
Users, 228
Logoff time, 225
Logon
Users, 227
Logon data, 147

M

MAC address, 134
Main dimensions
MP 377 PRO 15" Touch, 279
Mains terminal
Connecting, 66
Maintenance, 273, 274
Manual
Production sequence, 272
Transfer, 163
Mechanical
Storage conditions, 44
Transport conditions, 44
Media Player, 93
Memory
MP 377, 280
Memory card, 27
Backup, 84
First use, 153
Inserting, 83
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Restoring file system, 116
Unplug, 85
Memory information, 99
Displaying, 129
LED, 128
Memory management, 98, 158
Menu command
Simple recipe view, 263
Microsoft Excel Viewer, 32
Microsoft PDF Viewer, 32
Microsoft Word Viewer, 32
Monitoring mode
Sm@rtClient view, 221
Mounting, 48
EMC-compatible, 42
HMI device, 57, 59
Mounting clamp, 56
Mounting clamp
Mounting, 55, 56
Mounting cutout
Dimensions, 49
Preparing, 49
Mounting location, 48, 51
Mounting position, 47
Thin Client 15, 51
Mouse
External, 100
Mouse properties, 98
MP 377
Clearance, 49
Display, 280
Displaying information, 127
Input device, 280
Interfaces, 281
Memory, 280
Operating element, 81
Ports, 62
Weight, 280
MP 377 12" Key
Bottom view, 17
Front view, 17
Overall dimensions, 276
Rear view, 18
Side view, 17
MP 377 12" Touch
Bottom view, 15
Front view, 15
Overall dimensions, 275
Rear view, 16
Side view, (15
MP 377 15 PRO
Bottom view, 23
Front view, 23
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Rear view, 24
Side view, 23
MP 377 15" Touch
Bottom view, 19
Front view, 19
Overall dimensions, 277
Rear view, 20
Side view, 19
MP 377 19" Touch
Bottom view, 21
Front view, 21
Overall dimensions, 278
Rear view, 22
Side view, 21
MP 377 PRO 15" Touch
Main dimensions, 279
MPI
Setting, 99, 140
Multi-key operation, 190, 203
Multimedia card, 83

N

Name server, 146
Network
Configuring, 143
Logon data, 98
Set up, 142
Setting, 145
Network & dial-up connections, 98
Network ID, 98
Network operation
Device name, 144
Options, 99
Non-isolated plant configuration, 66
Notice of protected rights, 3
Number format, 98, 116
Numerical
Key assignment, 105, 202
Screen keyboard, 195
Numerical value
Changing, 206
Decimal places, 195
Display format, 205
Editing, 196
Entering, 196, 206
Limit value check, 195
Limit value test, 205

0]
Office location, 5
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Offline
Operating mode, 160
Recipe tag, 254
Test, 167
Online
Operating mode, 160
Recipe tag, 254
Test, 167
OP properties, 98
Device, 127
Memory monitoring, 158
Persistent storage, 117
Touch, 110
OPC server, 32
Open
Control Panel, 97
Drop down list box, 104, 202
Opening
Loader, 90
Operating
Control Panel, 100, 102
Explorer, 91
Feedback, 190
Key, 201, 205
Loader, 90
Operating element, 104, 201
Project, 189
Recipe screen, 255, 264
Slider control, 215
Switches, 211
Trend view, 213
Windows CE interface, 91
With external keyboard, 190
With external mouse, 190
Operating element
Operating, 104, 201
Recipe view, 255
Selecting, 104
Simple recipe view, 262
Operating instructions
Purpose of, 3
Scope, 3
Operating mode, 160
Changing, 160
Offline, 160
Online, 160
Transfer, 77, 160
Operating system
Configuring, 89
Update, 173
Update via ProSave, 176
Updating using WinCC flexible, 175
Operation feedback, 190
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Setting, 99
Operator control options, 99
Optical feedback, 191
Option
Installing, 162, 182
Installing with ProSave, 185
Installing with WinCC flexible, 183
Removing, 162, 182
Removing with ProSave, (186
Removing with WinCC flexible, 184
Options, 32
Network operation, 99
Overall dimensions
MP 377 12" Key, 276
MP 377 12" Touch, 275
MP 377 15" Touch, 277
MP 377 19" Touch, 278

P

Parameter assignment
Data channel, 99, 136
Password, 225
Backup, 225
Restoring, 225
Specifying, 112
Password list, 225
Password properties, 98, 112, 113
Password protection, 92, 98
Cancel, 113
Set up, 112
Windows CE taskbar, 92
PC/PPI
Configuring the cable, 72
Setting the adapter, 72
PDF Viewer, 32
PELV, 66
Permissions in remote control, 222, 223
Plant configuration
Non-isolated, 66
PLC
Configuring the interface, 70
Connecting, 68
Number of connectable, 33
Protocol, 34
Reading recipe data record, 260, 267
Transferring recipe data record, 261|, 268
Wiring diagram, 68
PLC_User, 233, 234, 235
Power failure, 168
Power supply
Connecting, 65, 66
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Setting, 99
State, 99
Wiring diagram, 65
Precautions
Electrostatic discharge, 288
Printer
Connecting, 75
Setting properties, 98
Wiring diagram, 75
Printer connection
Setting, 120
Printer properties, 98, 121
Printing
Labeling strips, 86
Via network printer, 143
ProAgent, 32
Process control phase, 159
Production sequence
Manual, 272
PROFIBUS DP
Setting, 99, 140
PROFINET, 142
Addressing, 142
Connecting, 69
PROFINET IO
Communication, 69
Communication fault, 33
Disabling direct keys, 134
Enabling direct keys, 134
Setting, 98
Project
Closing, 236
in ProTool, 161
In WIinCC flexible, 161
Offline testing, 167
Operating, 189
Reuse, 161
Testing online, 167
Transferring, 159, 162
Proper use, 37
Protected trademark, 3
Protection class, 50, 52
Protective foil, 26
Protocol
PLC, 34
Proxy
Server, 98, 148, 150
Setting, 98

R

Radiation
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High frequency, 37
Radio interference, 41
Emission, 43
Rated load
Interface, 74
Rated voltage, 50, 52
Reading out
Recipe data record, 260, 267
Real-time clock
Internal, 115
Rear view, 16, 18, 20, 22, 24
Rear wall
Closing, 80
Recipe, 246
Control, 247
Data flow, 249
Data record, 247
Field of application, 245
Functional scope, 30
Recipe screen, 250
Recipe view, 250
Synchronizing tags, 259
Recipe data record
Creating, 255, 264
Delete, 258, 266
Editing, 257, 265
Entering, 271
Exporting, 270
Importing, 269
Reading from PLC, 260, 267
Synchronize with PLC, 257
Transferring to PLC, 261|, 268
Recipe list, 251, 262
Recipe screen, 252
Operating, 255, 264
Overview, 252
Recipe tag
Offline, 254
Online, 254
Synchronizing, 253, 259
Recipe view, 250
Expanded, 250
Operating element, 255
Simple, 251
Recommissioning, 159
Record list, 251|, 262
Recycling, 5
Regional and language settings, 98, 116
Regional settings, 116
Registered trademark, 3
Registry Information
Backup, 98, 116
Regulations for the prevention of accidents, 38
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Remote control
Forcing permission, 222, 223
Start, 222, 223
Removing
Option, 162, 182, 184, 186
Repairs, 274
Reset to factory setting, 162
Restore, 98, 153, 168
Restoring, 162, 170, 172, 225
from external storage device, 98, 155
From memory card, 116
With ProSave, 172
With WinCC flexible, 170
Restoring factory settings, 73
Returns Center, 274
Reverse polarity protection, 66
RS 422 to RS 232 converter, 26
RS-422/RS-485 port
Configuring, 70
Ruler
Trend view, 213

S

S7 transfer settings, 99
Safe electrical isolation, 66
Safety
Functional scope, 31
Standards, 39
Safety instruction
Backlighting, 119
Changed tag name, 259
Compeatibility conflict, 168
Compressed project file, 163
Damage to the HMI device, 61
Data channel, 174
Data loss, 153, 173
Device name, 134
Direct key, 192
Electrostatic charging, 287
Equipotential bonding cable, 64
Functional problem, 74
High frequency radiation, 37
Keyboard, 82
License key, 174, 182
Loss of data possible, 155
Memory card, 85
Memory distribution, 129
Multi-key operation, 190
Observe grounding measures, 288
Path, 130, 131
Power failure, 168
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Preventing inadvertent operation, 273, 274
Project file, 130, 131
Recipe data record in background, 251
Remote control for channel 1, 137
Restart, 125
Storage, 44
Switching infotext, 200, 209
Time-dependent reactions, 115
Touch screen, 81
Transfer mode, 139
Transfer mode channel 2, 137
Transport, 44
Unintentional action, 81, 82, 203
Unintentional response, 273, 274
Unintentional transfer mode, 136
USB connection sequence, 73
USB host-to-host cable, 73
USB port, 74
Working on the control cabinet, 38
Safety regulations, 38
Scaling
Functional scope, 29
Screen
Functional scope, 30
Screen keyboard, 98, 193
Alphanumerical, 197
Change layout, 102
Character repeat, 107
Configure, 106
For Control Panel, 101
Keyboard level, 197
Language change, 197
Numerical, 195
Representation types, 101
Screen saver, 99, 120
Setting, 119
Screen settings
Changing, 98
Scroll back key, 104, 201
Scroll forward key, 104, 201
Search engine
Internet, 149
Secure mode, 94
Cancel, 94
Security settings, 98
Security system, 224
Selecting
Operating element, 104
Service
In the Internet, 5
Service pack, 274
Set up
Network, 142
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Password protection, 112
Secure mode, 94
Setting
Backlighting, 99
Browser, 98
Date, 114
Date format, 116
Date/Time, 98
Delay time, 99, 131
Device name, 99
DIP switch, 70
Double-click, 108
E-Mail, 99
E-mail connection, 148
IP address, 98
Language, 193
MPI, 99, 140
Name server, 98
Network, 145
Number format, 116
Operation feedback, 99
PC/PPI adapter, 72
Power supply, 99
Printer connection, 120
Printer properties, 98
PROFIBUS, 140
PROFIBUS DP, 99
PROFINET IO, 98
Proxy, 98
Regional data, 116
Screen saver, 119
Sound, 124
Storage location, 130
Time, 114
Time format, 116
UPS, 132
Setting language, 193
Settings
Internet, 99
Language, 98
Regional, 98
S7-Transfer, 99
Shift key, 105
SHIFT key, 105, 202
Shutting down
HMI device, 78
Side view, 115,17, 19, 21, 23
Siemens HMI input panel options, 98
Simple alarm view, 240
Simple recipe view, 251
Menu command, 263
Operating element, 262
Simple user view, 226
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Slider control, 214
Sm@rtAccess, 32
Sm@rtClient view, 220, 221
Monitoring mode, 221
Usage, 220
Sm@rtService, 32
SMTP server, 148
Software options, 32
Sort order
Alarm view, 241
Sound
Setting, 99, 124
Setting event, 124
Start
HMI device, 98, 125
Status Force, 216
Key control, 219
Touch operation, 217
Storage conditions, 44
storage device
Restoring from external, 155
Storage device
Saving to external, 153
Storage location
Setting, 130
Strain relief, 79
Subnet mask, 146
Supply voltage
MP 377, 281
Support
In the Internet, 5
Support arm system
Adapter set CP-L, 27
Adapter set PLUS, 27
Adapter set VESA 100, 27
Adapter set VESA 75, 27
Basic adapter, 27
Switches, 211
Switching on
MP 377,77
Symbolic value
Editing, 199
Entering, 199
Synchronizing
Date and time, 115
Recipe tag, 253, 259
System alarm
Meaning, 290
Parameters, 289
System information, 99
Displaying, 129
LED, 128
System key, 82
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System properties, 99
Device name, 144
General, 128
Memory, 129

T

TAB key, 104, 201
Tabulator key, 104, 201
Tags
Functional scope, 29
Task planner
Functional scope, 31
Taskbar, 89
TCP/IP address, 145
Technical specifications
Display, 280
Input device, 280
Interfaces, 281
Memory, 280
MP 377, 280
Supply voltage, 281
Technical support, 5
Temporary files
Backup, 116
Test
For ambient conditions, 46
Test voltage, 52
Testing
MP 377,77
Text box, 194
Character mode, 202
Normal mode, 202
Text list
Functional scope, 29
Time, 98
Entering, 199, 208
Setting, 114
Synchronizing, 115
Time format, 98, 116
Time zone
Setting, 114
Time-dependent reactions, 115
Touch operation
Trend view, 214
Touch screen
Calibrating, 98, 110
Safety instruction, 81
Trademark, 3
Training center, 5
Transfer, 159, 160, 163
Automatic, 164
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Cancel, 77

Manual, 163
Transfer mode

Unintentional, 136

Via MPI, 139

Via PROFIBUS DP, 139
Transfer settings, 99, 136

Channel, 136

Directories, 130, 131
Transferring

License key, 162, 187

Project, 159, 162

Recipe data record, 261, 268
Transferring back

License key, 162, 188
Transport conditions, 44
Transport damage, 53
Trend view, 212

Key control, 214

Touch operation, 214
Trends

Functional scope, 31

Limit violation, 212

V)

UL approval, 40
Unintentional action, 81, 82, 190
Unintentional transfer mode, 136
Update
Operating system, 173
Updating
About ProSave, 176
using WinCC flexible, 175
Updating the operating system, 162
UPS
Connecting, 67
Connection graphic, 67
Setting, 132
UPS properties
Configuration, 132
Current status, 133
USB
Connection sequence, 73
USB connection sequence
Safety instruction, 73
USB device
Connecting, [74
USB flash drive, 27
USB memory stick, 27
Use
Conditions, 45
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In residential areas, 41
Industrial, 41
With additional measures, 45
User data
Backup, 225
Changing, 233, 234
Restoring, 225
User group, 224
User name, 147
User view, 226
Expanded, 226
Simple, 226
Users, 225
Admin, 233, 234, 235
Changing, 229
Creating, key control, 230
Delete, 235
Logoff, 228
Logon, 227
PLC_User, 233, 234, 235
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Value table

Trend view, 213
VBScript

Functional scope, 31
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Volume, 122
Setting, 99
Volume & Sounds Properties, 99

w

Weight
MP 377, 280

WinCC flexible internet settings
E-mail, 148
E-Mail, 99

Windows CE interface
Operating, 91

Windows CE taskbar, 89
Password protection, 92

WINS, 146
Server, 142

Wiring diagram
Configuration PC, 71
Equipotential bonding, 64
PLC, 68
Power supply, 65
Printer, 75

Word Viewer, 32

Working on the control cabinet, 38
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